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Unit-Ii    
  

  PageMaker 6.5I 
 
  

Introduction  

Adobe PageMaker 6.5 is the "world's leading cross-
platform professional page layout software". PageMaker is 
primarily used for designing and producing publications 
such as flyers and newsletters and any other application 
that requires a combination of text and graphics. 
PageMaker 6.5 has a rich array of facilities to import text 
and artwork from other computer application packages, as 
well as allowing you to generate these directly from within 
PageMaker itself. PageMaker can handle text better than 
Illustrator and PhotoShop and also gives you the flexibility 
of graphic control not available in word processors. 

Features in PageMaker 6.5 
 
Document Layers 
 
Layers allow you to place elements one over the other. It 
can be thought of as sheets stacked up one on top of the 
other. You can place elements on these layers or 
temporarily hide the layers. These layers can be used for 
adding annotations, floating or background images. 
 
Easier Layout 
 
There is a new concept of frames in PageMaker 6.5, which can hold 
any type of text or images. PageMaker's freeform layout capabilities 
have become even more flexible with its frame and text controls. 
 
Better Integration 
 
PageMaker can work seamlessly with PhotoShop, Illustrator etc. It also 
builds the ability to drag and drop images and elements directly from 
one of these applications to the other. 
 
Color Controls 
 
PageMaker 6.5 introduces new color technologies, which helps in 
reproducing high fidelity colors in your publications. A new desktop 
color separation tool is also included. The Kodak color management 
system now supports the International Consortium of Standard for 
sharing device profiles. 
 
Internet Ready 
 
The current release of PageMaker (i.e. Version 6.5) includes an option 
to export your PageMaker documents to Internet ready HTML (Hyper 
Text Markup Language) files with the links preserved. The document 
images are converted to GIF or JPEG format required by the Internet. 
There is also an option to export the PageMaker documents in to 
Adobe Acrobat format. 
 
Paper Orientation  
 
You can set paper in two ways, portrait is one in which the paper is 
used with the longer size in the vertical direction. If we interchange the 
directions, we get the Landscape Orientation. 
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Starting PageMaker 
 

 Click the Start button. 

 Select Programs. 

 From the Programs Menu select Adobe. 

 In the Adobe Menu select PageMaker 6.5. 

 Click Adobe PageMaker 6.5. 

 The PageMaker window is displayed. 

 
PageMaker Environment 
 
Menu Bar The standard menu bar contains all the main menus 

for File, Layout, Element and other utilities. 

Ruler The top and left ruler bars helps you to precisely 
position the cursor, text, and graphics in the page. 
The Current Cursor location is shown by two dotted 
lines in the rulers. To view the rulers select View > 
Show Rulers. 

Master 
Page Icon 

The Master Page icon shows the position of the 
master Pages. Clicking it will display the Master 
Page. Master Pages contain text, graphics, layout 
and settings, which are common, thought the 
publication. 

Page Icon The Page icon shows the list of pages in the 
publication with the currently selected page in black. 
Clicking a particular page icon will display the 
selected page. 

Pasteboard Surrounding the page is an area of white space 
called the Pasteboard. It is used to store graphics 
and texts as you work. Items you place on the 
pasteboard are visible from any page and can be 
selected and moved regardless of the page you are 
currently working on. 

 
File Menu 
 
New New command is used to create a new publication. This command gives rise to a dialog box where you define the 

various options before opening a new page of the publication. 
Open Open allow you to open an existing PageMaker file. 
Save Save command saves the current publication. To save all the open files, press the shift key while choosing the Save 

option. 
Revert Revert command rolls back all the changes made since the last save. It is the same as closing the publishing, 

without saving and opening it again. 
Place Place command is used to place text and graphics into the publication. 
Acquire The Acquire command is used to scan an image into your publication. 
Export Export command lets you export your publications into the format you select. 
 
Edit Menu 
 
Paste Multiple Paste Multiple lets you paste multiple copies of text or graphics. 
Paste Special Paste Special is used to specify the format to use when you paste an object into your publication. 

Insert Object Insert Object is used to specify the format to be used to insert an OLE embedded object within a PageMaker 
publication. 

Edit Story Edit Story is used to toggle between the word processing mode and the layout mode. 
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Layout Menu 
 
Sort Pages When you select Sort Pages command, a dialog box appears with all the pages of 

the publication. You can rearrange the pages in the publication graphically. 
Column 
Guides 

Column Guides lets you divide the pages of the publication into different columns of 
equal size. 

Auto Flow Auto flow is used to flow the text onto the pages of the publications on its own from 
a loaded text icon. It flows the text into pages from columns to columns and also 
adds pages on its own depending on the availability of text. 

 
Type Menu 
 
Define Styles This option will present you a dialog box with the list of styles used in the 

publication. You can add, modify and delete styles from this dialog box. 
 
Element Menu 
 
Frame Frame has options for frame alignment, position 

and margins. 
Align 
Objects 

Align Objects lets you align multiple objects relative 
to each other. 

Link 
Options 

Link Options is used to define whether the linked 
text or graphic is to be updated along with the 
publication in use and also its frequency. 

 
Utilities Menu  
 
Plug-ins Plug-ins has a list of sub commands, which lists out 

the various plug-ins, which have been included with 
PageMaker as additions. 

 
View Menu 
 
Display 
Master 
Items 

Display Master Items toggle the display of items 
from the master pages to be reflected in the current 
page of the publication. 

Display 
Non-
Printing 
Items 

Display Non-Printing items toggle the display of 
non-printing items. 

 
Window Menu 
 
Show Tools Hide/Show tools toggles the display of PageMaker toolbar. 
Show Control Palette Show/Hide Control Panel toggles the display of control panel on the screen. 
Show Colors Show/Hide Colors Toggles the display of the Color Palette on the screen. 
Show Styles Show/Hide Styles toggles the display of the Styles Palette on the screen. 
Show Layers Show/Hide Layers toggles the display of the Layers Palette on the screen. 
Show Master Pages Show/Hide Master Pages toggles the display of the Master Pages Palette on the screen. 
Show Hyperlinks Show/Hide Hyperlinks toggles the display of the Hyperlink Palette on the screen. 
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Pointer Tool 
 
Pointer tool is used to pick, drag and drop graphics and text. 
 

 
 
Text Tool 

Text Tool is used to edit and select text and insert text frames. 
Click the text tool and click anywhere in the document and start 
entering text. The text tool creates a free flowing text box 

 
  

UNDERSTANDING PAGEMAKER TOOLS 
 
Toolbox 
 
Toolbox contains all the tools used to create a publication in 
PageMaker. Choose Window and select Show Tools to display the 
toolbox. The individual tools will be explained in detail later in this 
session. 
 

 
 

   
Zero Position 
 
Zero Position allows you to set the zero position on the screen. Zero 
position is the position, where both the top and the left side rulers are 
at zero. By Zero positioning all measurements in the pages are made 
relative to this point. Click it and drag it to anywhere on the 
workspace to set it as the Zero Point 
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Constrained Line Tool  
 
Constrained Line tool will draw lines at 45degree intervals, i.e., 
horizontally, vertically or diagonally. 
 

 
 
Box Tool 
  
Box tool is used to draw a box 
 

 
 
Rectangle Frame 
 
Rectangle Frame is used to type text inside a box. First select the 
toll and draw the area to be enclosed by the rectangular frame, then 
select the text tool and click inside the drawn frame to enter text. 
The text will be constrained to the rectangular frame. 
 

 

Rotate Tool 
  
Rotate tool is used to rotate text and graphic objects. Click the 
rotate tool, then click on the object reference point and drag to 
rotate the object. 
 

 
 
Crop Tool 
 
The Crop tool is used to crop imported graphic images to the 
required size. The crop tool only works on TIFF type of images. 
Click on the toll and, drag the image handles, to crop the image. 
 

 
 
Oblique Line Tool 
 
Oblique Line is used to draw slanting lines. To draw a line, click 
the oblique line tool, click and drag to draw a line in any direction. 
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Polygon Frame 
 
Polygon frame puts the text inside the polygon. Select the polygon 
frame tool, draw a polygon then select the text tool and click inside 
the frame to enter the text inside the polygon frame 
 

 
 
Hand Tool  
 
Hand tool is used to move the screen. This tool is very useful when 
you are working with large documents. It helps you to easily 
navigate in a large page. To move a screen, just select the hand 
tool and click and drag the page to view different parts of the page. 
 

 
 
Zoom Tool 
 
Zoom tool allows you to zoom in and out of the document view. By 
default the zoom tool will be in the zoom-in mode. To zoom out of 
page select the zoom tool and press control and click in the 
document window with the zoom tool. 
 

 

Circle Tool  
 
Circle tool is used to draw a circle or elliptical graphic. To draw a 
circle or an ellipse, select the tool, click and drag to draw a circle 
on the document. 
 

 
 
Circular Frame  
 
Circular Frame is used to type text inside a circle or an oval. Use 
the Circular frame tool to draw the frame and then click inside with 
the text tool to start entering text. The entered text will be 
constrained to the circular frame. 
 

 
 
Polygon Tool  
 
Polygon tool is used to draw a shape with more than four sides. 
You can modify the polygon by selecting Element and selecting 
Polygon Settings 
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Enter 1 inch as the inside margin and press the TAB key. 
 

 

Enter 1 inch as the outside margin and press the TAB key. 

 

Enter 1 inch as the top margin and press the TAB key. 

 

OPENING A NEW PUBLICATION  
 
Click File. 
 

 
 
Select New. 
 

 

The Document Setup dialog box appears. Enter 2 in the number 
of pages text box and press the TAB key. 
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Click OK. 
 

 
 
A new document is opened with the required margins and the first 
page of the selected document is displayed. 
 

 
 
 

PAGE SIZE AND PAPER SIZE 
 
Paper size is the actual size of the paper and Page Size is the 
printable area of the page. The Page size is the area enclosed by 
the page margins. 
 

 

Enter 1 inch as the bottom margin and press the TAB key. 

 

Click the "Compose to printer" dropdown menu. 

 
 
Select the printer "HP DeskJet on LPT1" 
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Control Palette In Paragraph Mode 

The control Palette displays options for the paragraph style, 
alignment, indents, spacing, grid spacing and grid alignment 

 
  
Color Palette  
 
The color Palette is used to apply colors or view the name or kind 
of color applied to the selected text or object. The buttons stroke, 
fill or both, can be used to change the color of the graphic object 
and Object level.  
 
Tints allow you to have variations of the same color. To apply a 
color to a text or object, select the corresponding text or object 
and select the color from the color Palette. 
 
Choose Window and select Show Colors, to display the Colors 
palette. 

Kerning Text Kerning adjusts the spacing between 
characters in text. It is selective, so you can 
adjust just one or two characters, or whole 
sections of text. Negative numbers move 
characters closer together, whereas Positive 
numbers space them out. 

Leading Text Leading adjusts the spacing between lines 
of text. This is applicable on line-by-line basis. 
Positive and Negative numbers have the same 
effect as they have on Kerning, except that the 
spacing is between the lines of text. 

Tracking Text Tracking adjusts how closely characters 
follow each other. Very tight tracking brings text 
closer together, very loose spreads it out a bit. 

Size Text Size adjusts point size of text. 
Position Text Position adjusts the placement of the text on 

a given line. Positive Numbers move the text into 
a super text position (above the line), and 
Negative numbers move it into a subtext position 
(below the line). 

Width Text Width adjusts the character width and does 
not affect height. The larger the percentage, the 
wider the word. Percentages over 100% make it 
proportionately larger than the standard sizing, 
under 100% make it proportionately smaller. 

CONTROL PALETTE 
 
The control Palette displays the properties for the selected 
paragraph, Character or object.  
 
It is a sort of shortcut to the object, text, and paragraph properties. 
Choose Window and select Show Control Palette to display the 
Control palette. 
 

 
 
 
CONTROL PALETTE IN OBJECT MODE 
 
The control Palette when it has an object selected displays the object 
properties such as the reference point, position, size, scaling, 
cropping, printer resolution, rotating, skewing and horizontal and 
vertical reflection. 
 

Horizontal/vertical 
mirror 

mirrors the currently selected object along 
the x or y-axis. 

Height/width sets the height and width of the currently 
selected object, either numerically in 
inches or in percentages of the current 
size. 

Rotate Rotate, is used to rotate the selected 
object around an axis. The center of 
rotation is set as the object's center and 
exact measurements can be used 

Skew This skews, the currently selected object, 
in degrees. 

XY position Sets the horizontal and vertical position of 
the upper-left corner of the currently 
selected object. 

 
 

 
 
 
Control Palette in Character Mode 
 
The Character Palette is displayed when the text tool is selected.  
 
It has options for changing text styles, size, leading, tracking, width 
and Kerning.  
 
There is a toggle button to shift between paragraph view and 
character view. 
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Master Pages Palette  
 
The Master Pages palette is used to create and apply masters. It 
displays a list of available master pages for a particular document. 
The master page icon at the bottom of the window is used when you 
want to go to a master page for editing. Choose Window and select 
Show Master pages to display the master Pages palette 
 

 
 
Hyperlink Palette 
 
A hyperlink has two parts: a source, which is the hyper linked text, 
or graphic that you click, and a destination, which is where the 
source jumps. Inside a PageMaker publication, destinations are 
called anchors. You can also give a valid web hyperlink. Choose 
Window and select Show Hyperlinks to display the Hyperlinks 
palette 

 
 
 
Setting a Measurement System  
 
Click File. 
 

 
 

 

 
 
Styles Palette 
  
The Styles Palette is used to apply styles or to view or edit styles 
defined for the publication. To apply a style, just click a paragraph 
with the text tool and then click a style name in the palette. Choose 
Window and select Show Styles to display the Styles palette. 
 

 
 
 
Layers Palette  
 
The Layer Palette is used where a multiple layers document 
structure is required. Layers allow you to separate the different 
elements that make up your document. You can hide, display, add 
or delete layers as required. Choose Window and select Show 
Layers to display the Layers Palette. 
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Select Millimeters. 
 

 
 
Click OK. 
 

 
 

You will notice that the rulers have changed 
from Inches to Millimeters. 
 

 

Select Preferences. 
 

 
 
In the Preferences menu select general. 
 

 
 
Click the "Measurement in" drop down box. 
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INSERTING PAGES 
 
Click Layout. 
 

 
 
Choose Insert Pages. 
 

 
 
The Insert Pages dialog box is displayed. Enter 2 as the number of 
new pages to add. 
 

 

GUIDES 
 
Margin 
Guides 

Margins are defined in the Document Setup dialog 
box, when you first create a publication, and are 
applied to the Document Master page. These are 
represented by pink lines on the top and bottom 
and by blue lines on the left and right. 

Column 
Guides 

Column guides serve as boundaries for text you 
place within them. You can have as many as 20 
columns per page. Column guides control the flow 
of text and are represented by dark blue lines. 

Ruler 
Guides 

Ruler Guides are also non-printing guidelines 
which are primarily used to align objects in the 
publication and are represented on the screen by 
Light blue lines. 

 

 
 
Viewing Pages 
 

Zoom In Zoom in Magnifies the Document to the 
next level 

Zoom Out Zoom out Shrinks the Document view to 
the previous level 

Actual Size Actual size Displays the entire page or a 
two page spread within the publication 
window. 

Fit in Window Fit in window will display the current page 
in its entirety within the publishing 
window. This view is especially useful to 
check the layout of the page. 

Entire pasteboard Entire pasteboard displays the page with 
the entire pasteboard so that you can find 
or view objects. 
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Select Sort Pages. 
 

 
 
A dialog box with the page icons appears. Click on the fourth 
page, and place it before the first page. 
 

 
 
Click OK to close the dialog box. 
 

 
 

Click Insert. 
 

 
 
You will notice that new pages are added to the page icon bar. 
 

 
 
SORTING PAGES  
 
To change the page order Click Layout. 
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Select the Show Master Pages Palette from 
the window menu. 

 
 
In the Master Pages Pallete Click on the Top right arrow to 
display the Palette Menu. 
 

 
 

Now select New Master. 
 

 

The Page is rearranged and the page numbers are changed 
accordingly. 
 

 
 
MASTER PAGES  
 
Master Pages are a sort of a template for all of the pages in a 
publication. The Master pages can contain text, Graphics and guides. 
These are reflected in all the pages of the publication. They generally 
contain logos and volume title, which are to be repeated in every page 
of the publication and also guides, which help to maintain uniformity 
throughout the publication. 
 

 
 
Creating a New Master  
 
Click Window. 
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In the New Master Page dialog box enter the name as "content". Select the option "One page". 
 

 
 

Click OK. 
 

 

The New Master Page is added to the document. 
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Press the mouse button and drag the insertion point to the right. 
Release the mouse when you have opened the box to the correct 
size. 
 

 
 
Type "Layout Galaxy". 
 

 
 
Placing Text  
 
Click on Edit Menu. 
 

 

HEADERS AND FOOTERS  
 
Headers are text or graphics, which are located above the top 
margin and below the bottom margin in case of footer. They are 
used to display information about a page such as chapter title or 
page numbers, current date and time of publication or revision 
date. 
 

 
 
TEXT BASICS 
 
Entering Text 
 
In PageMaker, text is typed in text blocks or frames. Text blocks 
are defined by the amount of text and the margins of the page. To 
open a text block First click the Text tool. 
 

 
 
Click anywhere on the page within the margin guides. 
 

 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                                   - 17 -                                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

PageMaker displays an alert message that says, "The story has not 
been placed." Click the place button to place the story. 
 

 

PageMaker displays a loaded text icon. Click the icon to flow text 
into the frame or column you click on. 

 
 

 

Select Edit Story. 
 

 
 
Type "Demo for Placing Text". Click on Story. 
 

 
 
Select Close Story. 
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Automatic 
pair 
kerning 

Automatic pair kerning adjusts the space between 
certain character pairs, based on the kerning 
information that's built into the font. 

Manual 
kerning 

Manual kerning lets you kern any range of text, 
from one character pair to a whole story, using 
cursor keys or by using the Control palette. 

Expert 
kerning 

Expert kerning calculates a manual kerning value 
for every character pair in a selected range of 
text. 

 
Tracking 
 
Tracking is similar to kerning in that it deals with the horizontal 
space between letters. PageMaker includes five built-in tracks 
from Very Loose to Very Tight. To set the required track, first 
select the text. 
 

 

Click the Window menu. 

 
 

Text Objects, Stories and Editors 
 

Understanding 
text objects 
and stories 

Text in PageMaker is part of a story. A story can 
be a single letter or several pages of text and 
can be contained in a single text object or 
threaded through many different objects. 

Layout Editors 
and Story 
Editors 

Text blocks that are threaded together in the 
Layout Editor comprise the same story in the 
Story Editor. A text block may be split among 
several pages in the Layout Editor, but it 
appears as a continuous story in the Story 
Editor. 

 
Formatting Text 
 

Changing 
Font Sizes 

In PageMaker, by default the type size is 12 points 
but you can change the size as often as you like 
using the Control Palette. The Control Palette can 
be activated or deactivated from the Window menu. 

Changing 
Typeface 
Styles 

There are ten different styles for any typeface. They 
are Normal, Bold, Italic, Underline, Reverse, 
Strikethrough, Small caps, All caps, Super script 
and Sub script. 

 

 
 
 

Changing 
Character 
Specifications 

The Character Specifications dialog box allows 
you to choose several type attributes in one step. 
This dialog box can be opened by double clicking 
the Text tool. 

 

 
 
KERNING AND TRACKING 
  
PageMaker provides three types of kerning. 
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PARAGRAPH SETTING 
 
Paragraph formatting includes setting indent values, paragraph 
spacing, text alignment, dictionary, etc. In this exercise we shall 
see how to draw a line below a paragraph. Click on the Text tool. 
 

 
 
Select the paragraph. 
 

 

Select Show Control Palette. 
 

 
 
Click on the Tracking pop-up menu. 
 

 
 
Select Very Tight from the menu. 
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Select Rules below Paragraph check box. 
 

 
 
Click on the Stroke Color drop down menu. 
 

 
 
Select Blue from the menu. 
 

 
 

Click on the Type menu. 
 

 
 
Select Paragraph. 
 

 
 
Click on the Rules button. 
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SETTING TABS  
 
In this exercise we shall see how to set tabs. Select the Text tool. 
 

 
 
Select the text in which the Tab key is pressed once in-between 
each item. 
 

 
 
Click on the Type menu. 
 

 

Click Ok to close the Paragraph Rules dialog box. 
 

 
 
Click Ok to close the Paragraph Specifications dialog box. 
 

 
 
You can now see a line below the paragraph. 
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Now you can see the text being aligned according to the tab 
marker. 
 

 
 
INDENTS SETTING 
 
In this exercise, we shall see how to set Indents. Click the Text 
tool. 
 

 
 
Select the paragraph. 
 

 

Select Indents/Tabs. 
 

 
 
Click once above the ruler to create your own tab marker. 
 

 
 
Click Ok. 
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Drag the right indent by 1 inch. 
 

 
 
Click OK. 
 

 

Thus the paragraph has been aligned according to the Indents set. 

 

Click on the Type menu. 
 

 
 
Select Indents/Tabs. 
 

 
 
Drag the first half of the left indent to 1 inch. 
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Hyphenation Setting 
 

Let us see how to add a word to the user dictionary. Click on 
the Type menu. 
Select Hyphenation. 

Click the Add button in the Hyphenation dialog box. 
In the Add to User Dictionary dialog box type Lay~out~ 
Galaxy. In this word, the most favorable break is marked by 
a single tilde (~) and the second most favorable break is 
marked by a double tilde. Click OK to close the Add to User 
Dictionary dialog box. 
Click OK to close the Hyphenation dialog box. 
The word "LayoutGalaxy" has been added to the 
Dictionary. 

 
Set Styles 
 
In this demo we shall see how set style. Select the Text tool. 
 

 
 
Click the insertion point anywhere in the text. 
 

 

BULLETS AND NUMBERING  
 
The Bullets and Numbering option automatically adds bullets or 
numbers to the paragraph in the text block. To edit bullets or to 
add numbers you can click the Edit or Numbers button 
respectively. 
 

 
 
HYPHENATION SETTING  
 
PageMaker hyphenates words to reduce the spacing between 
them in a justified text. Hyphenation is controlled with the 
hyphenation dialog box. The Manual only option hyphenates only 
the words that you have marked to hyphenate by inserting a 
discretionary hyphen in the word where it would normally break. 
 

 
 

Manual plus dictionary option hyphenates the words to which you 
have added discretionary hyphens, as well as words hyphenated 
in the PageMaker dictionary. 
 

 
 
In addition to using the dictionary, Manual plus algorithm option, 
uses a mathematical algorithm and your manually inserted 
hyphens to break words. 
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Thus the selected text has been changed to the Headline style. 
 

 
 

Creating Styles  
 
To create a new style click on the Type menu. 
 

Select Define Styles. 
 

 
 
In the Define Styles dialog box, Click New button. 
 

 

Click on the windows menu. 
 

 
 
Select show styles. 
 

 
 
In the style palette select Headline. 
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Click the Next Style drop down menu. 
 

 
 

Select Subhead 1. 
 

 
 
Click OK to close the Style Options dialog box. The new style has 
been created. 
 

 

Style Options dialog box opens.  
In the Name text box type "MyStyle". 
 

 
 
Click the Based on drop down menu. 
 

 
 
Select Headline. 
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ROTATING TEXT 
 
Let us see how to rotate a text frame. Click the arrow tool. 
 

 
 
Select the text "Layout Galaxy". 
 

 
 
Delete the current value in the rotation angle text box of the control palette. 
 

 
 
Type 45 degrees and press Enter. 
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CREATING HYPERLINKS 
 
Let us create a hyperlink. Click on the File menu. 
Select New. 

 

Document Setup dialog box opens. Click the Page size pop-up 
menu. 
 

 
 
Advanced Topics 
 

 
 

 
 
The frame has been rotated by 45 degrees. 
 

 
 
ADDING COLOR TO TEXT  
 
Select the text.  Click on the Window menu. Select Show Colors. 
Select blue from the Colors Palette. Click anywhere on the page. 
The text color has been changed to blue. 
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Type "ImageOnline". Select the text. 
 

 
 
Click on the Windows menu. Select Show Hyperlinks. 
 

 

Click on the pop-up menu of the Hyperlinks palette. 

 
 

Select 500x335 Browser-small. 
 

 
 
Type 2 in the Number of pages textbox. 
 

 
 
Click OK to close the dialog box. 
Select the text tool.  Click on the page. 
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Type "Homepage". Select the text. 
 

 
 
Select the target anchor i.e. the anchor named "Introduction". 
Click on the pop-up menu of the Hyperlinks palette. 
 

 
 
Select New Source. 
 

 
 

Select New Anchor. Click Anchor1. 
 

 
 
Type "Introduction" for the anchor name in the dialog box,  
which appears. Click OK. 
 

 
 
Click the second page's icon. 
 

 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                                   - 31 -                                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

Select the hand tool. 
 

 
 
The new active link is outlined with a blue box. Click on 
the link. 
 

 

You can see a link being created. 

 

Click Source3. 
 

 
 
Type "goto homepage" in the dialog box. 
 

 
 
Click OK. 
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SPELL CHECK  
 
PageMaker helps you in proof-reading your text by providing a 
'Spelling Checker', which can be used to check the spelling for a 
selected range of text or for all the text in the active story or all 
stories in all open publications. PageMaker will warn you of any 
words it cannot locate in its dictionary. If any word is misspelled 
then you have the choice to re-enter it or choose from a selection 
of closest matches in the dictionary. The Spelling dialog box can 
be activated from the Utilities menu. 
 

 
 
Working with Columns  
 
PageMaker allows you to divide any page into columns. In this 
exercise we shall split a page into Columns. Click on 
the Layout menu. 
 

 
 
Select Column Guides. 
 

 

THREADING 
 
When a story in a text block extends to the next or subsequent 
pages, it is broken up into individual page text blocks. A small Red 
triangle in the lower window shade handle indicates that there is 
more text that can be currently displayed in the text box. Click on 
the Red triangle to display the second block of the text. 
 

 
 

The pointer will turn into a loaded text icon. Click to place the 
second block. 
 

 
 

The small + symbol in the top window shade indicates that the story 
has been continued from a previous block text. An empty handle in 
the bottom window shade indicates the end of the Story. 
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Select Edit Story. 
 

 

Select the text "adjust layout". 

 

Click on the Utilities menu. 

 

A Columns Guide dialog box appears.  
In the Number of columns dialog box, type 2. 
 

 
 
Click OK to close the dialog box. 
We can now see the pages split into columns. 
 

 
 
Indexes and Pagination  
 
To create an Index, Click on the Edit menu. 
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Click the loaded text icon anywhere on the page. Now you have 
added, "adjust layout" to your Index. Similarly you can add 
other words. 

 

INDEXES AND PAGINATION  
 
The Sort Pages feature can be activated from the Layout menu. 
This feature allows you to re-order the pages in your document. 
This can be easily done by dragging the page thumbnail images 
around, within the window. Changing the order of pages does 
not alter the text in a story. The story remains intact even 
though text objects may have moved to different pages. 
 

 
 
USING THE FIND FEATURE 
  
Using the find and change feature, you can search for specific 
occurrences of a word or group of words. Once you find what 
you're looking for, then PageMaker automatically changes it to 
the selected option. The find and the change dialog boxes can 
be activated from the Utilities menu. 
 

 
 
GRAPHICS 
 
Line Tool 
 
In this exercise, you will learn to use the Line Tool. Select 
the Line Tool from the Tool Box. 

Select Index Entry. 

 
 
Click OK to close the dialog box. 
 

 
 
Click on the story menu & Select the Close Story.  
Click on the Utilities menu & Select Create Index & Click OK. 
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Point the Cursor on A and hold down the mouse Button and 
drag it to Point B and release the mouse button to draw a 
Rectangle. Now Draw a Square using the Box Tool. Point 
the Cursor on C and hold down the Shift Key and drag the 
mouse button down to Point D to draw a Square. 

 

 

 

Point the Cursor on "A" and hold down the mouse Button and drag it to 
Point "B" and then release the mouse Button. 
 

 

Now you can see a line drawn on the Screen. 

 
 
Box Tool 
  
Box tool is used to draw both rectangles and squares. In this exercise you 
will learn to use the Box Tool. Select the Box Tool. 
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In the Polygon Settings dialog box, enter 40 for the number 
of Sides and press the Tab Key. 
 

 
 

 
 
Click Ok. In this way you can modify a Polygon in to a star 
having 40 Sides and 30% Star inset. 
  
Rounded Corners  
 
In this exercise you will learn how to round the corners of a 
rectangle using "Rounded Corners" option. Select the Pointer 
Tool. 
 

 

Ellipse Tool 
 
Ellipse tool is used to draw both Ovals and Circles. In this exercise, you 
will learn to use Ellipse Tool. 
Select Ellipse Tool. Point the Cursor on A and hold the mouse button 
down. Drag it to Point B to draw an Oval. 
 

 
 

 
 
Polygon Tool  
 
In this exercise, you will learn to use the Polygon Tool. 
Select the Polygon Tool. 
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Fill  
 
The Fill command is used to fill the 
box or circle with the options 
available under this command, which 
consists of various types of lines 
along with the options like paper and 
solid.  
If you choose the paper option, the 
object fill changes to the background 
paper color and when the solid option 
is chosen, the object gets completely 
filled. 

Stroke  

You can use the stroke command to 
select the lines of different sizes and 
styles or choose the option called 
custom to create the line of your own 
style. Besides these, you have two 
more options called Transparent and 
Reverse. Use Transparent 
Background option if you want the 
objects placed behind a patterned 
stroke to be shown through the 
spaces in the pattern otherwise the 
spaces in the pattern are opaque. 
Reverse Stroke option is used to 
draw a paper-colored stroke or 
outline of a shape on a contrasting 
black, shaded, or colored 
background. 

Fill and stroke 
 
This is the combination of the above two commands. Instead of 
selecting them one by one, you can select them together with 
this command. 
 

 
 
Placing Graphics 
  
The Place command is used to Import Graphics. In this 
exercise you will learn placing a Graphic.  
 
To do this you first click the File menu. Select Place from the 
drop down menu. 

 
 
The Rounded Corners dialog box appears on the Screen. From this 
dialog box select the last Option. 
 

 
 
Click anywhere outside the rectangle on the screen. 
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Cropping an Image  

Cropping trims away a portion of the graphic, rather than reducing 
the size of the graphic. In this exercise you will learn to Crop a 
Graphic. 

Select the Cropping tool. 

 
 
Click the handle shown and drag towards the center to crop the 
graphic. Now click on the center of the graphic, notice that the 
cropping tool changes to a hand tool. Hold down the mouse 
button and move the graphic downwards. 
 

 
 
Adding Color to a Graphic Shape 
  
In this exercise you will learn to add Color to a Graphic Shape. 
 
Select the Pointer Tool. Click Window menu. Select Show 
Colors to open the Colors Palette. 

 

The Place Dialog Box opens up. Double Click "Bouquet.tif". 

 

Move the Pointer to the Work area and Click it. You can now see the 
imported image on your screen. 

 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                                   - 39 -                                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

Locking Objects  

You can lock individual objects in 
place in order to help preserve the 
design of your pages through all 
stages of production. You can 
change a color or fill applied to a 
locked object, but not its degree of 
rotation or its skewing angle. You 
cannot cut or delete a locked 
object without unlocking it first, but 
you can copy a locked object; it will 
be pasted as an unlocked object. 
The Apply button in the Control 
Palette appears gray when the 
selected object is locked. The 
cursor changes to a lock icon when 
you try to move a locked item. 

Click the Circle drawn on the Work area to select it. 
Click Element menu. 

 

Select Lock Position. 

 

 

While the Outline of the Polygon is still selected, click the stroke Button. 
Click Green color in the colors palette. 

 

You can see that the Outline of the polygon is changed to Green 
color. To Fill the Polygon with Yellow Color, Click the Fill button in 
the Color Palette. Click Yellow Color in the Color Palette. Now you can 
see that the Polygon is filled with Yellow Color. Click the Tint button to 
display the drop-down tint list. Tint the fill Color to 55% by selecting it from 
the drop-down Tint list. In this way you can easily add color to 
the Squares, Rectangles, Ovals and Circles in PageMaker. 
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Select "Mask" option. 
 

 
 
Click anywhere outside the object in the work area. You can 
now see that only the text inside the oval is visible and that 
around the oval has disappeared. Actually this command 
creates a window sort of effect to see the text through the 
graphic. You can also adjust what part of the text has to appear 
through the object by moving the text with the Pointer Tool 
 

 
 
PRINTING YOUR DOCUMENT 
 
Printer  
 

Here choose your printer type if you have loaded the drivers for 
more than one printer, otherwise the default printer, which you 
have selected is shown. 
 

 

Masking Objects  
 
Masking is a way of covering part of an object so that only a portion of it 
appears through a shape drawn with the rectangle, ellipse, or polygon 
tool. In this exercise you will learn how to mask objects. 
Select the Pointer Tool. Click the oval drawn on the work area using 
the Pointer Tool to select it. 
 

 
 

Drag it and place it on the text, which is already there on the work area. 
Select both the text and the object. To do this click Edit menu. 
 

 
 
Select "Select All". Now you can see that both the text and the object 
are selected. Click the Element menu. 
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No of Copies: Choose the number of copies of each page you want to print. 
Collate: This option collates the printed output. If you want to make 2 copies of pages 1-5 then this command will print page number 1to5, 2 
times over in a collated form. 
Reverse order: This is used to print in reverse 
order that is while printing 1 to 5 pages, it will 
print 5 to 1. 
Proof: by choosing this option you can print the 
pages as lower quality proofs. 
Pages: All' will print the entire document and if 
you select Ranges, you can specify the range of 
pages to be printed. 
Book: This command is valid if you have the 
publications lined up in Book. The options here 
are that you can print all the pages of all the 
publications in the book or choose otherwise. 
Print drop down list: 'Both Pages' is used for 
printing a document on the front and back at a 
time. 'Odd pages' is normally used to print all 
odd-numbered pages first. Then these printed 
pages can be printed on the other side also by 
putting them back in the tray and giving 'Even 
Pages' option. 
Orientation: This has two icons for Portrait and 
Landscape. Select the appropriate icon. 
Ignore 'Non-Printing: Click this if you want to 
print the non-printing characters too. 
Reader's spreads: It allows for the evaluation 
of two-page spreads 
Percentage: Print Options can be opened by 
clicking options button in printing your document 
dialog box you can scale the pages to any size 
before printing. 
Reduce to fit: While printing if the paper size is smaller than the page designed by you, the Reduce to fit command enables you to print the 
document on the paper even when the paper size is small. While printing if the paper size is smaller than the page designed by you, the 
Reduce to fit command enables you to print the document on the paper even when the paper size is small. 
Duplex: Duplex can be used to print on both sides of the page during one pass through the printer. This is a very handy feature if you need to 
print front and back originals. The various options here are None, Short edge and Long edge. 
Options: Here are the various options, which can be printed on the page itself that is the Printer's marks and Page information. Tiling breaks 
up the ultimate size into smaller pieces that fit on the page size specified in the page Setup dialog box. PageMaker sets an automatic overlap 
of the tiles that takes into account the unprintable margin around the edge of the page or you can manually set the overlap, if you wish. 
Color Options: Color Options can be selected by clicking the Color button in printing your document dialog box. This gives control over 
handling color separations and printing color. 
Composite: Composite is opposite of separations. When this option is selected colors will not be separated instead they will be printed in 
place as either shades of gray or as close approximations of the colors. To print colors on a color printer, click the Composite button. If you are 
using a laser printer then, using this option you get shades of gray. 
Print Colors in Black button: Makes all the colors print in shades of black in the same-screened percentages acquired with process and spot 
separations. 
Separations: When you select the separations button, the separations pop-up list becomes active. This contains the process colors and any 
spot colors you have defined for this document. From this, select the colors whose separations you want to print and click 'Print This Ink' check 
box to add an X in the pop-up list. PageMaker only prints separations for the colors with X's in the Print column. 
Print All Inks: This command is used to mark all the colors with X's. 
Print No Ink: This command is used to remove all the X's in the list of colors. 
All to Process: This command is used to convert all spot color separations temporarily to process separations. 
Printing Your Document: This exercise will teach you how to print a document.   Click File menu. 
 
 

 
 

________________________________________________ 
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Unit-IIi    
  

  CorelDraw 12I 
 
 
INTRODUCTION 
 
CorelDRAW is a vector illustration program. Images are displayed on the computer screen as pixels. How the program treats the pixels is 
determined by whether the image is defined as a vector or a bitmap. A bitmap file defines the position, color and size of each pixel. A vector 
program defines a line of pixels and treats them as a single object. To change an object in a bitmap, you must change all the pixels, so if a red 
box on a blue background needs to be smaller, you have to re-create a smaller red box and change the pixels where the box was to the blue 
background. When you have a vector image, you redefine the size and location of the lines. Each object is independent of the others and can 
be manipulated as needed. To make your work easier, Corel Corporation has added a few bitmap manipulation tools in DRAW and includes 
its bitmap manipulation program, CorelPhotoPaint, when you purchase CorelDRAW. 

 
Window Components 

A - 
Standard 
Toolbar 

 You can customize this or any other Toolbar or create 
additional Toolbars. 

B - 
Property 
Bar 

The Property Bar is dynamic. Property options change 
depending on what you are working on. This enables 
you to access commands that are specific to the 
current tool or feature you are using. 

C - Main 
Tool Box The main tools you will use are accessed from this bar. 

D - Rulers The Rulers show the current mouse cursor location as 
you move in the work area. 

E - Color 
Palette 

The Color Palette by default is located to the right of 
the work window. Like the Toolbars, it can also be 
relocated. You can choose from a preset palette of 
colors, or use a specific color system such as Pantone 
Spot Colors. 

F - Status 
Bar 

The Status Bar is used to give you information about 
cursor movements or symbol properties such as the fill 
or size. 

G - Page 
Navigator 

The Page Selector is used to add and move between 
pages. When a file contains multiple pages, individual 
page tabs appear to the right of the Page Selector bar. 

H - Docker 
Tabs 

Dockers allow access to effects, styles, colors, and 
many other features of CorelDRAW. They can be 
floated or “docked” at the side of the window.  When 
closed, they are accessible through a vertical tab. 

 

GETTING TO KNOW CORELDRAW 
 
Opening CorelDRAW 
 

1. When CorelDRAW is loaded, a new section is created on 
the Start Menu. To open DRAW, click the Start button from 
the Taskbar. 
This opens the Windows Start menu. 

2. Select Programs from the list. This activates the Programs 
panel. Programs are contained in groups, but rather than being 
initially displayed in a group window, each group is listed. 

3. Find the Corel section and select CorelDRAW 12. This opens 
up the program with the CorelDRAW welcome screen. If you 
have used the program before, you may have turned off this 
screen. 

4. Choose Open Graphic or use the Open command on the File 
menu.  
New Graphic creates a new, one page document. Open Last 
Edited opens the last document you had open. The splash 
screen will show the names of the files over the icon. 
The Template icon allows you to access many professionally 
created templates you can then modify for your own projects. If 
you clear the check from the box in the lower left corner, you will 
not see this graphic but will open a new file when you open the 
program. 

5. Direct the Explorer to your hard drive and the folder where you 
saved the class files. 

6. Choose the file Open 1st.cdr. If the Panose Screen appears 
listing fonts that are not loaded, click the OK button. This utility 
allows you to load fonts for a document when you open the 
document. You must have the Font Navigator utility loaded and 
active for the fonts to install automatically. 
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TOOL OVERVIEW 
 
The Toolbox is located in the left portion of the window and contains all the drawing and editing tools necessary to create objects for an 
illustration.  
Tools containing a small triangle in the corner produce a Flyout. Flyouts contain additional tools, or tool options and are explained below in the 
order they appear on the default screen. Flyouts are described following the Tool Overview. 
 

Pick Tool 

 

Selects objects or groups of objects. Once selected, you can use the Pick Tool of move, stretch, 
scale, rotate, and skew objects. 

Shape Tool 

 
Reshapes objects. Objects are reshaped by moving nodes, lines, and control points. 

Zoom Tool 

 

Changes the current view of the drawing. You can also select magnification options from the 
Property Bar in the Zoom mode. 

Freehand Tool 

 
Draws lines and curves. You can also use this tool to trace bitmaps. 

Smart Drawing Tool  
Converts the freehand strokes you draw to basic shapes and smoothed curves. 

Rectangle Tool 

 
Draws rectangles and squares. Squares are created by using the Control key while drawing. 

Ellipse Tool 

 
Draws ellipses and circles. Circles are created by holding down the Control key as you draw. 

Graph Paper Tool 

 
Draws a collection of boxes that simulates a sheet of graph paper. 

Perfect Shapes Tool 

 

A collection of objects which you can add to your drawing. They include such things as arrows, 
stars, talk bubbles, and flow chart symbols. 

Text Tool 

 
Adds either Artistic or Paragraph text to your drawing. 

Interactive Blend Tool 

 

The Blend Tool allows you to merger objects together through a series of steps. The flyout gives 
access to several more interactive tools that are described on the following pages. 

Eyedropper Tool 

 

The Eyedropper Tool allows you to select a color within an object, especially a bitmap, and allows 
you to apply that color to another object. You can also capture the color for a customized palette. 
The flyout gives access to the paint bucket that applies the color. 

Outline Tool 

 

Sets the outline style of an object or a line. This includes the line type, ends, color, and weight. 
The flyout gives quick access to some changes. 

Fill Tool 

 

Assigns the fill style of any object. Fills are only visible on closed objects. The flyout gives access 
to control dialogs for each type of fill. 

Interactive Fill Tool 

 

  
Allows you to apply Fountain fills (gradients) using the mouse. The flyout gives access to the Mesh 
fill Tool. 

 
FLYOUTS 
 
Tool buttons containing a small triangle in the lower right corner display Flyouts. Flyouts are used by CorelDRAW to display additional tools. 
They are activated by holding down the tool button with the mouse.  
 
The table below is not meant to be a comprehensive look at each tool Flyout, but rather a reference. 
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Flyouts 
Shape Edit Flyout  

 

Holds Shape Edit, Knife, Smudge, Roughen, Free Transform and Virtual 
Segment Delete Tools. 

Zoom Tool Flyout  

 

Holds the Zoom Tool, which is used for changing the view magnification, 
and the Pan Tool, which is used for moving the drawing page around the 
display area. 

Curve Flyout 

 

Holds the Bezier Tool, Artistic Media Tool, Dimension Tool and the 
Connector Tool. Each tool is used to create specific types of lines. 

Rectangle Tool Flyout 
 

 

Holds the Rectangle tool and the 3-point Rectangle tool. 

Ellipse Tool Flyout 

 

Holds the Ellipse Tool and the 3-point Ellipse Tool. 

Object Flyout 
 

 

Holds the Polygon Tool for creating multi-sided objects, the Spiral Tool 
and the Graph Paper tool. 

Perfect Shape Flyout 

 

Accesses the collection of shapes you can add to your drawing . 

Interactive Tool Flyout  

 

Holds the Interactive Blend, Contour, Distortion, Drop Shadow, Envelope, 
Extrude, and Transparency Tools. 

Eyedropper Tool Flyout 

 

Holds the Eyedropper Tool and the Apply Tool for the color, effect, or 
property selected by the eyedropper. 

Outline Tool Flyout  

 

Displays options for changing line color, styles, weights, and ends. 

Fill Tool Flyout  

 

Displays options for changing fill color, styles, creating custom colors, and 
removing fills. 

Interactive Fill Flyout 

 

Holds the Interactive Fountain Fill Tool and the Mesh Fill Tool. 

 
Toolbars and Flyouts can be made to float. Once floating, you can dock them to any part of the window. To float 
a Toolbar or a Flyout, place your cursor over the area at the end of the bar that resembles two ribbed bumps or 
gray lines. Hold down the left mouse button and drag the bar out to the main window of the program. All tools 
on the Flyout will be displayed so you can easily access them.  
 
To dock the Flyout or return the toolbar to its original location, double click on the title bar of the floating Flyout. 
To return the Flyout to its original location, click on the closing X in the upper right-hand corner. Below is the 
Interactive Tool Flyout in floating mode and in Flyout mode. 
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PAGE NAVIGATION WITH THE PAGE SELECTOR 

A CorelDRAW file can have as many as 999 pages. A document of that length, however, might be created more easily in CorelVentura. To 
navigate a multi-page document you use the Page Navigator bar at the bottom left of the work window. From this bar you can add or move 
from one page to another. To delete pages you need to use the Delete Page command under the Layout menu. 

   

1. Click on the Page 2 Tab.  
The Page 2 tab should be white. You can also use the Page Up and Page Down keys on the keyboard. 

2. Select the Page Tab for page 3. The Add Page button should appear as this is the last page for this file. 
3.  Select the First Page arrow button to go back to page 1 
4.  Click on the 1 of 3 space. 
5.  Enter a 3 in the Go to box and click OK. 

THE PROPERTY BAR 

The Property Bar is located just under the Standard Toolbar. It is an interactive command center. Being interactive means that the options on 
the Property Bar change depending on the current task or command. It is designed to save time by interactively displaying commands as you 
work. You will work more with the Property bar as you progress. This section is meant only as an introduction. 

1. Select the Pick Tool . 
2. Place the cursor indicator on top of the purple rectangle and click. 

Small black handles appear designating a selection. You will learn about these later in the class. Notice the Property Bar changed to 
display a new set of options. 

3. Select the text. 
Again, new options display for working with text. 

DOCKERS 

Twenty-four functions of CorelDRAW 12 display in a dialog window called a Docker.  Dockers are placed into the interface or “docked” as are 
Tool Bars or the Property Bar. They are accessed by clicking on the tabs at the right of the working window. Dockers can also float or be 
closed so only the tabs show. Dockers replaced Roll-Ups from earlier version of DRAW. To access the Dockers, go to the Windows menu 
 Dockers. 
 

Docker Function 

Properties Displays the characteristics of the object selected including any Web assignments such as links or hot spots. 
Allows access to the function that changes that characteristic. 

Object Manager Shows the hierarchical structure of objects, layers, and pages within a document including the stacking order 
of the objects. Allows you to move objects from one layer to another. 

Object Data Manager Sets up a spreadsheet-like document recording information about an object. 

View Manager Allows you to change the view without using the menu or the drop down list on the Standard Toolbar. 

Link Manager Allows you to create HTML links within your documents. 

Undo Docker Lists all the moves you have made so you can reverse them. The default is 99 steps. You can change this to a 
smaller number if you wish. 

Internet Bookmark 
Manager Organizes bookmarks you have assigned within a Web project in DRAW. 

Symbol Manager Allows you to set up libraries of objects you use frequently and convert them to symbols. 

Artistic Media T his tool acts as an calligraphy pen, a paint brush or an image sprayer. 

Blend Gives all the controls for the Blend effect. 

Contour Gives all the controls for the Contour effect. 

Envelope Gives all the controls for the Envelope effect 

Extrude Gives all the controls for the Extrude effect 
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Lens Gives all the settings for the Lens effect. 

Bitmap Color Mask This CorelPhotoPaint feature allows you to mask all pixels of a certain color in a bitmapped image. 

Transformations Allows access to all the Transform tools, Position, Rotation, Scale & Mirror, Size, and Skew. 

Shaping Allows access to the Weld, Intersect, Trim, Simplfy, Front minus Back, and Back minus Front operations. 

Color Allow you to create custom colors in each color palette. 

Color Palette 
Browser Lists all color palettes available on the system and allows quick loading and changing of the palettes. 

Color Styles Sets color palette styles just as you set graphics and text styles for consistency within a project. 

Graphics and Text 
Styles 

Sets styles just as you can within a word processor. Allows you to keep text and objects consistent throughout 
a project. 

Scrapbook A storage area for frequently used clipart, text files and many other file types. Also allows quick access to sites 
on the Web or other networked machines. 

Web Connector Allows you to connect to Corel.com. 

COLOR PALETTES 

The colorful row of boxes on the right of the screen is the Color Palette. DRAW comes with 18 
color systems and gives you the ability to create your own palette. The palette can be floated 
or  parked. The type of palette can be changed with the Windows menu, or the Color Palette 
Browser Docker. You may have several palettes open at once. 

The main color palettes include HKS ® Colors, Trumatch Colors, Uniform Colors, Web Safe Colors, 
and the complete Pantone® Matching System including the system that was shipped with 
CorelDRAW 8. (The Pantone system is updated by the company on a regular basis and a major 
change was made in 1998. Pantone numbers assigned in DRAW 8 will not match the system in 
DRAW 9 or DRAW 10.) In addition, the Color Palette Browser Docker includes some specific color 
systems such as human skin colors and natural color systems. Here is also where any custom 
palettes you build will be stored. 

Note: When you hold down a chip on the color palette, a box with shades of that color displays. 
(Shown below.) By dragging to one of the shades of the first color, you can choose a shade of a 
color quickly and apply it to a line or fill an object. 

CHANGING AN OPTION 

The Options dialog allows for extensive customizing of CorelDRAW 12. To make this curriculum easier for you, one of the default settings for 
CorelDRAW 12 needs to be changed before we continue. 

1. Go to the Tools menu Options, Workspace, General 
Or (Ctrl+J), Workspace, General. 

2. Change the Regular Undo setting from 99 to 15. 
Each time you make a change in a document, CorelDRAW 12, makes a full copy of that document so it can reverse your steps if 
you use the Undo command. A level of 99 quickly uses up all the resources of your machine even if you are using a very powerful 
machine. In my opinion, more than 15 undo's constitutes “Start over". 

3. Click OK. 

CHANGING THE VIEW 

Often, when working on an image, you want to see it with out the clutter of the screen or the image has become so complex that you only want 
to see the outlines of the object. These are the View options. 

1. Go to the View menu and select the Wireframe. 
The various view qualities are designed to save screen redraw time for complex drawings. 

2. Change back to the Normal View option. 
The other View options are described below. 
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Views View descriptions 

Simple Wireframe Black and white outlines of the objects. Bitmaps are shown as monochrome grayed areas. 
Does not show blended objects or some other effects. 

Wireframe Black and white outlines of all objects including blend groups. 

Draft 

Displays most items as they will be printed but uses patterns to represent certain fills. A 
checkerboard pattern is displayed for the two-color fills. Two-headed arrows display for full 
color fills. Hatched line patterns display in place of bitmap fills. A pattern of repeated PS 
displays for the PostScript fills. Screen redraw time is much faster in Draft mode. 

Normal Displays all object, high resolution bitmaps and all fills except PostScript. 

Enhanced Displays the best possible quality for your monitor and shows all PostScript fills. 

Full screen preview Removes all the DRAW elements from the screen and shows the image at the best possible 
resolution and against a white background. 

Preview Selected only Shows the selected object at the best possible resolution and separates it from the other 
objects. 

Page Sorter View This allows you to rearrange the pages of a multi-page document and to view all the pages 
of a multi-page document in thumbnails format. 

THE ZOOM PROPERTY BAR 

As you work on an image, you may want to get closer to see detail or make small adjustments. DRAW gives you several options for zooming 
into your object or out. When the Zoom Tool on the Toolbox is selected, the Property Bar displays the following options. 

Zoom Commands 

Zoom In  

Allows you to get closer to your drawing and work on detail. You can drag a marquee 
box around a point and zoom into that point. Clicking with the cursor zooms you in to 
double the previously set view level. 

Panning  

Allows you to move about the page with precision. With a work area of 250 feet (yes 
that is feet!), it is easy to get lost. This allows you to move the page as if you could use 
your hand. 

Zoom in and out  

Clicking with the plus Tool zooms you in double the last view setting, for example, if 
you are at 100%, you will go to 200%. Clicking with the minus Tool zooms you out to 
the last setting. Using the example in the previous sentence, it would put you back to 
100% 

Zoom To Selected 

Zoom To All Objects 

 

Changes the display to show only selected objects (Shift+F2). Changes the view to 
display all objects (F4). This will include objects located outside of the page. 

Zoom To Full Page, Page Width, or Page 
Height  

 

 

Allows you to see the entire page (Shift+F4). Changes the current magnification to 
include the left and right edges of the page. Changes the current magnification to 
include the top and bottom edges of the page. All three cause the page to be shown at 
less than 100% magnification. 

Zooming 

1. Go to the Toolbox and select the Zoom Tool (F2). 
The mouse cursor changes to the magnifying glass with the plus sign. The Property Bar also displays the tools described above.   
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2. Click in an area. 
You have just gotten closer to the drawing. You can also zoom in by dragging the Zoom Tool around a specific area. 

3. Press the F3 key on your keyboard. 
This shortcut zooms out to the previous view each time you press it. 

4. Place the tool icon to the upper right of the Bluebonnet. 
5. Click and drag diagonally to create a zoom marquee. 
6. Release the mouse. 

By dragging the Zoom Tool around an area, you can enhance the magnification and be more precise by zooming to a specific area. 
7. Go to the Standard Toolbar and select the Zoom Levels list (the box showing the % of magnifications). 

Values for the magnification settings can be selected from the list, or typed in as needed. 
8. Select To Page (Shift + F4). 

This will change the display to show you the whole page. 

Changing preview settings 

1. Go to the View menu and select the Full Screen Preview (F9). 
The window changes to display only the drawing. All window components are removed. 

2. Press the Escape key on your keyboard. 
This will take you back to a standard preview or you can use the right mouse button. 

SELECTING OBJECTS 
 
In order to change an object, it must first be selected.  

To select an object you use the Pick Tool.  
Each time you select an object, an invisible bounding box designated by eight selection handles is displayed around the object. An x appears 
at the exact center of the object or objects. This provides a point to grab when you want to move an object. Selection handles are also used to 
resize an object using the mouse. The smaller hollow points appearing on the object after selection are nodes. Nodes designate the start and 
stop points of line segments. Nodes and line segments are used to reshape an object. Once it is selected you can manipulate an object. 

Selecting single objects 

1. Go to the Standard Toolbar and select the Open button. 
2. Go to the folder on the hard drive where you saved the class files. 
3. Open the file Open 2nd.cdr 

This is a multi-page file containing simple objects. You will learn how to properly select and perform basic editing techniques. 
4. Go to the Toolbox and select the Pick Tool. 

Remember to hold the mouse over a tool button if you do not remember the name of a tool. The small box will appear next to the 
mouse pointer displaying the name of the tool or other information about the button. 

5. Place the Pick Tool cursor icon in the middle of the blue square. 
6. Click to select the blue square. 

The black squares are the selection handles. When you select an object, dimension information appears on the Property Bar at the 
top of the screen and descriptive information appears on the Status Bar at the bottom of the screen. 

7. Click and drag to move the square downward into rectangle 2. 
As you begin to drag, a 4-pointed arrow replaces the cursor. You will discover that the changes in the mouse cursor designate 
certain editing functions. 

Marquee selecting 

1. Place the Pick Tool cursor just outside and above the circle and hexagon. 
2. Click and drag to surround the objects. 

By dragging with no objects selected, you create a 'dotted line box’. All objects within this dotted line or marquee will be selected. 
3. Release the mouse when they are surrounded. 

Notice the Status Bar. It will help verify how many objects are selected. 
4. Place the cursor over the center X. 
5. Hold down the mouse button and drag both objects next to the square. 

Objects act as one while they are group-selected. 
6. Press the Escape key to deselect all objects. 

You can also click in a blank area, but sometimes this may inadvertently select something else. 

If you start out to select multiple objects and do not quite surround them all as you drag, hold down the Alt key while dragging, and any objects 
touched by the marquee will be selected. 
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Shift-Select 

1. Select the square. 
2. Hold down the Shift key. 
3. Click on the circle. 

The selection is extended to the circle. Notice the selection handles. 
4. Click on the polygon. 
5. Release the Shift key. 

The selection handles surround all three objects. You should have all three objects selected. Check the Status Bar to be sure you 
have three objects. 

You can also select all objects on a page and the desktop by double-clicking the Pick Tool. 

Removing objects from a selection 

1. Be sure the three objects are selected. 
Check the Status Bar to be sure. If the Status Bar does not display the properties of the objects, right click on the Status Bar area 
and choose Refresh. 

2. Hold down the Shift key. 
3. Click on top of the circle. 

Notice the Status bar. Even though the selection handles remain around all three, only 2 objects are selected. Check the Status Bar 
to be sure. 

4. Place the cursor on the X. 
5. Hold down the mouse button and drag the 2 objects up about one inch. 

The circle remains in place. 

Nudging Objects 

Sometimes you only want to move an object a small distance or you want to move several objects the same distance. The arrow keys allow 
you to nudge an object. The default nudge is one tenth of an inch (0.10). You can change the distance in the Options Edit dialog or on the 
Property Bar with nothing selected. 

1. Select the circle. 
2. Push the up arrow key on the numeric key pad at the right of your keyboard. 
3. Push the down arrow key. 
4. Push the right arrow key, then the left arrow key.  

Each time the object has been moved one tenth of an inch in the direction of the arrow. 

Resizing objects with the selection handles 

Scaling and resizing are essentially the same technique, except that scaling resizes both the height and width at the same time. Scaling an 
object means that the proportions (size relationships) between the height and width are maintained. For example, if a square is 1 inch by 1 
inch and you scaled it 200 percent, it will become 2 inches by 2 inches. 

1. Go to page 2. 
2. Select the blue square. 
3. Place the cursor on the lower right corner. 

Your cursor should change to the double-headed arrow cursor. If it doesn't you missed the handle. 
4. Click and drag downward along the red line. 

Dragging a corner handle scales objects proportionally. 
5. Release the mouse button. 
6. Select the red square. 
7. Place the pointer on the left middle selection handle. 
8. Click and drag to the left. Repeat to the right. 

Dragging any middle handle will allow you to resize along one side only. Notice the cursor shows which direction you may move 
using that selection handle. 

Quick Copying 

1. Go to page 3. 
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2. Select the kangaroo. 
3. Click and drag to the end of the dotted line. 
4. Do not let go of the left mouse button. 
5. Click the right mouse button while you hold down the left button.  

Right-clicking while an object is selected is a fast way to create a duplicate. 
6. Release the left mouse button. 

You should have a duplicate of the kangaroo. 
7. Proportionally reduce the size about 50%. 

Watch the Status Bar as you resize. 
8. Place the smaller kangaroo at the end of the dotted line. 
9. Create a few more copies and resize them just to get some practice. 

Tip: You can also specify the resize percentage of an object by typing  values in the Scale Factor text box on the Property Bar. The lock 
button next to the boxes controls how the changes will be applied. When the lock is closed, the changes will stay in proportion or when open, 
allow you to change one dimension without effecting the other. 

Rotating and Skewing Objects 

Special selection handles, called Rotate and Skew handles, are available to rotate and slant objects using the mouse. Objects are rotated 
around a pivot point. The pivot point can be relocated outside of the object. This is handy when you want to rotate one object around another. 

Free rotation 

1. Go to page 4. 
2. Select the top rectangle. 
3. Click on it a second time as if selecting it again.  (Do not double-click). 

Selecting an object twice activates the special rotate/skew handles. This is not the same as double-clicking, where you click rapidly. 
The circle in the middle is the pivot point. 

4. Place the cursor on one of the corners. 
The cursor icon changes indicating that you can rotate the object. 

5. Click and drag the corner handle in a circular motion. 
The cursor changes again to display the rotate cursor. 

6. Watch the Property Bar to see the degree of rotation as you move.  
Rotating objects counterclockwise produces a positive angle(+), while rotating clockwise produces a negative angle(-) of rotation. 

Rotation with control 

You can add precision to your rotation by using the Control key. This technique will restrict the rotation to 15-degree increments. Rotating 
clockwise will produce a negative value (-15 degrees), rotating counter clockwise will produce a positive value (15 degrees). The increment of 
rotation can be changed in the Options dialog. 

1. Go to page 5. 
2. Select the green circle. 
3. Click the circle again to activate the Rotate and Skew handles. 
4. Move the cursor over the target mark in the middle of the green circle. This is the pivot point. 
5. Hold down the left mouse button and move the pivot point down to the center of the large yellow circle. 

The position indicator on the Property Bar should read 4.25 and 5.5, the middle of the page. This will change the rotation and allow 
the green circle to rotate around the larger yellow circle. 

6. Hold down the Control key. 
7. Place the cursor on the upper right rotation handle of the green circle. 
8. Move the handle clockwise.  

As you rotate the green circle, the Property Bar shows you how far you have rotated. With the control key down, you will move in 15-
degree increments. Because the pivot point has been moved in the center of the yellow circle, the green circle moves around the 
yellow one. 

9. Release the mouse button. 
10. Go to the Edit menu and select Undo (Ctrl+Z). 

By default, the Undo command will reverse the last action. 

Copying while rotating 

Remember to keep the left mouse button down until you are finished! 
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1. Select the green circle again and activate the Rotate and Skew handles. 
2. Hold down the Control key. 

The Control key constrains the movement of the object. 
3. Click and drag to rotate -30 degrees (clockwise).  

Remember to watch the Property Bar as you rotate. The Angle of Rotation section in the middle displays rotation angle as you 
rotate. 

4. Before letting go of your left mouse button, right click. 
This should produce a duplicate at the 1 o'clock position. 

5. Release the left mouse button then the Control key. 
6. Go to the Edit menu  Repeat Rotate. 

The Repeat command repeats the last action. The last command will follow the word Repeat on the menu. Another duplicate is 
created 30 degrees away from the second green circle. 

7. Press Ctrl+R. 
This is the Repeat command. A new green circle should be added to the drawing. 

8. Keep using the Repeat command (Ctrl+R) until the circles form a clock similar to the one shown below. 

Tip: You can also rotate objects by specifying an increment in the Angle Rotation section of the Property Bar. You cannot, however, create 
duplicates while rotating this way. If the object does not move after you change the parameters on the Property Bar, press the Enter key. 

Skewing objects 

Skewing slants an object along either the horizontal or vertical plane. This technique is used often to give the illusion of distance or movement. 

1. Go to page 6. 
2. Select the top gray text object. 
3. Activate the Rotate and Skew handles. 
4. Place the cursor on the top middle Skew handle. 
5. Click and drag to the right about 1 inch. 
6. Move the red text object on top of the gray text. 

This combination produces a cast shadow. 

Flipping objects 

1. Go to page 7. 
2. Select the blue triangle. 
3. Place the cursor on the middle left selection handle. 
4. Hold down the Control key. 
5. Drag the handle over to the middle right selection handle. 

As soon as you begin to drag, the cursor turns into a double-headed arrow. 
6. Release the mouse button. 
7. Release the Control key. 

When using a combination of the mouse and keyboard, always let go of the mouse first. 
8. Select the red triangle. 
9. Place the cursor on the middle top selection handle. 
10. Hold down the Control key. 
11. Drag the handle over to the bottom right selection handle. 

As soon as you begin to drag, the cursor turns into a double-headed arrow. 
12. Release the mouse button. 
13. Release the Control key. 
14. Use a corner handle to flip the shapes diagonally. 

Using the Property Bar to flip 

You can also flip objects from the Property Bar. There are two buttons located to the right of the Angle Rotation portion that are used to flip 
objects. 

1. Go to the Standard Toolbar and select the Undo arrow twice. 

(Ctrl+Z or Edit Undo)  
When you select the arrowheads, a drop down list shows you all the steps you have done since the last save. This allows you to 
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undo one particular step or a series of step. It is an advanced feature that you might find useful but will not be addressed in this 
class. 

2. Select the blue triangle. 
3. Go to the Property Bar and select the top Mirror button. 

The object is flipped left/right.  

4. Flip the red rectangle using the lower Mirror button. 
Using the button makes the object flip in place so sometimes you can't really see what moved. 

THE DRAWING TOOLS 
 

Drawing Tools 

 
The Curves Flyout 

Freehand Tool  

The first tool on the Curves flyout is used for creating freehand lines (similar to scribbling). 
While holding the Control key your lines are constrained to 15-degree angles. This helps you 
draw simple straight lines. 

Beziér Tool  
The second tool on the Curves flyout is used to create curved lines by using special control 
points. It is one of the more difficult tools to master. 

Artistic Media Tool  

The third tool on the Curves Flyout acts as an calligraphy pen, a paint brush or an image 
sprayer. We will not cover this tool in this class. 

Pen Tool  
The fourth tool on the Curves Flyout allows you to draw curves one segment at a time. It is 
similar to the Beziér tool. 

Polyline Tool  
The fifth tool on the Curves Flyout allows you to draw connected straight lines and curves 
one segment at a time without double clicking. 

3-Point Curve Tool  

The sixth tool on the Curves Flyout allows you to specify both the height and width of a curve 
as you draw it. It works very much like the 3-point ellipse tool. You will not cover this tool in 
this class. 

Connector Line Tool  
The seventh tool on the Curves Flyout creates dynamic connectors between shapes as in a 
flow chart. 

Dimension Line Tool  
The eighth tool on the Curves Flyout creates dimension lines for technical and architectural 
drawings. You will not cover this tool in this class. 

Rectangle Tool  
Used for creating basic rectangles and squares. Squares are created when holding down the 
Control key as you draw. The flyout gives you the three-point rectangle tool. 

Ellipse Tool  
Used for creating basic elliptical (oval) shapes and circles. If you need circles, hold down the 
Control key while drawing. The flyout give you the three-point ellipse tool. 

Graph Paper Tool  
The Graph Paper Tool is used to create a group of identical boxes that simulate at sheet of 
graph paper. When the Flyout is activated you can also select the Spiral and Polygon Tools. 

 

Drawing Rectangles 

1. Go to the Standard Toolbar and select the Open button. 
2. Go to the folder where you stored the class files and open Open 3rd.cdr. 

This file contains templates for drawing basic shapes. 
3. Go to Toolbox and select the Rectangle Tool.  

Notice the cursor changes to indicate the tool you are using. Place the cursor in the upper-left corner of the top rectangle shape. 
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4. Click and drag diagonally along the red line.  
You can also draw a rectangle shape by drawing one dimension (height), then the other (width). Release the mouse button when 
finished. 

Drawing squares 

1. Move to the square shape. 
2. Place the cursor on the upper left corner. 
3. Hold down the Control key. 

Don't release it until you are finished. The Control key constrains the sides of the rectangle, forcing it to become a square. 
4. Click and drag diagonally along the red line. 
5. Release the mouse first, then the Control key. 

Since the keyboard is modifying the mouse, you must release the mouse first. If you do not, you will lose the modification – in this 
case the constraint for creating the square. 

6. Try redrawing the objects for practice. 

Drawing from the center 

1. Go to page 2. 
2. Be sure the Rectangle Tool is selected. 
3. Place the Rectangle Tool in the center of the rectangle at the cross marks. 
4. Hold down the Shift key 

The Shift key modifies drawing tools to draw objects from their centers. 
5. Click and drag down and to the right to create a rectangle. 
6. Release the mouse first, then the Shift key. 
7. Move to the square shape. 
8. Hold down both the Control key and the Shift key. 
9. Click and drag to draw the square. 

You can use both modifiers at the same time while drawing . 
10. Practice some more if you need to. 

Drawing a 3-Point Rectangle 

1. Go to page 3. 
2. Choose the 3-point rectangle tool from the rectangle flyout. 
3. Click on the red dot marked 1 and hold down the mouse button. 
4. Drag to the red dot marked 2. 
5. Release the mouse button. 
6. Click on the red dot marked 3. 

The tool allows you to establish the height and width of the rectangle as you draw. Practice by doing the second rectangle. 

Note: If you have trouble making the first line of the rectangle straight, hold down the Control key as you draw the first line of the 3-Point 
Rectangle but let up after you release the mouse button. This insures your rectangle is straight but does not draw a square. The Control key 
will constrain your 3-Point rectangle to a square just like with the standard rectangle tool if you hold it down as you go to the third point. 

Drawing Elliptical Shapes 

Elliptical shapes are created using the same basic mouse movements as those used when creating rectangles and squares. By adding the 
Control key you can create circles while drawing with the Ellipse Tool. 

1. Go to page 4. 
2. Go to the Toolbox and select the Ellipse Tool. 

Notice the cursor indicates which tool you are using. 
3. Place the cursor on the blue dot. 
4. Click and drag diagonally along the red line. 
5. Release the mouse button.  

Notice that the selection indicators for the ellipse are showing a bounding box, not a bounding ellipse. The point where you began 
the ellipse is not where the line of the ellipse is drawn. This is a good reason to draw your ellipses from the center. 

6. Place the cursor on the red dot. 
7. Hold down the Control key 
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8. Repeat drawing as in step 4. 
The Control key proportionally constrains the height and width to create a circle . 

9. Release the mouse, then the Control key. 

Drawing elliptical shapes from the center 

1. Go to page 5. 
2. Place the Ellipse Tool on the crossed lines in the dotted ellipse. 
3. Hold down the Shift key. 
4. Click and drag to create an ellipse. 
5. Release the mouse, then the Shift key. 
6. Move to the circle shape. 
7. Hold down the Control key and the Shift key. 
8. Repeat drawing as in step 4. 
9. Release the mouse, then the keyboard keys. 

Drawing a 3-Point Ellipse 

1. Go to page 6. 
2. Choose the 3-point ellipse tool from the Ellipse flyout. 
3. Click on the red dot marked 1. 
4. Drag to the red dot marked 2. 
5. Let up on the mouse button. 
6. Move the cursor to the the red dot marked 3. 

The final movement sets the height or diameter of the ellipse. Notice it ends at the bounding box indicator. 

Note: The Control Key constraint works here just as it does in the standard ellipse. Hold down the Control Key as you drag the line to 
establish the diameter of the circle and when you click on the outside of the circle for the third point, you will get a circular ellipse of exactly 
that diameter. The technique for drawing with the 3-Point Curve tool is the same as that for the 3-Point Ellipse. You establish the first point, 
drag to the end of the curve, then drag to establish the height of the curve. 

Drawing Polygons 

Polygons are multi-sided closed shapes. By default, the Polygon Tool is set to draw pentagons. By changing the tool properties, you can draw 
a polygon with up to 500 sides, which looks very much like a circle. 

Drawing Spirals and Grids 

1. Go to page 7. 
2. Hold down the Graph Paper Tool button to activate the Object Flyout. 
3. Select the Spiral Tool. 
4. Using click and drag, draw the spiral object. 
5. Delete the object. 
6. Repeat drawing while holding down the Control key. 

Remember that the Control key keeps the proportion as you draw. 
7. Hold down the Spiral Tool button. 

After selecting a tool from the Flyout, it becomes an active tool button. 
8.  Select the Graph Paper Tool. 
9. Draw a grid with the Graph Paper Tool. 
10. Repeat using the Control key. 

Note: The Graph Paper Tool creates the grid out of rectangles. You can ungroup them and resize them if needed. 

Drawing Polygons 

1. Go to page 8. 
2. Go to the Toolbox and select the Polygon Tool from the Object Flyout. 

Remember holding down a tool button that contains a triangle produces a Flyout.  
Notice the change in the cursor. 

3. Place the cursor at the start point for the triangle. 
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4. Click and drag along the red line. 
As you can see, it does not draw a triangle. To draw a triangle the number of sides must be changed in the tool properties. 

5. Release the mouse. 
6. Go to Standard Toolbar and select the Undo button.  

The drop down list on the Undo button allows you to undo several steps at a time. 
7. Go to the Property Bar. 

8. Change the number of points/sides to 3.    
9. Hold down the Control key. 

The Control key will keep all sides equal while drawing. 
10. Redraw the triangle. 
11. Change the number of sides to 6. 

Refer to the previous steps if needed. 
12. Draw the hexagon by following the red line. 

 The PerfectShapes Flyout 

The Perfect Shapes tool allows you to draw several kinds of objects quickly. Perfect Shapes can be filled, resized, 
and effected just like any object you draw. The Perfect Shape displays a red diamond to show it is a Perfect 
Shape.  

Basic Shapes This is a collection of 15 basic shapes you can use as the foundation of an object. The example above is one of 
these shapes. 

Arrow Shapes This is a collection of 21 different types of arrows to use with a drawing. 

Flowchart Shapes This is a collection of 23 shapes commonly used in a flow chart. 

Star Shapes This is a collection of 12 stars and star bursts. The polygon tool will create a 5-pointed star but with internal 
lines. This tool creates a 5-pointed star without internal lines. 

Callout Shapes This is a collection of 6 text balloons for use as callouts in both cartooning and technical drawing. 

1. Go to page 9. 
2. Go to the Toolbox and select the PerfectShapes tool flyout. 

3. Select the Star Shapes tool.  
4. Go to the Property Bar and drop down the options menu.  
5. Choose the 5-pointed star. 

The second option is the 5-pointed star. 
6. Click and drag down the red line to form a star. 
7. Go to the flyout and choose the PerfectShapes tool. 
8. Go to the Property Bar and drop down the options menu. 

Notice the menu button icon changes for each options. 
9. Choose the smiley face object. 
10. Click and drag to on the red guide line. 
11. Go to the PerfectShapes flyout and select the Callout tool. 
12. Go to the Property Bar and choose the option that matches the guide. 
13. Click and drag in the direction of the arrow.  

The beginning point sets the tail or narrow point of the text balloon. 

Drawing Lines and Curves 

1. Go to page 10. 

2. Go to the Toolbox and select the Freehand Tool.  
Notice the cursor changes to indicate the tool you are using. 

3. Click to start the line (do not drag). 
When you drag the tool it does not draw straight. 

4. Move to the end of the line and click again. 
Clicking a second time sets the line segment. 
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5. Draw another line while holding down the Control key. 
The Control key is used to help draw straight by constraining the line to horizontal or vertical. It can be angled at 15 degree 
increments. The constraint value can be changed using the Options, Workspace, Edit dialog box. 

6. Draw the diagonal line while holding down the Control key. 
7. Place the tool on the left end of the curved line at the bottom of the page. 
8. Click and drag to trace over the curved line. 
9. Go to the Edit menu and choose Select All. 
10. Delete the lines. 
11. Take a moment to practice drawing more lines. 

Creating polylines 

1. Go to page 11. 
2. If needed, select the Freehand Tool again. 
3. Place the Freehand Tool at the top left end of the object. 
4. Click to start the first line segment. 
5. Move down to the first dot. (Do not drag!) 
6. Double-click. 

This ends one line and begins the next line so they are connected. 
7. Move to the second dot. 
8. Double-click. 

This ends one line and begins the next line so they are connected. 
9. Repeat the previous steps. 
10. Move to the last dot. 
11. Click once to stop drawing. 

Clicking only once will end the line. 

Tip: If you stop prematurely, you can continue drawing on the same line by placing the Freehand Tool on the end and start drawing again. 
DRAW assumes you want to connect the lines if you begin again close to the end of another line. 

The Beziér Tool 

The Beziér Tool creates curves by adding control points to the line segments. These control 
points are used to bend the lines as you draw. It is one of the more difficult tools to use. If you 
do not get the hang of it right away, don’t feel bad. It just takes practice. The next exercise 
uses the familiar connect-the-dots approach to help you learn the Beziér Tool. The Pen tool 
was added in Draw 11 and is a modified Beziér tool. You will draw with each. 

Be sure to follow the steps closely. As you will find out, the tool works differently based on 
how you start and stop the curves. When you are finished you will have created a leaf that 
looks similar to the one below. 

Tip: With the Beziér Tool, Click & Drag creates the curve reference point while Click makes the line. 

1. Go to page 12. 
2.  Hold down the Freehand Tool button. 

3. Go to the Flyout and select the Beziér Tool.  
Notice the cursor change. 

4. Place the cursor on dot 1. 
5. Click and drag to dot 2.  

The small black squares at the end of the dotted line are the control points. They help shape the curve of the line while drawing. The 
control points work like magnets as they pull the line toward them. 

6. Release the mouse button. 
7. Move to dot 3 (DO NOT DRAG). 
8. Press and hold down the left mouse button until the line appears. 
9. Drag to dot 4. 

Moving to a new spot before dragging sets the line first, then creates the curve. 
10. Release, then click and drag to dot 5.  

This combination starts a new line segment and allows the new curve to be independent of the previous one. 
11. Release the mouse button. 
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12. Move to dot 6. 
13. Press and hold down the mouse button until the line appears. 
14. Release the mouse button. 
15. Place the cursor on top of the start point on the red dot. 
16. Double click and the line should appear.  
17. The shape should close. It can now be filled with color. 

Mixing colors 

1. Select the square again. 
2. Hold down the Control key and select another color on the color 

pallete. 
3. Click once on the other color.  

CorelDRAW adds a 10 shading of that color to the square. 
4. Click again on another color to mix it with the first.  

You can see how you can manipulate the colors here to obtain a 
new shade for your drawings.  

By dragging 

1. Select the star. 
2. Click on a color and drag that color to an arm of the star.  

The cursor icon changes to show you are dragging a fill color. The 
color will be used to fill the star. Note that only parts of the star will 
be filled. The default setting in DRAW creates a six chambered 
object from the polygon. To create a star with one area, must use 
the Perfect Shapes tool. 

3. Click on another color and drag that color to the line that creates 
the star.  
The cursor icon changes to show you are dragging a line color. 

4. Practice this function by changing the colors in the other two 
objects. 

An Overview of Fills 
 
All closed objects can contain fills. Fill styles range from a simple color to a 
complex bitmap pattern. Fill types are applied to objects through the Fill Tool. 
Once the object is selected you can choose a fill type from the Fill Tool Flyout. 
Each fill style has unique characteristics and editing options that are 
controlled through their respective dialog boxes. 
 

Fill Tool Flyout 

Uniform Fill  

Opens a color dialog box that allows you to 
change palettes, mix colors, and apply solid colors 
to selected objects. 

Fountain Fill  

Creates a gradient fill. Gradients are formed by 
merging multiple colors together. 

Pattern Fill  

Fills the object by tiling the pattern. You can select 
from one of the standard fills or create custom fill 
patterns. 

Texture Fill  

Applies a fractal fill. Textures are created using 
bitmap images. The texture can be edited 
extensively by the user. Many sample fills are 
provided as a starting point. 

PostScript Fill  

Fills the object with a selected PostScript fill 
pattern. These will print only on a PostScript 
printer. Because of the complex nature of these 
fills, they only display in Enhanced View. 

No Fill  

Removes the fill of selected objects. It is the same 
thing as selecting the invisible fill from the Color 
Palette. 

Color Docker  

Used to create color and apply it to either the Fill 
or Outline of an object. 

 

The Pen tool 

1. Go to page 13. 
2.  Hold down the Freehand Tool button. 

3. Go to the Flyout and select the Pen Tool.  
Notice the cursor change. 

4. Place the cursor on dot 1. 
5. Click and drag to dot 2.  

The small black squares at the end of the dotted line are 
the control points. They help shape the curve of the line 
while drawing. 

6. Release the mouse button. 
7. Move to dot 3 (DO NOT DRAG).  

Notice that unlike the Bezier tool, the line is drawn as 
you move the pen. 

8. Press and hold down then Drag to dot 4. 
9. Release, then click and drag to dot 5.  

This combination starts a new line segment and allows 
the new curve to be independent of the previous one. 

10. Release the mouse button. 
11. Move to dot 6. 
12. Release the mouse button. 
13. Place the cursor on top of the start point on the red dot. 
14. Single clicking ends the drawing. 

As you can see, the new Pen tool is somewhat easier to use. If 
you are going to draw many curves, it will be worth your time to 
master these tools as well as the 3-Point curve tool. 

Applying Color 

With the mouse 

Although color can be applied using the Fill or Outline Tool, it is 
faster to apply color directly from the Color Palette. 

1. Go to page 14. 
2. Select the square. 
3. Go to the Color Palette and select a color by clicking 

the left mouse button. 
The square should fill with your selected color. 

4. Look at the Status Bar in the far right lower corner. 
The Status Bar changes to give you the fill information 
on the selected object. You can enlarge the Status Bar 
height by dragging the top border. 

5. Right-click on a different color. 
The outline is now changed. The right mouse button 
assigns the outline color. 

6. Change the fill and outline of the other objects. 
7. Select the blue text. 
8. Right-click on a different color. 

The outline fill also works with text object. 
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ALIGNING OBJECTS 

When preparing to align objects the selection order is important. All 
selected objects will align to the last selected object. 

1. Go to page 16. 
2. Select the yellow 'X'. 
3. Hold down the Shift key. 
4. Select the red circle, then the blue box. 

Objects align with the last one selected. 
5. Go to the Arrange menu, Align and Distribute. 
6. Select the Left Align option. 
7. Click OK.  

Changes do not take effect until you apply them. Notice how 
the objects all aligned with the blue box. That is because it was 
the last selected object. The Preview button allows you to 
move the dialog box and see if the resulting alignment is what 
you wanted. 

8. Activate the Align and Distribute dialog box. 
9. Select both the Center options. 

Selecting both options at the same time will center objects on 
top of each other. 

10. Click OK. 
A fast way to center objects on each other is to click the Center 
to Page box, then clear the Center to Page leaving the other 
two boxes checked. 

Alignment shortcuts  

DRAW provides some fast alignment options using 
the keyboard. At least two objects must be selected 
for this function to work. 

1. Select the yellow 'X'. 
2. Hold down the Shift key. 
3. Select the red circle, then the blue box. 
4. Press the t key.  

Objects are aligned at the top of their 
bounding boxes. 

5. Practice using these short cuts. 

Distributing objects 

1. Go to page 16. 
2. Select all the objects on the page. 

You can use the Select All command from the Edit menu, or double-click on the Pick Tool button. 
3. Go to the Align and Distribute dialog box  and select the Distribute tab. 
4. Select the vertical center option. 
5. Click OK. 

The objects are now evenly spaced out between the top and bottom. 
6. Go to the Edit menu select Undo. 
7. Go to the Align and Distribute dialog box and select the Distribute tab. 
8. Select Vertical Center option again. 
9. Select the Align tab. 
10. Select the Horizontal Center option. 

As long as you do not click OK, options from one panel remain active allowing you to combine both align and distribute options. 
Adding the Center align option will align and distribute objects at the same time. 

11. Click OK. 

Note: Attempting to distribute a large number of objects will sometimes result in odd, unexpected arrangements. When this occurs, a function 
of the way the program remembers where objects are, called stacking order, has interfered with the distribution. Try distributing a objects a 
few at a time. 

Alignment Options 
A. Vertical Alignment Options 

B. Horizontal Alignment Options 

C. Page Alignment Options: 
Edge of Page… 
Aligns objects on edge of drawing page along the 
parameter you select. For example, Right side, edge of 
page aligns all objects to the right edge of the page, along 
their right sides. 
Center of Page… 
Moves all objects to the center of the page. Ungrouped 
objects will stack. 

Note: The Align and Distribute functions effect the objects 
according to the bounding box, or area of the object. When 
you select an object, the selection boxes are on the edges of 
this box. Keep this in mind when aligning irregularly shaped 
objects. To achieve an exact alignment, you may need to 
manually move an object. 

Key Function 
e Aligns selected objects by their horizontal centers. 

c Aligns selected objects by their vertical centers. 

l Aligns selected objects by their left sides. 

r Aligns selected objects by their right sides. 

b Aligns selected objects by their bottom edges. 

t Aligns selected objects by their top edges. 

p Aligns selected objects to the center of the page. 
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Ordering Objects 

1. Go to page 17. 
2. Select the red object. 

This object is actually the background and needs to move to the back. 
3. Go to the Arrange menu – Order - To Back (Shift+Page Down).  

Tip: You can also use the To Front and To Back buttons from the Property Bar.  
4. Select the lemon.  

Notice it is a group of two objects, the yellow lemon and the white light accent. 
5. Go to the Arrange menu - Order - In Front of. 
6. Click on the green leaves with the large black arrow.  

The leaves are moved behind the lemon. 

Note: Often, the Back One or Forward One commands don't seem to work. The computer creates a 'page' for each object. What you see as 
two objects next to each other, may be several 'pages' apart. This is why Corel added the In Front of command. This is called the stacking 
order of the objects. 

CREATING DUPLICATES 

  

The copy command 

The Copy command is great for duplicating objects when the object 
needs to stay in the same place on multiple pages – for example, a 
header or footer. You can also use the '+' on the number keypad to 
copy and paste objects but only on the same page. 

1. Select the yellow circle. 
2. Go to the Edit menu and select Copy (Ctrl+C). 

>A duplicate is made and placed on the Windows 
Clipboard. 

3. Return to the Edit menu and select Paste (Ctrl+V). 
The copy is placed directly over the original. 

4. Move the copy to the right. 
5. You can also use the Cut, 

Copy, and Paste buttons pictured 
here. 

Working with Object Groups 

Often, when working with many groups, you want to insure the objects don't move in relation to each other. To keep objects in the same place, 
DRAW provides the Group function. 

1. Go to page 20. 
2. Go to the Edit menu and choose Select All. 

Double clicking on the Pick Tool  also selects all objects. 
3. Go to the Property Bar and select the Group button (Ctrl+G). 

You can also find this command under the Arrange menu. Look at the Status Bar. When objects are grouped, the Status Bar tells 
you that you have selected a group and how many objects are in the group. 

4. Move the group to a new location. 
5. Go to the Color Palette and select any color. 

The whole group changes. As long as they are grouped they will act as one object. 

Editing within a group, child objects 

Sometimes, you may want to change one object within a group but don't want it to move. 

The duplicate command 

The Duplicate command creates a copy of the original and places 
it back into the drawing offset from the original. 

1. Go to page 18. 
2. Select the red box. 
3. Go to the Edit menu and select Duplicate (Ctrl+D). 

The Duplicate command creates a copy and places it 
back into the drawing offset to the top and right of the 
original. This default placement can be changed from 
the Options dialog box or on the Property Bar when 
nothing is selected. 

4. Go to the Color Palette and select a gray color. 
5. Move the gray object to the back (Shift + Page Down). 

This creates a drop shadow for the red box. 
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1. Place the pointer over the antelope. 
2. Hold down the Control key. 
3. Select the antelope. 

Round selection handles appear. You can now make a change to the object. The text is on a separate layer and is locked. 
4. Release the Control key. 
5. Move the antelope down a bit. 
6. Change the color of the antelope. 

You can do almost any editing task without ungrouping. 
7. Press the Escape key to finish. 
8. Reselect the group of objects. 
9. Go to the Property Bar and select the Ungroup button (Ctrl+U).  

This button acts as a toggle between grouping and ungrouping. 
10. Press the Escape key to deselect the objects. 

Even though the objects are now separated from the group, they remain group-selected. Deselect them first before selecting them 
individually. 

Note: The Ungroup All command releases all groups within groups. For example, you have three groups of three objects grouped together. 
When you use the Ungroup command, the status bar will show three groups selected. When you use the Ungroup All command, the status 

bar will show nine objects selected.  

Placing Objects with Precision 

1. Go to the class files folder and open the file Open 4th.cdr.  
Remember you can open a file from the File Menu, from the Standard Toolbar, or using Ctrl+O. 

2. Go to the Windows menu  Docker  Transform  Position. 
This opens the Transform Docker with the Position function active. 

Indicator grid on Transform Docker 

CorelDRAW uses the terms Horizontal and Vertical to indicate which dimensions are changed on an object. 
Shown here are an indicator grid and properties you will see on many Dockers. The indicator grid, the nine 
boxes with the center box selected, show where the parameters you fill in will apply. For Position, DRAW 
moves the object so that the point on the gird is at the parameters you set or moves the object that distance 
in the direction given by the grid. For Rotate, it shows the point of rotation. For Scale, the grid gives the 
direction of the change. For Size, it will show the direction of the change and for Skew, the direction of the 
skew. You will practice each of these in the following exercises. The buttons at the top indicate Position, 
Rotation, Scale and Mirror, Size and Skew. 

Position objects precisely 

1. Select the rectangle at the top of page 1. 
2. Go to the Transform Docker  Position. 

Although we activated the Transform Docker using Position, once it is open we can also access all Transform commands. 
3. Deselect Relative Position if necessary. 

Relative position settings allow you to move an object in relation to its current position; as in, two inches to the right or down two 
inches. 

4. In the Horizontal box, type: 5.5. 
5. In the Vertical box, type: 7. 
6. Click Apply. 

The center of the rectangle moves to the specified positions. This can be verified by looking at the Status Bar at the bottom of the 
window. The rectangle should move down from the top edge of the page. The position of the center point of the object is also shown 
on the Property Bar. You can also move objects by changing the parameters on the Property Bar but you cannot apply to Duplicate 
as in the next exercise. 

 Placing duplicates 

1. Be sure the rectangle is selected. 
2. Go to the Transform/Position Docker  and use the parameters below.  
3. Click Apply to Duplicate. 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                                   - 61 -                                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

A duplicate is now placed down and to the left of the original. 
4. Using the values below, create two more duplicates. 

When finished, your drawing should look similar to the one below. 

 H (4.0) and V (5.0) Apply to Duplicate 
 H (4.0) and V (4.0) Apply to Duplicate. 

Moving relative to position 

1. Select the three lower boxes. 
The values change in the Transform/Position dialog box to reflect the selected objects. 

2. Select Relative Position. 
3. Select the bottom middle position box in the grid. 
4. Type in settings V=0, H=3.0 

This will move the duplicates to the right 3 inches. 
5. Click Apply to Duplicate  

Your graphics should look something like the one below. 
 

6. Save your file. If you want to preserve the original file, do a Save As and rename the file.  
You will return to this page later to make other changes to the organizational chart. 

  

Mirror 

In an earlier chapter, you mirrored objects by dragging a 
middle selection handle from one side to the other while 
holding down the Control key. Now you will flip an object using 
the Transform Docker. 

1. Return to page 1. 
2. Go to the Toolbox and select the Freehand Tool. 

Remember to use the Control key to draw straight lines. 
3. Draw lines to connect the boxes as in the example below. 
4. Select only the line. 
5. Go to the Transform Docker    Scale and Mirror. 
6. Select the left/right mirror button. 
7. Click the middle right relative position box. 

This will flip the object back to the right along the right 
selection handle. 

 

Rotation 

Remember the exercise in the first session where you created a clock? 
Here we will use a different approach to do the same thing. 

1. Go to page 2. 
2. Go to the Transform Docker   Rotation.  

The second button. 
3. Select the flower petal and move it until the pointed end touches the 

edge of the flower center. 
4. Change the point of rotation to the following settings: 

 H = 5.5 
 V = 4.25 

5. Change the rotation angle to 15 degrees. 
6. Click the Apply to Duplicate button. Continue clicking until you have 

completed the wild flower, a Texas Indian Blanket.  
Another way to complete the flower is to use Ctrl+R, the repeat last 
function short-cut, after you have moved the petal once. 

7. Save the file. 

Scale 

1. Go to page 3. 
2. Select the first tree and place it at the edge of widest part of the road. 
3. Go to the Transform Docker  Scale and Mirror. 
4. Be sure the Proportional setting is selected and the grid selection is 

the middle both directions. 
5. Change the H setting to 125%. 
6. Click on the Apply button.  

Notice that the V setting changed to 125% 
7. Place another tree at the top or end of the road. Change its size to 

25% of the original. 
8. Move the trees to the side of the road and scale them to give the 

illusion of a line of trees along a road. 
9. Save the file. 
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8. Click Apply to duplicate.  
Your drawing should look similar to the one below. 

9. Select the lines and send them to the back with the button on the Property Bar.  
Because the rectangles have a white fill, you will not see the lines behind them. 

10. Save the file. 
You will use this 
page again later. 

Skew 

1. Go to page 5. 
2. Select the box. 
3. Go to the Transform Docker   Skew. 
4. Check the box by Anchor Point.  

This functions like the grid point setting in the Size 
function. The anchor point will remain stationary and the 
object will distort from that point. 

5. Choose the upper right corner on the grid as the anchor 
point. 

6. Change the H skew angle to 15%. 
7. Click Apply to Duplicate. 
8. Repeat the process on each of the four boxes. Change 

the anchor point on each and see what results. 
The resulting objects look like a stack of paper.   

9. Save the file. 

FREEHAND TRANSFORM TOOL  

When you are manipulating objects, you often want to see the effect  quickly and apply your ideas before they slip away. 

1. Open a new drawing. 
You can have more than one file open at a time in DRAW. In fact, the number of files you can have open at any one time is limited 
only by the resources of your machine 

2. Go to the shape tools and draw a few shapes on the page. 
3. Go to the Shape Edit Tool Flyout and select the Freehand Transform Tool.  
4. Click on one of the objects you have created.  

A dotted blue line appears from that point on the object. The default mode for the Free Transform Tool is 
rotate. 

5. Move the object around.  
The point where you first selected the object is the center of the rotation. 

6. Notice the Property Bar has changed to reflect the tool and the direction of rotation. At the left side 
of the Property Bar are the icons for the other Freehand Tools, Skew, Angle Reflection, and Size. 
 

7. Experiment with each tool on the objects you have created.  
These could become very useful for you. Remember, the point of action is the point where you 
click on the object. 

8. You will not use these images again in this class, but you may want to save them. If not, just close the document without saving. 

MANIPULATING OBJECTS 

The basic element of a CorelDRAW illustration is the vector object. Objects can be manipulated in a number of ways to create different 
elements in your drawing. The lines that form an object are called vectors and those vectors are connected with nodes. Vector drawing 
applications create objects mathematically. Predefined objects include rectangles, ellipses, polygons, and curves. Each vector of the image is 
defined by the nodes. These react in set ways to changes. Some manipulations cannot be applied to defined shapes. To change predefined 
objects, the objects must be changed to a series of lines or curves. You will cover this under the command Convert to Curves. 

CorelDRAW creates two basic types of objects – open and closed. Open objects include straight lines and curved lines. Closed objects 
include circles, rectangles, squares, polygons, and freehand drawings. All objects can be 'filled' with an interior fill style, however, unless the 
object is closed, the fill will not appear. 

Transform Docker and Property Bar 

Size 

1. Go to page 4. 
2.  Select the upper right hand box. 
3. Go to the Transform Docker  Size. 
4. Clear the box by Non-proportional. 
5. Move the grid indicator to the upper right position. 
6. Change the H setting to 3.5. 

The Proportional function changes the V setting 
automatically for you. 

7. Click the Apply button. 
The box resizes from the grid point toward the center. 

8. Select each box and resize it, changing the grid point 
setting so the boxes resize to the center of the page.  
The grid sets the direction of the increase or decrease in 
size. Selecting the center of the grid and proportional 
causes the object to increase equally on all sides. 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                                   - 63 -                                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

Two of the main tools for manipulation of objects are the Transform Docker that you covered in Chapter 5 and the Shape Tool. Many of the 
elements of these functions are also found on the Property Bar. As with all CorelDRAW operations, functions are accessed many different 
ways. 

Proportional vs. non-proportional buttons 

One of the more confusing elements of CorelDRAW are the locks for proportional and non-proportional changes. These button are found on 
the Property Bar. Proportional changes keep the width and height of an object in direct relation to each other as they were in the original 
object. In other words, if you make a square an inch larger, it will remain a square, not become a rectangle. Non-proportional allows you to 
change one direction's dimension without affecting the other dimension. 

Button Definition 

 

When the lock is closed (default, button raised), all changes will 
be proportional. A change to the width (H) will always change the 
height (V). 

 

When the lock is open (button depressed), all changes will be 
non-proportional. A change to the width (H) will NOT change the 
height (V). 

Note: Size changes made with the selection boxes is not affected by the proportional button on the Property Bar. Only the size indicator boxes 
on the Property Bar are effected. 

Reshaping objects using Nodes 

The most basic editing of objects is moving and changing the nodes. This is done with the Shape Tool.  The various elements of the 
shape tool are shown in the table below. 

Button Name and Icon Function 

Add 

 

Adds nodes where you clicked on the line. When you select a node and click this button, it adds a 
node half way between the selected node and the nodes to either side. 

Delete 

 

Deletes selected node. Double clicking on a node will also delete the node. 

Join 

 

Connects two selected end nodes on two connected lines. Moves each node an equal distance to 
meet in the middle. 

Break apart 

 

Breaks a line at the selected node and adds an additional node. The nodes will be on top of each 
other. 

To Line 

 

Changes a curved line into a straight line segment. 
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To Curve 

 

Changes a straight line segment into a curved line and adds control handles. 

Cusp 

 

Changes the node property so the curve control handles can be moved independent of each other. 

Smooth 

 

Changes the node property so the curve control handles stay in a straight line. The curves form 
compliments to each other. 

Symmetrical 

 

Each side of the curve mimics the other as in you move one control handle and the other moves in 
the opposite direction. 

Reverse ends 

 

Reverses the end nodes on a line or curve. This is useful when you are putting arrowheads or other 
special endings on lines. 

Extend 

 

Creates a new line segment between two unconnected nodes of an object. 

Extract Subpath 

 

Removes nodes and line segments from within an object. 

Auto Close  

 

Draws a line from the first to the last node of a line segment. 

Stretch and Scale 

 

Allows you to make an object larger or smaller by dragging the nodes. 

Rotate 

 

Allows you to rotate or skew selected parts of an object using the nodes. 

Align 

 

Places the nodes in line with each other either horizontally or vertically. 

Select All 

 

Selects all the nodes in the active object. 
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Elastic Mode  

 

Alters the way nodes are moved by proportionally maintaining the distance between nodes as they 
are moved. 

Auto Reduce 

 

A slider that alloys you to simplify an object by having DRAW remove nodes that are unnecessary to 
maintain the shape.  Can be used for the entire object or selected nodes. 

In certain situations, when you select a line or an object, the program will change from the Pick tool to the Shape tool. When this happens, you 
will be manipulating nodes rather than just moving the object. The shift will be indicated by the cursor icon and the appearance of nodes on 
the lines in your drawing. 

This is the Pick tool cursor next to a node in a selected object.  

This is the Shape tool cursor next to the same node.  

You will find your work moves faster and you will be less frustrated if you learn to recognize the cursor icons of the various tools. 

Working with Nodes on lines 

1. Reopen Open 4th.cdr 
2. Go to page 7. 
3. Select the blue line. 
4. Go to the Toolbox and select the Shape Tool.  

When you select an object with the Shape Tool, the nodes display. 
5. Select the starting node (first on the left).  

The first node will always be larger than the others. It will be at one end of a line but can be at any point on a closed object. 
6. Click and drag to move it around. 

This will change the length and position of the line segment. 
7. Hold down the Shift key. 
8. Select the second node point. 
9. Place the cursor on either node. 
10. Move the nodes. 

Just as objects work together when selected, so do nodes. 
11. Group-select two other nodes. 

The same techniques used for selecting multiple objects are also used for selecting multiple nodes. Drag the Shape Tool to 
surround the nodes. You can also use the Shift+Click to select multiple node points. 

12. Place the cursor on one of the selected nodes. 
13. Move them. 

The line segment in-between the selected nodes remains the same, while adjacent line segments are reshaped. 

Adding nodes 

1. Click on a portion of the blue line that has no node. 
A small black circle appears on the line. 

2. Go to the Property Bar and select the Add node button.  
A new node appears on the line . 

3. Select another node. 

4. Delete it with the delete node button.  
Double clicking on a node will also delete the node. Deleting nodes can be a fast way to straighten out lines. 
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Tip:  If you need a new node precisely in the middle of two other nodes, select an existing node, then click the Add node button. A new node 
will appear centered between it and the next node on the line towards the beginning of the line. The largest node is the first node of a line. 

Aligning nodes on straight lines 

1. Select the red line. 
You are automatically in reshape mode when you select objects with the Shape Tool. 

2. Select the bottom middle node. 
3. Hold down the Shift key. 
4. Select one of the top nodes. 

5. Go to the Property Bar and select the Align button.  
This activates the Node Align dialog box. 

6. Select Horizontal to deactivate that option. 
This will align the nodes vertically. Aligning the Control Points aligns the control handles of the nodes on curves. The option is 
grayed out when aligning nodes on lines. You saw the control handles when you drew with the Beziér Tool. 

7. Click OK. 
The nodes align and by doing so, reshape the object. 

Moving nodes on curved lines 

1. Select the curved line at the bottom of the page. 
2. Select a node. 

The Status bar will display the characteristics of the node. If necessary, right click on the Status Bar and choose Refresh. 
3. Select one of the control points and move it.  

The control points are the blue dotted lines that extend from the node. You used them when you created an object with the Beziér 
Tool. 

4. Move other control points and notice what happens. 
5. Place the cursor over the line and move it. 

Note: Working with curved lines takes a bit more care than working with line segments. Not only can you reshape them with the nodes, you 
can move the lines as well. The Control handles will move to match your changes to the line segments. 

Converting line segments 

Objects created with straight lines do not have control points. To change a line to a curve, you will use the node at the end of the line. This will 
add control points along the lines. Once they are activated you can create a curve by moving them. 

1. Select the red line.  
Be sure you still have the Shape Tool selected. 

2. Select all the nodes with the Select all button.  

3. Go to the Property Bar and select the To Curve button.  
This converts all selected lines to curves. 

4. Press the Escape key to deselect the nodes. 
5. Select only one node. 

The control points follow the lines because this object was created with straight lines 
6. Move a control point. 

Notice that you may also grab the line when the control points are close to the line. 
7. Group-select all the nodes. 

8. Go to the Property Bar and select the Smooth button.   
Smoothing bends straight lines by averaging out the distance between node points. This is a great technique to create curved 
polylines. 
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Connecting and disconnecting nodes 

1. Select the blue line. 
2. Select the two end nodes. 

Each segment has two nodes. 
3. Go to the Property Bar and select the Extend button. 

A line is drawn to connect the selected points together.  
4. Go to the Standard Toolbar and select the Undo button.  

Or use Ctrl+Z. 
5. Select one of the other node points. 

6. Go to the Property Bar and select Break Path button.  
This command is used to split the line at the selected node. 

7. Move one of the disconnected nodes. 
The nodes are on top of each other. Zooming in helps to move one or the other. 

8. With both nodes selected, click on the Join node button.   
The nodes move and are joined in the middle of the space between them. If you want the nodes to combine at a particular place, 
drag both nodes to that point and have them touching. The Join function will combine the two nodes into one. 

9. Select the curved line at the bottom of the page. 

10. Click on the AutoClose button on the Property Bar.  
As you can see, this can create some very unusual results. Use the same command on the other lines to see how the results vary. 

11. Go to page 8. 

Cusping node points 

1. Zoom in close to the lower fish.  
Make him look like the top shark. Use the Zoom level list on the Property Bar, the Zoom Tool from the F2 button, or the Zoom Tool 
from the Toolbar. 

2. Select the top fin of the fish with the Shape Tool.  
Use the Ungroup All button if necessary. You cannot use the Shape Tool on a grouped object. Notice the   control points are 
already there. That is because this line was created using curved line segments. 

3. Select the top node point. 
4. Move one of the control points. 

Notice how difficult it is to get the proper shape. 
5. Go to the Standard Toolbar and select the Undo button. 
6. Be sure the top node point is still selected. 

7. Go to the Property Bar and select the Cusp button.  
Be sure the node is still selected since changes will only apply to selected nodes. 

8. Move the lower (right) control point to edit the curve of the fin. 
9. Reshape the fish to match the shark.  

Remember to Cusp the points if necessary. 

Reshaping Closed Objects 

Reshaping rectangular objects 

1. Go to page 9. 
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2. Select the blue rectangle. 
Notice the nodes in each corner. This is a defined, closed object. 

3. Go to the Property Bar and click the Round Corners Together lock.    
With the lock open, the corners can be rounded one at a time. With the lock closed, the corners will round together. 

4. Click on one corner node.  
Be sure only one node is selected. Notice the mouse cursor icon changes to the Shape Edit Tool cursor. 

5. Round the corner by pulling the node along the line that makes up the side of the rectangle. 
Notice that the number of degrees in the arc is shown on the Property Bar. You can also enter the number in and change the 
corners so several rectangles match. Press the Enter key to apply the changes. 

6. Select the red rectangle. 
7. Go to the Property Bar and depress the Round Corners Together lock. 
8. Click on one corner node. 
9. Round the corners by pulling the node along the line that makes up the side of the rectangle.  

All four corners round together in the same amount. As with the individual corner rounding, you can enter the arc measurement and 
press the Enter key to apply these change.   

RESHAPING ELLIPTICAL OBJECTS 

Elliptical objects can be used to create arcs, pie shapes for graphs, and pie wedges. 

1. Select the blue circle. 
Notice an elliptical shape contains only one node point. 

2. Keeping the cursor outside of the circle, click and drag the node point. 
This produces arcs. Once the object is reshaped a second node appears. 

3. Return the node to the original position. 
4. Repeat step 2, keeping the cursor inside the circle. 

This will produce a pie-shaped object that shows the fill. Moving the pointer outside the circle creates an arc that does not show the 
fill. The fill is defined for the circle. 

5. Select the red circle. 
6. Go to the Property Bar and click the middle button of the three shown here. 

 
7. The circle becomes a three-quarter pie shape.  

A 270 degree arc is the default. 
8. Click on the third arc icon.  

The object becomes a 270 degree arc. 
9.  Click the Reverse button. 

The arc reverses to the smaller portion of the circle. This works on the pie shape also. 

 
10. Arc and pie shapes can be set using the Property Bar parameters. 

This allows you to create duplicate arcs and pies for charts and technical drawings. 

Virtual Segment Delete Tool 

1. Go to page 9. 
2. Select the clip art image.  

Remember to use the Pick tool to select. 
3. Check the information on the status bar. 
4. Ungroup the image and notice the number of objects that make up the picture. 
5. Press the Esc key to de-select all the objects. 
6. Select the words For Sale.  

Notice the selection indicator boxes and nodes. 
7. Press the delete key.  

Notice that much more than the words For Sale are removed! 
8. Undo your last action. 
9. Go to the Shape Edit Flyout and choose the last tool.  

This is the Virtual Segment Delete tool. 
10. Go to the View menu and choose Wire Frame.  

This allows you to look at the basic structure of the clip art. 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                                   - 69 -                                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

11. Zoom in and click on the letter S. 
12. Continue removing the letters and shading in the box. 
13. Go to the View Menu and choose Normal .  

Notice that the yellow color is not displaying. 
14. Go back to Wire Frame. 
15. Choose the Shape edit tool. 
16. Select the edge of the yellow area.  

Remember it is the front of the house. 
17. Choose the Auto-Close button.   
18. Check the drawing in Normal view. 

COMBINING AND SHAPING 

Problem: Applying the Break Apart command to merged objects may not return them to their original condition. Some alterations cannot be 
reversed. This is not predictable. Plan before you combine. 

Combining closed objects 

1. Go to page 10. 
2. Group-select all the red circles. 

Probably the best way is to marquee select. The text is on another layer. You cannot select it from the current layer. 
3. Go to the Arrange menu and select Combine (Ctrl+L) 

Every other circle is knocked out. A new object is now formed. The fill for the new object is determined by the fill of the first object 
chosen. Because all of our objects were filled with red, the final object has a red fill. If the resulting object does not have the fill you 
anticipated, select the objects in the reverse order. 

Combining open objects 

1. Go to page 11. 
2. Group-select the two blue line objects. 
3. Go to the Arrange menu and select Combine (Ctrl+L). 

Open objects will react differently than closed objects when combined. When they are combined, they create one object giving you 
reshaping control over both simultaneously. 

4. Go to the Toolbox and select the Shape Tool. 
Notice there are node points on both lines. The Shape Tool is not available for Grouped objects. 

5. Select the leftmost end nodes on both blue lines. 
6. Go to the Property Bar and select the Extend button.  

Remember that the extend button joins nodes by adding a line that connects them together.  
7. Repeat to connect the right end nodes. 

With both sides connected, you now have a closed object. 
8. Give the new object yellow colors fill. 

Because it is now closed, the fill will display. 
9. Go to page 12. 

Note: You will see buttons on the Property Bar to apply all three of the following functions. While these button apply the effect, they do not 
allow for the options seen in the Docker. Once you have become familiar with the functions, you may find it easier to use the buttons. 

Welding objects 

1. Select the blue diagonal line.  
Notice it overlaps the circle. You can see the outlines of both shapes. 

2. Go to the Window Dockers Shaping.  
This will activate the Shaping Docker. 

3. Click the Weld To button. 
4. Select the red circle (this is the target object). 

The two are welded together and form a new object. 
5. Go to the Standard Toolbar - Undo Button. 
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6. Go to the Weld Docker - Leave Original Target Object. 
This is the object you weld to. It is the one you select when you weld. Notice the window in  the Docker . This is a visual cue. 

7. Select Other Object(s). 
8. Click the Weld To button. 
9. Select the circle. 

When you leave the original objects they remain along with the welded object, which is below the originals. 
10. Drag the weld off the page. 

The originals may be on top. The blue rectangle turns red because it is welded to the red circle.The target object determines the fill 
and outline of the final object. 

Intersecting objects 

1. Go to page 14. 
2. Select the yellow rectangle. 
3. Go to the Shaping Docker - Intersect. 

Once you activate the Docker you can select the 
Intersect command because these are all part of a Docker 
group. 

4. Turn off Leave Original Target and Source Objects. 
5. Click the Intersection With button. 
6. Select the red circle. 

The remaining object looks like a red pie slice. 
7. Place the red object on the gauge. 
8. Move the arrow on top. 
9. Rearrange the Order (from the Arrange menu) if needed. 

Three other options are available on the drop down menu of the 
Shaping Docker. These are versions of the first three tools that 
provide shortcuts. As you become more familiar with the program, 
you may find them very helpful. 

Simplify 

This tool allows you to remove parts of an image that are not visible. It 
will cause the file to print faster since the printer driver will have to parse 
less code. All code in a file must be parsed even if the object will not 
show. 

1. Go to page 15. 
2. Select the graphic. 
3. Ungroup it.  

Always use the Ungroup All function before you Simplify. 
4. Select the black out line and move it off to one side.  

Notice it is a solid black box. 
5. Undo the move. 
6. Select all the objects again. 
7. Go to the Shaping Docker and select Simplify. 
8. Click the Apply button.  

Because this image only has 20 objects in it, it will simplify 
quickly. If you have an image with hundreds of parts, do it 
incrementally. This is a very complex process and takes lots of 
resources to accomplish. You can crash the program! 

9. Select the black outline and move it off to the side.  
Notice how the other objects have now been used as 
templates to put holes in the black background. 

10. Undo the move. 

Back Minus Front — Front Minus Back 

These two functions expand the trim function to several objects at one time. They are faster than the trim but do not have the same controls or 
parameters as the Trim tool. You cannot save the object you cut. 

TRIMMING OBJECTS 

1. Go to page 13. 
2. Select the large black arrow.  

The selection order is important. The last selected will 
be the object trimmed. 

3. Go to the Shaping Docker - Trim. 
4. Deselect Source Objects and Target Objects. 
5. Click on the Trim button. 
6. Click on the red rectangle with the special cursor. 

A notch is created using the overlapping areas of the 
objects and the arrow is discarded. 

7. Go to the Arrange menu  Order  To the Back.  
This moves the red object back behind the text. Objects 
that are being affected will be moved to the front layer 
by the program so you must change the stacking order. 

8. Save the file. 

Tool Characteristics 

Weld 

Creates one object from two or 
more. Target object, last object 
chosen, determines the fill and 
outline of the final object. 

Trim 

Uses one object to alter the 
outline of a second object. Acts 
like a die cut or a cookie cutter. 
First object chosen alters the 
target object. 

Intersect 
Creates a new object from the 
area of where two objects 
overlap. 

Simplify 

Trims overlapping areas of 
objects. This tool will work on 
several objects. The 
overlapping areas are 
discarded. 

Back minus front Removes overlap by discarding 
the front object. 

Front minus back Removes the overlap by 
discarding the back object. 
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1. Go to page 16. 
2. Select the green circle and the blue polygon. 
3. Go to the Shaping Docker and select Back minus Front. 
4. Click Apply. 
5. Undo the effect. 
6. Select the triangle and the red square. 
7. Go to the Shaping Docker and select Front minus Back. 
8. Click Apply. 

Experiment with the four shapes and the two functions. 

The Eraser and Knife Tool 

The Eraser Tool disconnects line segments or parts of an object by removing them. The Knife Tool slices a line between two points across a 
line or a closed object. Each tool creates two sections, but handles them differently. 

1. Go to page 17. 
2. Select the yellow box.  

An object must be selected first. 
3. Hold down the Shape Tool button to produce the Flyout. 
4. Select the Eraser Tool.  

Notice the cursor looks like a pencil eraser. In the Tool properties dialog you can set the width of the eraser. When used on a closed 
object, the sections remain connected as two new closed sections. The option to reduce the number of nodes on the object selected 
is very helpful and should not be turned off. 

5. Click and Drag across the box.  
The tool functions just like an eraser. Notice the line color on the sections created by the Eraser Tool. This indicates you have 
created two objects with the same properties as the original. These shapes are still combined into one object. 

6. Experiment with each shape but use the Undo button or Ctrl+Z to return each to their original look. 
7. Hold down the Eraser Tool to produce the Flyout. 
8. Select the Knife Tool.  

Notice the cursor looks like an graphic artist's knife. In the Tool properties dialog, you can choose to leave the cut object as one or 
have it create two separate, disconnected objects. 

9. Select the polyline. 
10. Place the knife on a line segment and click.  

The icon changes to an upright position indicating you can now cut the object. 
11. Click on another segment. 

A new line segment is drawn from the first point to the second and the other lines erased. 
12. Experiment by cutting the other shapes. Notice the unusual effect on the polygon. 
13. Save the file. 

The Smudge and Roughen tools are also found on the Shape Edit flyout. These two tools allow you to change the textures and appearance of 
curved lines. They are not covered in this class. 

INTERACTIVE TOOLS FOR FAST CHANGES 
 
The Interactive Tools Flyout contains five tools. You will work with two of them in this class. Each applies an effect or modifies the object as 
you manipulate it. You can watch the effect as you do it which give you more control over the manipulation. 
 

Tool Description 
Interactive Bend 

 

Creates a series of shapes that gradually change from the beginning shape to the ending shape. 
Can be adjusted for speed of change, direction of change, color, and path of change. 

Interactive Contour 

 

Creates a blend using the outline of the selected object. Much improved over previous versions of 
the effect. 

Interactive Distort  

 

Changes an object based on the nodes that created the object. Default mode is called Push-Pull, 
others are zipper and twister. The pattern and amount of distortion is determined by the direction of 
drag, distance of drag and original location of the nodes. 
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Interactive Envelope 

 

Allows you to distort an object by placing a container or envelope around the object to constrain the 
distortion. Distortions can be mirrored on the object and the direction of distortion is controlled. 

Interactive Extrude 

 

Allow you to extend an object as if it were three dimensional. You can control the fills, light source, 
and beveling of the surfaces. 

Interactive Drop Shadow 

 

Allows you to create the illusion of a shadow for an object. Text will remain editable and the shadow 
will reform as the text is edited. You can change the color, edge feathering, and opacity of the 
shadow. 

Interactive Tranparancy 

 
Allows you to create a screening effect over an image. You can cange the color, percent of cover, 
direction of the gradient, and type of gradient. 

 Using the Interactive tools 

1. Go to page 18. 
2. Select the green pentagon.  

An object must be selected first. 
3. Hold down the Interactive Blend button to produce the Flyout. 

4. Select the Interactive Distortion Tool.   
5. Click in the middle of the pentagon and drag to the right.  

The pentagon is distorted with spikes from each node. Dragging to the left produces rounded spikes. 
6. Experiment with each option and shape but use the Undo button or Ctrl+Z to return each to their original look. 

Change the type of distortion with the buttons on the Property Bar. 
7. Hold down the Interactive Distortion Tool to produce the Flyout. 

8. Select the Interactive Envelope Tool.  
9. Select the phrase “The Hump”. 

A red-dotted line with nodes appears around the word. This is the envelope.   

10. Go to the Property Bar and choose the Double Arc mode.  
11. Click on the top center node and drag it up. 

The words are distorted into a humped sign. The other modes change the direction of the distortion.   
12. Save the file and close it. 

SETTING UP A PAGE 

Pages in a CorelDRAW document can have mixed orientation. Some can be portrait and some can be landscape. In these exercises, you will 
explore the various options on the Page setup up dialog. When you print the document, DRAW will adjust the orientation so the page prints 
properly, in other words, you will see the pages as mixed orientation but they will print with the all pages rotated to either landscape or portrait. 

1. Go to the Standard Toolbar and select the New button.  
Or use (Crtl+N) or the button on the Standard toolbar. 

2. Go to the Property Bar and choose the Landscape button.   
Notice the two button to the right of the Landscape button. When the icon at the top is pressed, the page orientation change applies 
to all pages of the document. When the lower icon is depressed, the change applied only to the active page. In other words, if you 
add a page when the bottom icon is depressed, that page will be portrait, not landscape. 
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3. Go to the Layout menu and select Page Setup. 
This activates the Page Size dialog box within the Options dialog. You can also double-click on the page border in the drawing area 
to activate the Page Size dialog box. 

4. Change the orientation to Portrait. 
Notice the preview window that shows your changes. 

5. Drop down the Paper menu and explore the various sizes of paper available. If you choose the Custom size, you can set a specific 
page size then save that size for future projects. Notice the option to apply the change only to the current page of the document. 

6. Go to the dialog window on the left and change to the Page option. 
7. Clear the box in front of Show page border.  

This is the default parameter. Show printable area puts a dotted line on your page based on the currently selected default printer. 
8. Click OK.  

Notice the page is no longer visible. The Show page border gives the illusion that the page is floating above the Desktop. 
9. Go to the Tools  Options  Page and turn the Show page border back on.  

This is a third way of accessing the Page Setup dialog. 
10. Change to the Layout dialog window under Page.  

This allows you to set up publications such as newsletters, two sided documents or other page arrangements. Leave the parameters 
at default. 

11. Change to the Label dialog.  
Templates for almost every type of label stock available world wide are accessible on this dialog. CorelDRAW opens the page with 
only one label showing, then prints as the labels are located on the page. It also has templates for such things as perforated 
business cards and CD labels. 

12. Change to the Background dialog window. 
Leave the parameters at default but look at the possibilities, not only can you change the color of the page, you can assign a bitmap 
as a background. This is a Web friendly feature to assist you in designing graphics that are compatible with your background on a 
Web site. 

13. Click OK to return to the page. 

USING GUIDELINES 

Guidelines provide assistance for placing and aligning objects or dividing pages into columns. For example, they can be used to create 
columns for text layouts, baselines for newsletter headers and footers, or just align objects as you draw. There are three types of guidelines; 
vertical, horizontal and slanted guidelines. 

Placing guidelines 

1. Go to the View menu and select Guidelines Setup. 
This will activate the Guidelines Setup dialog box. 

2. Type: 0.5 (½ inch) in the Horizontal parameters box. 
3. Click the Add button. 

A dotted guideline is placed at the bottom of the page. Remember that the ruler origins start at the bottom left corner of the page, so 
0.50 is ½ inch from the bottom edge. 

4. Type: 10.5 (10 ½ inches) in the Horizontal position text box.  
Notice that the position of the guidelines displays as you place them. If you want to change the position of a guideline, highlight it, 
change the measurement, then click Move. 

5. Click Add. 
Do not use the Return (Enter) key. This will close the box without adding the guideline. 

6. Click on the Vertical tab and set two guidelines at one half inch from the sides of the page.  
Hint: 0.5 and 8.0. 

7. Activate the Snap to Guidelines.  
If you click on a guideline then when in the Pick tool'  

you can turn the snap to off with a button on the Property Bar.  
8. Click OK. 
9. After you have added the guidelines click OK. 

Tip: You can also place guidelines into a drawing by dragging them from either ruler. Place the cursor on top of the ruler, hold down the left 
mouse button, and drag into the drawing. When you release the mouse, a double-headed arrow will appear indicating which direction you can 
adjust the guideline. Double clicking on the guideline brings up the Guideline properties dialog or you can use the parameter settings on the 

Property Bar.  
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Drawing objects using guidelines 

Guidelines are very useful in dividing a page into smaller sections. They provide good visual clues when designing layouts. 

1. Go to the Toolbox and select the Rectangle Tool. 
2. Place the mouse cursor close to top left corner where the guidelines meet. 
3. Click and drag to the lower right corner. 

Notice how the rectangle snaps to the guides. 
4. Press the Spacebar. 
5. Go to the View menu and select Guidelines Setup. 

Or double click on the guideline. 
6. Deselect Show guidelines located in the lower left corner. 
7. Click OK.  

Tip: Although the guidelines are off, they remain in position and active. If you need them again simply turn them on. They remain set 
within the file. Snap to Guidelines is not the default setting however, and will need to be turned back on each time you open a new 
file. 

8. Close the file without saving. 

  

Adding artistic text 

1. Go to the File menu and choose Open 4th at the bottom 
of the menu.  
The most recent files you have worked on will be listed at 
the end of this menu. You can change the number of files 
listed in the Options dialog. 

2. Select all the boxes. 
3. Go to the Property Bar - Ungroup All. 

4. Go to the Toolbox -Text Tool.  
5. Click in the blank area to the left of the page. 

This places an insertion point where the text will be 
placed. 

6. Go to the Text menu - Format Text. 
Or the F on the Property Bar or (Ctrl+T). This activates 
the Format Text dialog box used for setting text options. 

7. Scroll down in the Font list - Times New Roman. 
If you know the name of the font you are looking for, 
highlight the first font name, then type the first letter of the 
font you want. The list will automatically scroll to the fonts 
that begin with that letter. 

8. Replace the current font size value with 14. 
9. Go to the Weight drop-down list and select Bold. 

As you make changes they appear in the sample window 
at the bottom of the dialog box It will display the first few 
word of anything you have typed or the first few letters of 
the alphabet. 

10. Click OK.  
If you have not set an insertion point, the change default 
dialog box will appear. If you click OK at this point, the 
next time you access the Text tool, it will have these 
settings. 

Creating labels 

1. Type: Organization Chart for LaSalle Produce Company. 
2. Right click on the word LaSalle and choose Ignore 

All.  
The red underline turns to blue. You can add to your 
dictionary any words you know you will be using often. 

3. Press Enter. 
4. Use the following list to complete the titles for the left 

INTRODUCING THE TEXT TOOLS 

One of the strongest features of CorelDRAW is its text capabilities. 
There are two types of text in CorelDRAW: Artistic Text and 
Paragraph Text. Artistic Text allows you to enter single lines of 
text—for example, callouts, titles, or labels in a drawing. To create 
a second line, you will have to manually end the line by using the 
Enter key.  

CorelDRAW treats Artistic Text as an object and allows you to 
apply many of the graphic effects to that text while it retains it 
ability to be edited as text. 

Paragraph Text is used for larger portions of text requiring word 
processing-type capabilities, such as indents and tabbing. 
Paragraph Text works within a user-defined area.  

For example, if you were creating a brochure and you needed a 
text area of about 3 inches by 5 inches you would create a Text 
Frame. The Paragraph Text would then wrap within the frame. 

Both types of text can be formatted to include bold, underline, and 
other text styles normally associated with typesetting. In addition, 
the Paragraph Text can be further enhanced by using various 
paragraph formatting such as indentation, tabs, and line spacing. 
While you can assign basic changes from the Property Bar, you 
will have to go to the Format Text dialog box for extensive text 
editing. 

Another feature of the Text Tool is the real-time spell checking 
utility. It functions very similarly to that in most word processors. 
There is also a Grammar checker available but it is not turned on 
as a default. If there is a spelling error you will see a red line 
appear under the text as you type.  

This means that the word is misspelled according to the default 
dictionary. A blue line indicates a word not in the dictionary but you 
have told the program to ignore.You can add technical words to 
the dictionary using the Spell Check dialog box. 
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group.  
Press the Enter key after each to place each title on a new line. 
Corporate  
Sales  
Marketing  
Advertising. 

5. Go to the Toolbox and select the Pick Tool. 
This will end the typing mode. The text will become selected. To toggle to the Pick Tool, use Ctrl+Space bar. 

6. Go to the Arrange menu and select Break Apart. 
This will split the text into individual text lines. They can now be moved into position. 

  

Aligning text within an object 

The most important thing to remember when aligning objects is the 
selection order. Remember that alignment is based on the last 
object selected. 

1. Select the text in the top box (Corporate). 
Check the Status Bar to ensure that you have the text. 

2. Hold down the Shift key. 
3. Select the white box below the text. 

The Status Bar should read that you have two objects. 
4. Release the Shift key. 
5. Press the e key and then the c key.  

The short cut will center the two objects vertically and 
horizontally with each other. Two or more objects must be 
selected. 
Or, Go to the Arrange menu and select Align and 
distribute . Select both the Center options. Selecting the 
Center of the Page option, then deselecting it 
accomplishes the same thing. Click OK. 
This will place the text in the center of the boxes. 

6. Repeat these steps to align the rest of the text with the 
boxes as needed. 
Remember to select the text first. 

7. Save your work (Ctrl+S). 

Adding paragraph text 

Paragraph Text is created by drawing an area for the text. The 
technique is similar to drawing a rectangle. The area used by 
Paragraph Text is referred to as a Text Frame. It acts like a small 
page. 

1. Go to the Toolbox and select the Text Tool. 
2. Click and drag in a blank area of the page to create a Text 

Frame approximately 3 inches wide and 3.5 inches tall. 
As you drag, watch the Status Bar for dimensions. Text 
Frames can be resized after they are created so you don't 
have to be exact. 

3. Release the mouse button. 
4. Go to the Text menu and select Format Text. 

Or use the Property Bar. 
5. Set the Font to Arial and the Size to 14 points. 

One point is equal to 1/72 inch. 
6. Click OK. 
7. Type: 

The LaSalle Citrus organization was established in 1915 
by its owner, Lee Mone Peel. A French immigrant, Mr. 
Peel purchased a tract of land in south Texas and began 
growing citrus produce. It has since grown to be the 

Copying text properties 

1. Go to the Toolbox and select the Text Tool. 
Notice the Property Bar. The text settings reverted back 
to the default parameter. 

2. Click in a blank area below the text you just typed. 
3. Use the following list to complete the titles for the right 

group.  
Press the Enter key after each to place each title on a 
new line. 
Orchard Mgmt. 
Quality Control 
Shipping 

4. Go to the Toolbox and select the Pick Tool. 
Selection handles appear. 

5. Go to the Edit menu and select Copy Properties 
From. 
This activates the Copy Properties dialog box. 

6. Select Text Properties. 
7. Click OK. 
8. Click on any text object from the previous text list with 

the large black arrow. 
The fonts should be updated to match the first list. 

9. Go to the Arrange menu and select Break 
Apart (Ctrl+K). 

10. Place the title of the chart on top and a division title in 
each box. 

11. Drag one of the corner handles to resize the text. 
Artistic Text can be proportionally resized just like other 
objects. While this is quicker, it is not as precise as 
using the Text Format dialog box or the Property Bar. 

12. Reposition the title in the middle over the top of the 
chart.  
Hint: Use the aligning shortcuts, c for vertical center with 
two objects selected. 

13. Save your work (Ctrl+S). 

Tip:  A faster way to copy the properties is the Drag and Copy 
mentioned earlier. Select the object you wish to copy properties 
from.  

With the Right Mouse button, drag the object to the object you 
wish to change.  

A target helps you select the object to be changed. Release the 
Mouse.  

A dialog allows you to choose which properties you want to apply. 
The original object remains in place, unchanged. 
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nation's thirtieth largest grower.  
Click Ignore All for both LaSalle and Mone when the spelling checker underlines them. 

8. Go to the Toolbox and select the Pick Tool. 
Selection handles should appear around the Paragraph Text. If they do not, then select the Text Frame. 

9.  Move the text under the right side column of boxes. 
10. Save the file. 

IMPORTING FILES 

Many file types can be opened within CorelDRAW. When you open the Import 
dialog, the Files of Type drop down list will show you all of the various kinds. 
The filters to import these files are installed with DRAW. If you do not see a file 
type you need, do a custom install from the CD-ROM. Check the list of files to 
see if a filter is available and follow the directions to install it. 

Importing files makes a copy of the file within DRAW. It does not affect the 
original file. 

1. Go to the File menu  Import.  
This activates the Import dialog box. The screen capture below 
shows the dialog with the Options button clicked. You can also use 
the Import button from the Standard Toolbar.  

2. Go to the Files of Type drop-down list, scroll down  CorelDRAW 
(.cdr).  
Only files created in CorelDRAW will be shown in the file list. 

3. Go to the class files folder  CITRUS LOGO. 
4. Click on the Preview checkbox. 

With the Preview active you can view the files before importing 
them. 

5. Click on the Import button.  The name of the file you are importing is displayed 
by the import cursor. This screen capture is 
only an example. 

6. You have two options at this point.  

If you want to import the object at its original size, click at the spot you want the 
graphic. 
If you want to resize the graphic, click and drag to reduce or enlarge the graphic 
to the size of the click and drag area. 

7. You do not know the size of the original but you do know where you want 
to put the logo. Click and drag the cursor using the image below as a 
guide.  
The logo is centered on the chart. 

8. Save your work (Ctrl+S). 
Your work should look similar to the chart below.  
 
  

CLIPART 

Clipart consists of drawings and bitmap images produced by artists for use in desktop publishing and graphic design. Corel Corporation 
provides thousands of clip art images with CorelDRAW 12. You USE the clipart, you do not OWN the clipart. Most suppliers ask that you 
indicate the source especially if you use several images. Each package of clipart comes with an agreement outlining the limitations and 
acceptable usage of the clipart. Always read your clipart package agreement. Copyright infringement fines are very high. Better safe than 
sorry! 

Adding clipart to your drawing 

1. Go to the Standard Tool bar and click on the Import button. 
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2. Go to the class files folder and select the Oranges.cdr file. 
3. Click OK. 
4. Click the cursor once at the lower left corner of the page.  

The clipart oranges are much larger than we need. 
5. Use the selection handles to scale the image down. 
6. Save the file. 

PRINTING YOUR WORK 

CorelDRAW uses the print drivers in Windows. It does not have any print drivers of its own. Each printer will have a different set of standards 
and settings. 

1. Go to the Standard Toolbar and select the Print button. 
(Ctrl+P or File - Print)  
This activates the Print dialog box. There are six tabs where parameters may be set for printing projects. Many of these are highly 
advanced for use in complex projects such as four color process work where very exact negatives must be created. You will cover 
only the options on the General tab in this class. 

Printing Options 

Printer Lets you select from a list of installed print devices. The Properties button activates the Setup dialog box 
for the selected printer. 

Print Range Lets you designate what you want to print. The Selection option is good for proofing parts of a drawing 
without having to print the whole page. 

Copies Sets the number of copies desired. 

Print styles Just as you saved styles for documents, you can save setting for printers. If you make several changes 
for a particular printer or type of print job, save them so you don't have to re-enter all your parameters. 

2. Select Current page in the Print Range section. 
This will print only the currently visible page of a multi-page document. 

3. Go to the Printer section and select the Properties button. 
This activates the Setup dialog box. Each dialog box will be specific to the currently selected printer. 

4. Change the Orientation to Landscape. 
If the orientation of the printer does not match the page, CorelDRAW will prompt you and ask if you want it to automatically change 
the orientation. 

5. Click OK. 
You will return to the Print dialog box. 

6. Click OK again to begin printing. 

EXPORTING YOUR WORK 

Exporting an image or a file insures the code in the file is standard code for that type of file. Using Save As to create files other than cdr files is 
possible but risky. Save As is best used to make copies of a file under another name for example, saving versions of an image. Some types of 
files are more difficult to export. If you plan to import the image into another type of program such as a page layout program or word 
processor, do some samples first to see which type of file imports best. 

1. Go to page 1. 
2. Select the LaSalle Citrus logo. 
3. Go to the File Menu and select Export (Ctrl+H). 

You can also use the Export button from the Standard Toolbar. This will activate the Export dialog box. 
4. Go to the Save in list box and select the class files folder. 
5. Select the Save as type list box.  

Each type of file has different parameters. You will cover only one type here. 
6. Go to the list of file types and select Windows Metafile (WMF). 

This applies the export filter. Filters are used to properly set the information in the exported file for the new file type. Windows 
Metatfiles are useful if you use Microsoft programs. 

7. Click the Selected only check box. 
This option will export selected objects only. If you want to export the entire illustration, leave this blank. 

8. In the File name text box, type: Logo 
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9. Click the Export button. 
This will activate a filter dialog box. Some filters have these to set various options. 

10. Under Export text as, select Curves. 
By exporting as curves, you convert the text into a graphic. This avoids any problems of font availability between computers. 

11. Click OK. 
The logo is now exported. 

Tip: The author has found it takes one-half to one-third the time to export when the elements of a graphic are ungrouped. Use the Ungroup All 
command on the Properties bar. After exporting, you can re-group the elements to keep them from moving. 

SETTING A NEW DEFAULT STYLE 

Creating a style with the Outline and Fill tools 

1. Go to the Toolbox - Pick Tool. 
2. Be sure nothing is selected (press the Escape key). 
3. Go to the Toolbox - Fill Tool. 
4. Activate the Flyout and select the invisible fill option, the large X. 

You will be prompted by the Uniform Fill style dialog box warning you that you are about to change the default style properties for 
this document. 

5. Click OK. 
The new fill style is set to invisible for graphic objects. You can change it to no fill by turning off the 'Treat all objects as filled. 

6. Go to Toolbox - Outline Tool. 
This will produce the Flyout. 

7. Select the 2 Point Outline button (fourth from right). 
8. Click OK. 

Again the dialog box appears and you can assign a line to each type of object as a default for this document. 
9. Draw a rectangle. 

The rectangle will now have a thicker border and no fill. 
10. Delete the rectangle.  

Selected objects can be deleted with the Delete key or on the Edit menu. 

Setting defaults with Options dialog 

1. Go to the Tools menu  Options  Workspace  Toolbox  Rectangle tool. 
2. Reset the Corner roundness to 40. 
3. Click OK. 
4. Select the Rectangle tool and draw a rectangle on the screen.  

The default has been changed to a rounded corner rectangle. The changes are only for the current document. 
5. Go to the Tools menu  Options  Document  Styles. 
6. Go to the right panel and expand the Default Graphic listing. 
7. Drop the fill menu down and choose Uniform Fill  Edit button .  

The Uniform Fill color palette appear. Here you may choose or create a color from the CMYK mixing area. The More button 
accesses an area where you can define the color precisely by the numbers. 

8. Move the small box to the upper right corner to change the fill color. 
9. Click OK. 
10. Repeat these steps with the Outline dialog, choosing a different color for the outline. 
11. Click OK. 

Your changes do not take effect until you select OK. 
12. Draw some rectangles. 

The fill and outline should now be colored with round corners on the rectangles. These attributes will remain for all rectangles in this 
document until you change them. 

13. Return the setting to the default of sharp corners, thinner line and invisible fill. 

The Options dialog allows you to change the defaults for all of the tools including the Text Tool. You will work in customization of your 
Workspace later in this chapter. 

CHANGING THE DEFAULTS FOR ALL DOCUMENTS 
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The default setting for DRAW is to apply the default changes you made in the last exercise only to the active document. If you want to change 
the defaults for all documents, you must change a setting. A note, some users of CorelDRAW 11 have had the setting change back to the 
factory default without warning. It is a sporatic bug and as such very difficult to fix. Corel Corp. is aware of it and attemting to fix it. 

1. Go to Tools - Options - Documents. 
The default parameter is for five of the six options to be non-documents specific. You may change any of these parameters. The 
authors recommend making the styles option non-document specific. 

2. Select the box next to Styles.  
Now all changes you make to Styles in Text, Fill, and Outline will apply to each new document you open. 

3. Click OK to close the dialog. 

Changing the ruler settings 

1. Go to the Tool menu - Options. 
2. Go to Document - Rulers. 

Ruler Options 

Units 
Many different units of measure are available for the rulers. This is because DRAW is an 
internationally sold program. Horizontal and Vertical Rulers can also have different unit of 
measure. Units of measure can also be changed on the Property Bar when nothing is selected. 

Origin 
The origin point for measuring can be moved here or manually on the rulers. To move the origin 
point, hold and drag the box at the upper left corner of the drawing window where the rulers come 
together. 

Tick Divisions This sets the number of marks between the major measurements as in sixth of an inch or tenths of 
an inch. 

Show Rulers Allows you to work without the rulers if you are short on screen space. 

Edit Scale The Edit Scale button allows you to work at a set scale such as 1:2 or 1 inch=1 mile. 

3. Experiment by changing the units to metric or point and picas.  
All object dimension displays will change to what you set on the rulers. You can mix units such as having the horizontal ruler in picas 
and the vertical ruler in inches. 

WORKSPACE 

CorelDRAW allows you to customize the working area or interface of the program. Just as you can float the tool bars, you can create new tool 
bars, hide tool button you never use, or change DRAW to speed work on particular projects. 

1. Go to Tools menu - Options -Workspace . 
DRAW allows you to customize the working area to suit a project, work style, or knowledge of another vector illustration program. 

2. Click on New to create your own workspace. 
Do not make changes to the default. Workspace customization files are very small so you can create as many as you like. While 
you can return to factory defaults by pressing the F8 key while the program is loading, some customizations will not be over written. 
When using the F8 reset, be sure Default is Set as Current. If not, your personal Workspace will be over laid. By preserving the 
default workspace, you have a benchmark when you have problems. 

3. Give the workspace a name. 
4. Click OK. 
5. Go to the listing at the left of the dialog and choose Customization. 
6. To remove a button you don't use , such as the Cut, Copy and Paste buttons because you use the shortcut keys for those, hold 

down the button with the left mouse button, drag it to the work area and drop it.  
It will be removed from the Toolbar. 

7. To add a button, such as the Save All or Save As, go to the Customization option in the file tree at the left of the dialog. 
8. Choose the File and Layout folder - File.  

All the button options for the items on the File menu will then be displayed. 
9. Select the button you want to add and drag it to the tool bar where you want to add it. 
10. To create a new tool bar, drop the button on the workspace and a new toolbar is created.  

Explore the many options by opening the various menu titles listed. 
11. When you have made all the changes you want for now, click on Set as Current. 
12. Click OK to return to the work area. You will see the changes displayed. 
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13. To change the Workspace, go to Tools menu - Options -Workspace and choose the one you want, then click set as current.  
You can create Workspaces with all Web tools, different rules and measuring system, custom colors or any other combination you 
want. Just remember that if you are reloading the program using the F8 key, you should be in the default Workspace. If you have 
more than one person using DRAW, you can each create a custom Workspace. If you move from one machine to another, you can 
take the Workspace with you by copying the file. The Workspaces are saved in the Program Files folder with DRAW 12. 

CorelDraw Illustration -1 
How to Create a Quirky Twitter Bird in Corel Draw 

 
 

 
 
 
Step 4 
Do the same again but cut a smaller, thiner part. Those steps are 
needed to add some light effects, which make it more 3D. 
 
 

 
 
Step 5 
This step uses only one simple option: Intersect (marked by red box, 
shown below). Just as in the steps above, select two object and 
Intersect. You will get the shape that both object share. 
This technique is an easy way to get shapes that you want in many 
other situations. In the picture below, notice that we used circles on 
the main shape, then the eye, then the eyeball, etc. Be sure to apply 
a radial fill to the eye as shown above. 
 

 

 

Below is the final image we will be working towards 
 

 
 
Step 1 
Create new document, whatever size. A4 is fine. Draw the shape 
of the bird’s body using the Free Hand Tool and make it nice with 
the Shape Tool. This part requires a bit of creativity :) 

 
Step 2 
Color the shape blue. Then Copy the shape and paste in the same 
place. Now using the Up Arrow key, move the second shape 4 
pixels up. And then change the color of the second shape to a 
lighter blue. For better a effect use the Radial Gradient Fill Tool 
with a lighter to darker blue. Still the first shape should be darker to 
get that dark line at the bottom. 
 

 
 
Step 3 
Copy the shape and place it in the white area. Copy it again and 
paste it. Then make it a bit larger and put it over the smaller one 
(green on pink example). Using the Back Minus Front option Cut 
the shape off. Then change it to blue (or use the gradient that we 
did in last step). And place it on our main shape. 
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Step 10 
Now let’s make the wings. In the image below, you can see again 
how we cut the shape out of the circle using different circles. Then 
we rounded the corners a bit using the Shape Tool. Also, we added 
some light effect, just like in Step 4. 
Place the wing on the bird. Also, Copy and Paste In Place the same 
wing, but change color to gray, move to the back, and move to the 
left a bit. That gives the effect of the second wing on the other side 
of the bird (you can see tiny gray part near the legs). 
 

 
 
 
Step 11 
We’re almost done. The hat is a simple thing drawn using the 
Freehand Tool to create the shapes shown below. They each were 
given different brightness, fills, and a radial gradients was placed on 
the white stripe to add 3D. 
 

 
 
 
Conclusion 
Place the hat on the bird. Add a dark blue ellipse under the hat 
(some kind of shadow of the hat). And our Quirky looking twitter bird 
in vectors is done! 
 
 

 

Step 6 
Do the same thing again. This time create the bottom part of the 
bird (that’s the way birds are built, a white patch makes the bird 
look more real). 
 
 

 
 

Step 7 
Coming back to using the Back Minus Front option. Cut off the 
shape of the first eyelash. Than copy, paste, resize, and rotate to 
put them together. Now copy the whole thing and paste in place, 
change to a darker blue, rotate a bit, and move it to the back. 
Lastly, group it and place it on the bird. 
 

 
Step 8 
To draw the legs and nose you need to use the Free Hand Tool 
and make it nice with the Shape Tool. In this step, we want to 
show you how using the same color, but in different brightness, 
adds more depth and dimensionality. 
 

 
Step 9 
This must be the easiest step because you do not have to be 
exact. Just draw away and create some jagged shapes for the 
eye. The more uneven the better. 
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CorelDraw Illustration -2 

Spider Web 
 

 
STEP THREE 
You can delete the rectangle now so all you’re left with is the 
straight line. We want to make copies of this straight line, but we 
need to rotate the copies and use left hand side of the line as the 
origin of rotation. So click twice on the line and you should see the 
following: 
 

 
 
STEP FOUR 
Notice the circle in the middle. Click on it and move it over to the left 
corner. This will be the origin of rotation. 
 

 
 
STEP FIVE 
Now this next step may be a bit tricky but try and follow! While 
holding down the Control key, click and drag the bottom right 
rotation arrow downward until you see a new line appear. To 
duplicate the line, right click with your mouse. If you did it right you 
should end up with the following: 
 

 

Below is the final image we will be working towards 
 

 
STEP ONE 
Select the Rectangle Tool, hold down the Control key, and draw 
out a rectangle. Holding down control will keep the rectangle 
proportional. 
 

 
 
STEP TWO  
Go to View > Snap To Objects and make sure it is selected. This 
will help find the edges and nodes of objects. The rectangle is just 
being used as a guide to create a straight line. Using the Bezier 
Tool, click the top left corner and then click the top right corner. 
You should have a straight line on top of your rectangle: 
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STEP NINE 
Repeat step 8 for each pair of lines. It may help to click the Pick 
Tool and then click anywhere in the white space to deselect the 
previous curve before you begin a new curve. If you don’t, you 
may end up adding to the curve and not getting the result you 
intended. You should end up with the following: 
 

 
 
STEP TEN 
Using the Pick Tool and holding down the Shift key, click on each 
curve and then group them all together by hitting Control + G. 
With the group selected, grab the bottom right handle and drag 
inward. You’ll notice a new line of curves display. To duplicate, 
right click on the mouse. You should end up with the following: 
 

 
 
STEP ELEVEN 
Repeat step 10 until the spider web is complete! Here’s my final 
result! 
 

 

STEP SIX 
Repeat step 5 five more times and you should end up with the 
following: 
 

 
 
STEP SEVEN 
Using the Bezier Tool, we’re going to begin to create the curves in 
the web. Let’s start with the following two points: 
 

 
 
STEP EIGHT 
Click on point 1 and then click and drag on point 2 until you get the 
following curve: 
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CorelDraw Illustration -3 
Ray Effect 

 
1. Open Corel DRAW. Select text tool and type the text.Use thick font to get proper line effect. We have used Impact font. Fill it with desired 
color.  
 
Note: It is expected that you have finished with the beginners projects when you start with intermediate, as we do not repeat the small 
instructions. 

 
2. Drag the guide line and using it draw vertical straight line with Bazier Tool. 
3. Make it thicker using Outline Tool. 

 
4. Double click on the line and drag the center of rotation to the bottom. 

 
5. Change the line color to white by selecting the line and right clicking on the white color in the palette. Keep the line selected. 

 
6. Arrange > Transformation > Rotation 
 

 
 
 

7. Keep angle 12 deg and start pressing "Apply to Duplicate" till you get the complete ray effect. 
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Unit-IIIi    
  

  PhotoShop 7.0I 
 
INTRODUCTION 
 
Photoshop is the leading digital image editing application for the Internet, print, and other new media disciplines. It has become a "killer app", 
embraced by a wide spectrum of developers. Traditionally, Photoshop has been and continues to be a print industry standard. There is a very 
strong chance that almost every photographic image you've seen in print (posters, books, magazines, flyers, etc.) has been prepared in 
Photoshop. The powerful features that make Photoshop the standard for print images are also just as useful for Internet and display-based 
images (video and computer presentations for example). Photoshop has evolved, expanding its print capabilities and adding Internet specific 
features essential to current and future web developers. Included with Photoshop is a web-specific companion program, ImageReady. This 
manual covers the fundamental elements of both programs, concentrating entirely on the web-side of digital image production. Photoshop is a 
very deep program. It will take time to use it proficiently and explore its many features. There are often many ways or methods to accomplish 
particular tasks. We will be looking at common web-specific production objectives and the methods you can use to achieve your goals. Before 
we get into the program, it will be useful to detail the nature of digital images themselves. 
 
 

Photoshop and ImageReady  

This task is a basic introduction to Photoshop and ImageReady. In this task, you launch each program and evaluate the general workspace. 

1. Launch Photoshop 
 
To launch Photoshop in Windows, click the Start button and choose Programs, Adobe, Photoshop 7.0, Adobe Photoshop 7.0. To launch 
Photoshop on a Mac, open the folder labeled Adobe Photoshop 7.0 and double-click the Adobe Photoshop 7.0 icon. 

 
 
2. The Basic Photoshop Screen Areas 
 
After closing the wizard, you'll see the full range of Photoshop controls arranged 
on your screen. The toolbox is on the left side of the screen and contains all the 
Photoshop tools. All the Photoshop palettes appear on the right side of the 
screen, and the menu bar appears across the top of the screen. 
The Options bar runs under the menu bar and contains the modifiers for each 
tool you select. 
 

 
3. Launch ImageReady 

 
To launch ImageReady in Windows, click the Start button 
and choose Programs, Adobe, Photoshop 7.0, Adobe 
ImageReady. To launch ImageReady on a Mac, open the 
folder labeled Adobe Photoshop 7.0 and double-click 
the Adobe ImageReady icon. 
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4. The Basic ImageReady Screen Areas 
 
You will find that the ImageReady desktop looks very similar to the Photoshop desktop. Closer examination reveals that some of the tool 
icons and palettes are different, and that the Animation, Rollover, Image Map, and Style palettes appear in the lower-left corner of the 
screen. 

 

 
 
 

How to Use the Toolbox 

Each time you launch Photoshop, the toolbox appears on the screen, usually in the upper-
left corner. In the process of editing an image, you will go to the toolbox frequently to 
choose various selection, painting, and specialty tools. This task outlines what you'll find in 
the toolbox and how to access it. 

 
1. Open the Photoshop Toolbox 
 
The toolbox should appear automatically on the desktop, but it can be closed, which means 
you'll have to reopen it. To open the toolbox, choose Window, Tools. 
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The following information will help you to become familiar with all of the tools available. 
 

    

The marquee tools make 
rectangular, elliptical, single 
row, and single column 
selections. 

The move tool moves 
selections, layers, and 
guides. 

The lasso tools make 
freehand, polygonal 
(straight-edged), and 
magnetic (snap-to) 
selections. 

The magic wand tool selects 
similarly colored areas. 

    

The crop tool trims images. The slice tool creates slices. The slice selection tool 
selects slices. 

The healing brush tool paints 
with a sample or pattern to 
repairs imperfections in a 
image. 

    

The patch tool repairs 
imperfections in a selected 
area of an image using a 
sample or pattern. 

The brush tool paints brush 
strokes. 

The pencil tool paints hard-
edged strokes. 

The clone stamp tool paints 
with a sample of an image. 

    

The pattern stamp tool The history brush tool paints The art history brush tool The magic eraser tool 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                                   - 88 -                                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

paints with part of an image 
as a pattern. 

a copy of the selected state 
or snapshot into the current 
image window. 

paints with stylized strokes 
that simulate the look of 
different paint styles, using a 
selected state or snapshot. 

erases solid-colored areas to 
transparency with a single 
click. 

    

The eraser tool erases pixels 
and restores parts of an 
image to a previously saved 
state. 

The background eraser tool 
erases areas to 
transparency by dragging. 

The gradient tools create 
straight-line, radial, angle, 
reflected, and diamond, 
blends between colors. 

The paint bucket tool fills 
similarly colored areas with 
the foreground color. 

    

The blur tool blurs hard 
edges in an image. 

The sharpen tool sharpens 
soft edges in an image. 

The smudge tool smudges 
data in an image. 

The dodge tool lightens 
areas in an image. 

    

The burn tool darkens areas 
in an image. 

The sponge tool changes the 
color saturation of an area. 

The path selection tools 
make shape or segment 
selections showing anchor 
points, direction lines, & 
direction points.  

The type tools create type on 
an image. 
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The type mask tools create a 
selection in the shape of 
type. 

The pen tools let you draw 
smooth-edged paths. 

The custom shape tool 
makes customized shapes 
selected from a custom 
shape list. 

The annotation tools makes 
notes and audio annotations 
that can be attached to an 
image. 

    

The eyedropper tool 
samples colors in an image. 

The measure tool measures 
distances, locations, and 
angles. 

The hand tool moves an 
image within its window. 

The zoom tool magnifies and 
reduces the view of an 
image. 

Using the tools 
 
You select a tool by clicking its icon in the toolbox. A small triangle at the lower right of a tool icon indicates that there are hidden tools. If you 
position the pointer over a tool it will display a tool tip with the tool's name and keyboard shortcut. 

To show or hide the toolbox: 
Choose Window > Tools. A check mark indicates the item is showing. 

To move the toolbox: 
Drag the toolbox by its title bar. 
 
To select a tool: Do one of the following: 

 Click its icon or press its keyboard shortcut. If the icon has a small triangle at its lower right corner, hold down the mouse button to 
view the hidden tools. Then, click the tool you want to select. 

 Press the tool's keyboard shortcut. 

Using the tool options bar 
 
Most tools have options that are displayed in the tool options bar. The options bar changes as different tools are selected. Some settings in 
the options bar are common to several tools (such as painting modes and opacity), and some are specific to one tool (such as the Auto Erase 
setting for the pencil tool).  
You can move the options bar anywhere in the work area, and dock it at the top or bottom of the screen. 

To display the tool options bar: Do one of the following: 

 Choose Window > Options. 
 Click a tool in the toolbox. 

                                                         

                                                                           

                                                          Lasso options bar 
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4. Select an ImageReady Tool 
 
Click a tool to select it. If the tool button contains a small triangle in 
the lower-right corner, that tool offers additional tool options in a 
pop-out menu. Click and hold the tool button to view the pop-out 
menu and drag through the pop-out menu to select one of the 
additional tools. 
 
 

 
 
 
5. Jump Between ImageReady and Photoshop 
 
 Click the Jump To button at the bottom of either the Photoshop or 
the ImageReady toolbox to move between Photoshop and 
ImageReady. This technique is especially useful when you have a 
file open and want to use features from both applications. You can 
also perform this command from a menu by selecting File, Jump to, 

Photoshop/ImageReady or by pressing +Shift+M (Mac users) 
or Ctrl+Shift+M(Windows users). 
 

 

2. Select a Photoshop Tool 
 
 
Click a tool to select it. If the tool button contains a small triangle in 
the lower-right corner, that tool offers additional tool options in a 
pop-out menu. Click and hold the tool button to view the pop-out 
menu and drag through the pop-out menu to select one of the 
additional tools. 
 

 

3. Open the ImageReady Toolbox 

The ImageReady toolbox should appear on the desktop as soon 
as ImageReady opens. Like its Photoshop counterpart, the 
ImageReady toolbox also can be closed, requiring you to reopen 
it. To open the toolbox in ImageReady, choose Window, Tools. 
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How to Use the Menu Bars 

 
The menu bars in Photoshop and ImageReady operate like the menu bars in any other application. Click the menu name so that the menu 
drops down. Choose an option that has a solid right-facing arrowhead, and a submenu pops out. Choose an option that has a three-dot ellipsis 
(…) following it, and a dialog box opens. Click any option to choose it. This task looks at the grouping of the different menus to help you 
understand the functionality associated with each menu. 

 
2. The Photoshop Edit and Image Menus 
 
You use the Photoshop Edit and Image menus to specify most of 
the standard global changes to an open image. You'll find controls 
for cut and paste, as well as transformations, fill, stroke, and pattern 
on the Edit menu. On the Image menu, you'll find options for color 
mode, canvas and image size, and global color adjustments. 
 

 
 
4. The Photoshop Select Menu 
 
You use the Photoshop Select menu to control selection options 
within the program. These options include inverting selections, 
feathering, selection modifiers, and saving and loading selections. 
 

 
 

1. The Photoshop File Menu 
 
You use the Photoshop File menu to address the basic opening, 
closing, and saving of files. This menu covers the import/export of 
files, workflow management and automated tasks, preferences, 
and color settings for the overall application as well. It also 
contains the Quit command (Exit in Windows) for closing down 
the application. 
 

 

3. The Photoshop Layer Menu 
 
The Photoshop Layer menu covers all your layer options—
creating and deleting layers, merging, applying layer effects, and 
grouping. You can find most of these same controls on 
the Layers palette menu. 
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7. The Photoshop and ImageReady Help Menus 
 
The ImageReady and Photoshop Help menus enable you to turn 
balloon help on and off (for the Macintosh), as well as to access 
help by topic. The Windows version of the Help menu offers 
two About options, which provide version information about 
Photoshop and plug-ins. 
 

 
 
8. The ImageReady File Menu 
 
You use the ImageReady File menu to open, close, and save 
files, as well as to save files optimized as GIFs or JPEGs. This 
menu also covers the import and export of files, HTML browser 
previews, and recent files. The File menu also contains the Quit 
command (Exit in Windows) for closing down the application. 
 

 
 
 

 
9. The ImageReady Edit and Image Menus 
  
You use the ImageReady Edit and Image menus to control most of the standard 
global changes to an open image. Controls for cutting and pasting image data and 
HTML, as well as options for transformations, fill, stroke, pattern, and setting 
preferences are located on the Edit menu. The Image menu is more limited than its 
Photoshop counterpart; it offers canvas and image size controls, as well as a few 
global color adjustments. 
 
 
 
 
 
 

5. The Photoshop Filter Menu 
 
Simply put, the Photoshop Filter menu contains all 101 of the 
native Photoshop filters, divided into 14 subheadings. 
The Filter menu also can include any third-party filters you may 
have loaded in the Photoshop plug-ins folder. 
 

 
 
6. The Photoshop View and Window Menus 
 
You use the View menu to control zooming and previews, as well 
as the visibility of rulers and guides. The Window menu lets you 
launch and close any of the 17 palettes. In addition, 
the Window menu lists all open file windows so that you can move 
a file to the front of the screen simply by choosing it from this 
menu. 
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12. The ImageReady Select Menu 
 
You use the ImageReady Select menu to control selection options 
within the program. These options include inverting selections, 
feathering, selection modifiers, and saving and loading selections. 
 

 
 
 
13. The ImageReady Filter Menu 
 
The ImageReady Filter menu contains 81 ImageReady filters divided 
into 13 subheadings. This menu also includes any third-party filters 
you may have loaded into the plug-ins folder. 
 

 
 
 
 
 
 

14. The ImageReady View and Window Menus 
 
You use the View menu to control zooming and previews as well as the visibility of 
rulers and guides. The Window menu lets you launch and close any of the 18 
ImageReady palettes. In addition, it also lists all open file windows and all the window-
arrangement commands. 
 
 
 
 
 
 

10. The ImageReady Layer Menu 
 
The ImageReady Layer menu covers all your layer options—
creating and deleting layers, merging, applying layer styles, and 
grouping. It also offers control over layer-to-imagemap conversion 
(from the Layer Options selection), slice and image map layer 
creation, and precise layer placement and locking. You can find 
many of these same controls in the Layers palette menu. 
 

 
 
11. The ImageReady Slices Menu 
 
The Slices menu specifies the handling of image slices. A slice is 
the portion of the image when ImageReady divides an image into 
smaller pieces for optimization and display in an HTML table. This 
menu specifies how image slices are created, modified, linked, 
and deleted. You can also preview JavaScript rollovers and link 
slices and slice selections. If it has to do with slices, you'll find that 
option on this menu. 
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Use Photoshop and ImageReady Palettes 
 

 
 

4. Tools and the Options Bar 
 
The Options bar in ImageReady and Photoshop is unique in that its 
content varies depending on the tool selected in the toolbox. By 
default, the Options bar runs across the top of the screen, docked just 
below the menu bar. Should you close it, you can reopen it by 
choosing Window, Options or by double-clicking a tool in the toolbox. 
 

 
 
5. The Palette Menu 
 
A palette menu lists options related to the functionality of the 
associated palette. To open any palette menu, click the black triangle 
in the upper-right corner of the palette; click again to make a selection 
from the list of options. 
 
 

 
 

 
6. Use the Palette Shortcut Buttons 
 
At the bottom of some palettes are shortcut buttons for easy access to 
common tasks. To find out what each button does, first make sure that 
the Show Tool Tips option is selected in the Options section of 
the General Preferences box (choose Edit, Preferences, General), 
and then position your mouse pointer over the button to read the 
description.  
 

 

Photoshop and ImageReady use a floating palette system to group 
items and controls such as brushes and tool options. ImageReady 
uses 18 palettes; Photoshop uses 17. You can open and close 
palettes on demand and easily compress or expand them to 
optimize your workspace. 

 
1. Examine a Group of Palettes 
 
To open a palette in ImageReady or Photoshop, click 
the Window menu; while still holding the mouse button, choose 
the command related to the desired palette. To optimize your 
workspace, the application groups multiple palettes in a single 
window and separates them with tabs. If the palette you want is 
hidden, click its tab to bring it to the front of the window. 
 

 
 
 
2. Collapse and Expand a Palette 
 
To collapse or expand a palette, click 
the Minimize/Maximize button (in Windows) or the Resize button 
(on a Mac). 
 

 
 
3. Resize a Palette 
 
To resize most palettes (some cannot be resized), click and drag 
the lower-right corner of the window. To return a palette to its 
default size, click the Minimize/Maximize button (in Windows) or 
the Resize button (on a Mac). 
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How to Use the Photoshop Color Picker 
 

3. Set the Hue 
 
Click and drag the white triangles on the Hue slider to select the 
desired hue. As you drag, notice that the range of colors displayed 
in the large Select foreground color window changes. 
 

 
 
4. Select a Value 
 
Move the cursor into the Select foreground color window. Notice 
that the cursor changes into a sample dot as you do so. Click in the 
color window to select a color; that color selection is reflected in the 
color swatch at the top right of the dialog box. 
 

 
 
5. Check the Gamut Warnings 
 
If the color you selected falls outside the printable CMYK color 
gamut, a triangle with an exclamation point appears next to the 
selected color. The small color box that appears below the triangle 
indicates which color will print based on the current conversion 
settings. If the color you selected does not fall within the browser-
safe color palette, a cube appears just below the triangle, along with 
another small color box that indicates the corresponding Web-safe 
color. 
 

 

The Photoshop Color Picker is the standard Photoshop interface 
for selecting a color. It allows fast and intuitive color selection from 
millions of colors. The Color Picker also offers Pantone color 
matching and Web-safe color choices. 

1. Set Color Picker Preferences 
 
Choose Edit, Preferences, General to open the Preferences box 
to the General page. Select Adobe from the Color Picker drop-
down list. Although you could select the Windows or Apple color 
picker, the Adobe version is the recommended choice. Click OK to 
close the dialog box. 
 

 

 

2. Launch the Color Picker 

In the toolbox, click the Foreground color swatch to launch 

the Color Picker dialog box. 
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2. Select a Background Color 
 
Click the Background color swatch in the toolbox to launch 
the Color Picker.  
 

 
 
3. Sample a Color 
 
Click the Eyedropper tool in the toolbox. Move the tool in the image 
over the color you want to sample and click to select the desired 
color. The color you select becomes the foreground color (check the 
color swatch in the toolbox). 
 

 
4. Use the Color Palette 
 
Choose Window, Color to open the Color palette. Move the RGB 
sliders as necessary to “mix” the desired color; watch the color you 
are creating in the swatch on the left side of the palette or in the 
toolbox. You also can select additional color models and options 
from the Color palette menu. 
 

 

6. Select Pantone-Type Colors 
 
In the Color Picker, click the Custom button to open the Custom 
Colors dialog box. Select a color-matching system from 
the Book drop-down list and type the color number (if you know it) 
or click in the color spectrum slider to select a color. Click the 
Picker button to go back to the Photoshop Color Picker, or 
click OK to select the color and close the color-selection dialog 
boxes. 
 

 
 

 

How to Select a Color 

The methods described in this task use a combination of working 
with the Color Picker, sampling colors from images, and using 
preset swatches. Use the method that best suits the task at hand. 

 
1. Select a Foreground Color 
 
Click the Foreground color swatch in the toolbox to launch 
the Color Picker.  
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2. Activate Rulers 
 
Choose View, Rulers to make the rulers visible around the top and 
left edges of the image area. 
 

 
 
 
3. Set Guides Preferences 
 
Choose Edit, Preferences, Guides, Grid & Slices to open 
the Preferences box to the Guides, Grid & Slices page. Here you 
can specify the color and format of the guide and gridlines, as well 
as the spacing for the grid. Click the color swatches to select a 
custom color, or use the Color drop-down lists to select from preset 
colors. You can also select slice colors and toggle slice numbers on 
and off. 
 
 

 
 
 

4. Create and Activate Guides 
 
To create a guide, click the Move tool in the toolbox. Click in the 
ruler area and drag into the image area. A vertical or horizontal 
guide will follow the tool, depending on which ruler you started with. 
You can drag out as many guides as you need. You can also place 
a guide in a specific place by selecting View, New Guide and 
entering the orientation and pixel position in the dialog box that 
appears. 

5. Use the Color Swatches 
 
Choose Window, Swatches to open the Swatches palette, which 
contains an array of preset color swatches. Click the desired color 
to select it (it becomes the foreground color in the toolbox). To add 
the current foreground color as a swatch on this palette, move the 
pointer to an empty space on the palette until the pointer changes 
to the Paint Bucket; click to add the color as a swatch on the 
palette. 
 

 
 
 

How to Use Rulers, Grids, and Guides 

The importance of rulers and guides has grown considerably in the 
last few revisions of Photoshop. Guides are user-defined 
alignment lines. The grid is an underlying matrix of lines you can 
use for general alignment of all items on the page. The enhanced 
type features have made text-alignment issues much easier to 
address. In addition, designers are creating complete Web pages 
in Photoshop and ImageReady, which necessitates using guides 
and grids to maintain spacing and alignment. 

 
1. Set Rulers Preferences 
 
Choose Edit, Preferences, Units & Rulers to open 
the Preferences box to the Units & Rulers page. From 
the Units drop-down list, choose the desired unit of measurement 
and click OK. In this instance, you do not have to restart 
Photoshop for the preference change to take effect. 
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USING LAYERS 

One of Photoshop's most powerful features is Layers. 
Layers are similar to acetate or transparent paper. Each 
Layer in a Photoshop document or image can contain image 
data that adds to the image data placed on the Layers 
below. Effectively, each Layer is an entire image unto itself 
within a master image. By combining these images together, 
you get what is called a composite, meaning an image 
composed of many different elements, in this case made up 
of multiple Layers. The best way to understand the concept 
of Layers, how they work, and why they are so powerful is to 
use them. 

Open priests.psd and gate.psd. 

 

priests.psd 
gate.psd 

Make gate.psd active by {Clicking} on the Image Window 
Title Bar. You'll notice the color mode is CMYK rather than 
RGB. CMYK is a color space suited for Print production, 
such as magazines or flyers. Examine the Channels Palette. 
CMYK images are made of a composite of 4 color channels. 
Because we are developing for the Internet, we need to 
convert from CMYK to RGB Image Mode. Select 
Image/Mode/RGB Color. Examine the Channels Palette. 
You'll see only 3 primary color channels and the composite 
RGB channel. We're going to use Layers to add text to the 
gate.psd image and add some content from the priest 
image. We'll be using some of the Selections Tools as well. 
We'll begin by examining the Layers Palette. {Click} the 
Layers Tab in the Layers Palette Set. 

Layers Palette 

The Layers Palette consists of many distinct controls, which 
include Layers themselves, Layer Options, Blend Mode, 
Opacity, Layer Lock Options, Fill, and the Layer Style, Layer 
Mask, New Layer, New Layer Set, New Adjustment Layer, 
and Trash Icon set at the bottom of the Palette. It's important 
to note that Layers have a stacking order, from the bottom 
up, meaning the Layer at the very bottom of the Layers 
Palette is the last or bottom Layer. 

 

 

 
5. Set Snap-To Parameters 
 
To precisely align elements to guides and grids as you drag the elements; 
choose View, Snap To, Guides or View, Snap To, Grid. Choose these 
commands again to turn them off. 
 

 
 
6. Lock Guides as Needed 
 
To lock the guides in place, choose View, Lock Guides. When you lock 
the guide lines, you prevent them from moving accidentally, especially 
when you are using numerous guides. 
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Visibility Toggle: {Clicking} the Visibility Toggle (see above) makes 
Layers visible or invisible in the Image Window. It's important to note 
that even though a Layer may be invisible, if it's the active Layer or 
is linked to an active Layer any changes you perform still occur. 

Blend Mode: You can select from over twenty different Blend Mode 
options that affect how the image data in a Layer mixes or blends 
with other Layers. Usually you'll use Normal mode. Some of the 
other Blend Modes produce interesting effects. By experimenting 
and practicing as you compose your images, you will become 
familiar with the most, if not all the Blend Modes. You must have at 
least two Layers in your image to use Blend Mode. 

Lock Transparency, Pixels, Position, and All: {Click} the Lock 
Transparency Icon to limit painting and editing effects to areas of a 
Layer that are not transparent. You can also lock the pixels 
information itself, lock the position of the pixels, or lock the entire 
Layer by {Clicking} the appropriate Icon. A Lock Icon appears 
beside the Layer Name. To disable a lock, {Click} the appropriate 
Icon again. 

 

Layer Modification Options: Along the bottom of the Layers 
Palette are six (6) key Options. 

Layers 

Each Layer contains a Layer Name, Thumbnail, Paint or Link 
Toggle, and Visibility Toggle. 

Layer Name 

It's a good idea to name your Layers for easy reference and 
organization. By default Photoshop names each new Layer "Layer 
x" where x represents a number, starting at 1. If you import a flat 
image (meaning an image with only one Layer, such as 
priests.psd, Photoshop defaults to naming the Layer "Background" 
in italics. The Italics indicate that no other Layer can be placed 
beneath it, in effect locking the Layer as the bottom of the Layer 
stack. To change the name of the "Background" Layer simply 
{Double-Click} the Layer and enter a new Name in the Name field. 
When you rename the "Background" Layer it is no longer fixed to 
the bottom of the stack. The Lock Icon will disappear. 

Thumbnail 

The Thumbnail is a visual representation of the Layer's content. By 
default, Photoshop uses the smallest Thumbnail size. To change 
the size or disable the Thumbnail {Click} the Layer Options menu 
and select Palette Options. Check the Thumbnail size you desire 
in the Layers Palette Options dialog box. The Layers Palettes 
pictured in this manual is set to the largest thumbnail size. 

 

Select Palette Options and then select from 
four (4) choices for Thumbnail Size. 

Paint or Link Toggle 

When a Layer is active or selected (by {Clicking} on it) a 
Paintbrush icon appears in the Toggle box beside the Thumbnail, 
indicating the Layer can be manipulated for editing. When you 
{Click} in the Toggle box of an inactive or unselected Layer you 
"Link" that Layer’s content to the current active Layer, no matter 
where the active Layer is in the stacking order. Changes in 
position and various effects you apply to the active Layer are also 
applied to the Linked Layer. A Chain Icon appears to indicate 
Linking. 
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If you haven’t done so already in the previous chapter, make a 
Selection around the Priests in the orange and green robes in 
priests.psd (if you have made the Selection, feel free to load 
priestsChannel.psd (if you called it that) for this exercise.) The 
shape around the Priests is somewhat irregular so a selection has 
been saved with the image for your convenience if you do not wish 
to create your own. Once the Selection is completed, select 
Edit/Copy to copy the contents of your Selection to the clipboard. 
The clipboard is Photoshop's storage area for image data you copy 
and paste. 

Make gate.psd active. Select Edit/Paste. Your Selection (the 
Priests) is pasted into gate.psd in a new Layer. Photoshop 
automatically titles the Layer "Layer 1." Select the new Layer and 
rename it "priests". Another method of moving image data from one 
image to another is by using the Move Tool. With the Move Tool, 
{Click}, drag, and drop your selection from priests.psd to gate.psd. 

Transparency: Examine the Layers Palette. The priests Layer sits 
on top of the Background Layer and in the Image Window the 
Priests sit on top of the Gate image. 

 

The Priests appear on top of the gate, just as the priests 
Layer is on top of the Background Layer 

in the Layers Palette. 

Add Layer Style: A Layer Style is a prepackaged set of visual 
modifications that you can control to modify the content of the 
selected Layer. Typical Layer Style’s include Drop Shadow, Bevel 
and Emboss, and Color Overlay among others. We will be using 
some of these as we progress through the manual. 

Add Layer Mask: A Layer Mask will mask the currently active 
Layer. We will use a Layer Mask later in the chapter. 

Create New Set: {Clicking} Create New Set creates a new Layer 
Set above the currently selected Layer or Layer Set. We will create 
a Layer Set later in the chapter. 

Create New Fill or Adjustment Layer: {Clicking} Create New Fill 
or Adjustment Layer creates a Layer that allows the designer to 
apply tonal and color modifications to their image without having to 
permanently affect the image content. For example, you may wish 
to make someone’s shirt brighter. Rather than actually modifying 
the brightness of the pixels that make up the shirt in the image, 
you create a Layer that makes the shirt appear brighter. If you or 
your client do not like the change you simply discard or change the 
Adjustment Layer. The original pixel information will have never 
been modified. We’ll be using this feature later in the chapter. 

Create New Layer: {Clicking} Create New Layer creates a new 
Layer above the currently active Layer. 

Delete Layer: {Clicking} Delete Layer deletes the currently 
selected Layer. You are asked to confirm whether or not you wish 
to delete the Layer. If you have only a one (1) Layer you cannot 
delete it. 

Using Layers: Make sure you have both priests.psd and gate.psd 
open and that you have changed the Image Mode of gate.psd to 
RGB. 

priests.psd 
gate.psd 

 
Make priests.psd active. 
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Make the Background Layer visible again. Make sure the 
Priests Layer is active. Layers are active when colored 
blue. A Paintbrush icon also appears in the Paint/Link 
Toggle box. {Click} the Opacity control and drag the slider 
back and forth. You begin to see the Gate and Trees in 
the background through the Priests as you decrease its 
opacity. As you create images you'll find Transparency a 
powerful tool. 

Moving Layers: Select the Move Tool. Make sure the 
priests Layer is active. {Click} and drag the Priests in the 
Image Window. You'll notice that you can move the 
Priests or part of Priests outside the edges of the Image 
Window. With Layers, you can think of the Image 
dimensions as the dimensions of a virtual window through 
which we see the image data. Photoshop permits you to 
move image data outside of the virtual window. As a 
result, we can do things like drag the Priests to the bottom 
right corner of the screen so that only their faces appear. 
You'll find this flexibility a great creative aid when 
composing images. 

Blend Modes: Move the Priests to the center of the 
image. {Click} the drop-down Blend Mode list and explore 
the different Blend Mode Options. Photoshop examines 
the color data of the Layer you are blending and the color 
data of the Layers below and uses the various Blend 
Mode Options to create particular visual effects. Keep in 
mind you can also move the Layer around and play with 
Opacity. Photoshop's flexibility and complexity 
encourages combining effects and operations for 
increased creativity. Move the Priests around the image to 
see how each Blend Mode appears against different parts 
of the Layer beneath. Make sure you select Normal for 
the Blend Mode before proceeding. 

Layer Masks: Non-Destructive Editing: Layer Masks 
are Alpha Channels attached to a Layer. Black completely 
masks or covers image data. White reveals image data. 
Gray values between Black and White reveal image data 
at various degrees of opacity. Add a Layer Mask to the 
Priests Layer by {Clicking} the Add Layer Mask button at 
the bottom of the Layers Palette. A Link Icon and a Mask 
Thumbnail are added to the Layer. 

 

You can see the gate, tree, and landscape around the Priests because, by 
default, Layers are transparent. Pasting the selection into gate.psd has 
created a new Layer with a transparent background in which the Priests 
selection sits. 

Transparency (con't): Recall when we created a new image we selected a 
transparent background. Transparency is represented by a gray and white 
checkerboard. {Click} the Visibility Toggle in the Background Layer. The gate 
disappears. You see only the Priests and the transparent background that 
surrounds them. 

 

With the visibility of the Background Layer toggled to invisible we can see the 
transparency surrounding the Priests. 

Lock Transparent Pixels: Select the Brush Tool. Make sure the Priests 
Layer is active. {Click} Lock Transparent Pixels. Paint on the Priests Layer. 
You'll notice that your paint strokes are limited to areas that contain image 
data, in this case the Priests.  

The effect is similar to painting a Selection. By selecting Lock Transparent 
Pixels, you are restricting changes to the image data contained within the 
Layer. Use the History Palette to remove your brush strokes and {Click} Lock 
Transparent Pixels again to disable it. 

Lock Image Pixels: {Click} Lock Image Pixels. Locking the Layer's pixels 
will allow you to reposition the content of the Layer but not change or modify 
the pixels themselves. You cannot, for example, use the Brush Tool to 
change the color of an object on a Layer with locked pixels. {Click} Lock 
Image Pixels again to disable it. 

Lock Position: {Click} Lock Position. Locking the Position of content on a 
Layer allows you to paint or edit it but not move it. {Click} Lock Position again 
to disable it. 

Lock All: {Click} Lock All. Locking the entire Layer disables moving or 
modifying the Layer whatsoever. {Click} Lock All again to disable it. 
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Layer Masks: Non-Destructive Editing (con't) 
Set the Foreground Color to Black. Select the Brush Tool. {Click} the Enable Airbrush Icon and {Click} on the Brush Preset Picker in the Brush 
Tool Options.  

Make sure that Mode is set to Normal, Opacity to 100%, 
and Flow to 100%. 

 

 

 
 

Layer Masks: Non-Destructive Editing (con't) 
Use the Master Diameter Slider or input a Diameter manually in the Master Diameter Field. In 
this case, select a Diameter of 30 pixels (px). 

We're going to remove the Priest in the green robe from the picture, or rather we are going to 
Mask the Priest so that he is not visible. This is a Non-Destructive approach to removing the 
Priest in the green robe. If we were to take a Destructive approach, such as erasing the Priest 
from the Layer, we would not have the benefit of easily reversing our decision to remove the 
Priest. For example, we or one of our clients may want the Priest removed one week and put 
back in the next. Using a Non-Destructive approach such as a Layer Mask, we could simply load 
the Photoshop Document and remove the Mask. Let’s try it out. 

 

Layer Masks: Non-Destructive Editing (con't) 

 

As you paint the Mask over the Priest in the green robe the pixel 
data is hidden. When the Mask is complete, it appears that only one 
Priest is in our image. Because a Layer Mask is Non-Destructive, 
the Priest is still actually present, and his visibility can be restored 
by disabling, modifying, or removing the Layer Mask. 

Layer Masks: Non-Destructive Editing (con't): Start painting 
over the Priest's face by {Clicking}, holding, and dragging the 
mouse over the face. Notice how the face disappears. {Release} 
the mouse button. If you examine the Thumbnails in the Layer, 
you'll notice the Mask Thumbnail displays Black where you've 
applied your paint strokes, making those areas taken up by the 
Priest’s face transparent. The Priest Thumbnail looks the same 
because you haven't actually erased the Priest; you're merely 
hiding or masking him. 

 

You can see the Priest’s face in the Layer Thumbnail. You can also see the 
Mask in the Mask Thumbnail. The Priest’s face is hidden or masked in the 

Image Window. 

Layer Masks: Non-Destructive Editing (con't): Continue using 
the Brush Tool to hide the Priest. You may need to zoom in closer 
and reduce the Diameter of the Brush Tool as you paint the Mask 
closer to the edge of the Priest in the yellow robe. You should 
notice that the longer you hold the mouse button down, the pixel 
data is erased gradually, this is because we have set the Brush 
Tool to the Airbrush Option. As you create your Mask, you may 
wish to look at the Channels Palette as well. Note that a Mask in 
Photoshop is automatically added to the Channels Palette as an 
Alpha Channel. 
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Modifying a Layer Mask 
You can modify a Layer Mask by {Right-Clicking} the Layer Mask in the Layers Palette and selecting from a number of different options. 

Set Selection to Layer Mask 
This creates a Selection around the boundaries of the Layer Mask. 

Add, Subtract, Intersect 
If you already have a Selection created, use one of these Options to use the 
boundaries of the Layer Mask in combination with your Selection.  

Layer Mask Options 
You can set the color and the opacity of the Layer Mask when you toggle its 
Visibility in the Channels Palette. 

Discard Layer Mask 
Select this Option to delete the Layer Mask. Anything that was covered by the 
Layer Mask is uncovered. 

Apply Layer Mask 
Select this Option to make the Layer Mask permanent. The area in the image that is covered by the Layer Mask is removed and the Layer 
Mask itself deleted. 

Disable Layer Mask 
Select this Option to temporarily disable the Layer Mask. This Option changes to Enable Layer Mask when the Layer Mask is disabled. 

Link and Unlink a Layer Mask 
{Click} the Link Icon in between the Thumbnails of the priests Layer. Move the Priests with the Move Tool. Note that the Mask remains in 
place. To move the Mask with the image data keep the Thumbnails linked. 

Transforming Layers 
You may have noticed that the Priest is a bit too large for the image that he has been inserted into. This can be easily corrected. You can 
Transform the Layer to scale, rotate, and distort image data. 

Select Edit/Free Transform. A Transformation Box surrounds the image data of the Layer, in this case the Priest. By {Clicking} on the Box's 
handles, you can resize the image data. Holding the [SHIFT] key constrains the Box as you resize, maintaining proportion. If you hold the 
mouse pointer just outside of the Box close to one of the Handles you can rotate the image. 

For precise Transformation control you can input numerical values in the Options Bar. 

Rotation is based around the Reference Point, which is at the 
center by default. To move the Reference Point, {Click}, hold, and 
drag it to the desired location. {Release} the mouse button to 
place it. 

 

What is Skew?: When an image is skewed its distorted on an angle. For example, we’ve applied a skew to the priest. Note how he seems to 
be leaning to the left. 

What is Skew (con't)?: We don’t want to skew or 
rotate the Priest, we simply want to reduce his scale. 
Make the Priest is slightly smaller so that he looks as 
though he is walking down the path beside the gate. 
We’ve selected the Maintain Aspect Ratio button 
between the Width and Height fields and input a value 
of 80%. We’ve also placed him toward the left side of 
the image: 
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Creating New Layers 
To create a new Layer {Click} the Create a New Layer button at the bottom of the Layers Palette. A Layer is added above the currently active 
Layer. Make the new Layer active and rename it "Garbage Can." 

Make the Background Layer active. Make a Selection around the 
White Garbage Can and Sign on the bottom left hand side of the 
image. The Priest may be obscuring that part of the image, if so, 
use the Visibility Toggle for the priests Layer. 

Having made your Selection, copy it to the Clipboard by selecting Edit/Copy. Make the Garbage Can Layer active. Select Edit/Paste. Your 
Selection, in this case the Garbage Can, is placed into the Layer. You may have to move the content on the Layer to reposition it exactly 
where it's placed on the original image (the Background Layer.) As an alternate, you can select Edit/Paste Into. A new Layer is created and 
the image data in the Selection is copied to the precise position it was copied from. In addition, a Layer Mask is automatically created based 
on the Selection. 

Creating New Layers (con't) 
If you toggle the Visibility of the other Layers to off, you can see the 
items you’ve selected, cut, and pasted into a new Layer. 

Move the priest Layer by dragging it beneath the Garbage Can 
Layer (if you used the Paste Into method, delete the Garbage Can Layer you created and rename the automatically created Layer to Garbage 
Can.) 

Creating New Layers (con't): The Priest now appears behind the 
garbage can. We've now added depth to the image. The Priest 
appears behind the Garbage Can and a measure of realism has 
been added to the photograph. You've created an image or 
composite using Layers. By isolating different elements or 
components of an image in Layers, you have a great deal of 
creative flexibility. Imagine creating this image without Layers. You 
would have to make very precise selections and use the History 
Palette extensively. It would also take up much more time. 

Text and Layers: When you add Text to an image by selecting the 
Type Tool and {Clicking} in the Image Window at the location you 
want your text to appear, a Layer is automatically created above the 
currently active Layer. The name of the Layer defaults to the text 
you input. 

Photoshop allows you to type text directly into or over the Image Window. Other image editing programs and previous versions of Photoshop 
required that you type your text into a specialized dialog box. Now all the user needs do is select the Type Tool, place their cursor in the Image 
Window and begin to type. 

Make sure the top Layer in the Layers Palette is active and the Foreground Color is white. Select the Type Tool and {Click} toward the top left 
corner of the image. At this point, we won't go through the Type Tool options in the Options Bar, for now select the following settings: 

 Arial (a typeface everyone should have) from the Font 
Family drop-down menu 

 Bold from the Font Style drop-down menu 
 Input or select a value a 12 pt in the Font Size drop-

down menu 
 Smooth from the Anti-aliasing Method drop-down menu 
 Left Align from the Justification Options 

 

Text and Layers (con't) 
Input "Japanese Shrines" and {Click} OK. Your type is created in its own Layer and the name of the Layer is the text you input. This Type 
Layer is editable and is indicate by a capital "T" in the Layer Thumbnail. 

 

By using a combination of Layers, Selections, Transforms, and a 
Layer Mask, a Priest from one image has been placed in another to 

make a new image. 
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Layer Styles (con't): A rather substantial dialog box appears with 
options to adjust the appearance of the Drop Shadow. Use the 
Layer Style dialog box to add, remove, and modify Styles attached 
to your Layers. {Click} on a Layer Style checkbox to add a Style and 
{Click} on the Style 
label to modify its 
properties. We'll take 
a closer look at the 
Styles later in the 
manual so stick with 
the Drop Shadow for 
the time being. Make 
sure you use the 
following settings (as 
seen in the 
screenshot): 

 

Layer Styles (con't) 
Once you’ve set the Options, 
{Click} OK to close the Layer 
Style dialog box. Take a look 
at your Image Window. There 
is a shadow behind the type, 
making it more visible against 
the background. A lower-case 
italic "f " appears in the Layer 
indicating that a Layer Style has been applied. You can {Click} the 
triangle beside the "f " to expand or collapse the list of Layer Styles 
you’ve applied to a particular Layer. You can also toggle the visibility 
of any of the Layer Styles, just as you do a Layer. To edit an 
existing Layer Style, {Double-Click} it in the Layers Palette. Each 
Layer Style has a set of properties that change according to the 
effect. Experiment with properties to customize the effect. 

 

Text and Layers (con't): At this point, the type can be re-edited or 
changed by highlighting the text in the Image Window (make sure 
the Type Layer is selected in the Layers Palette) with the Type 
Tool in the Layer. You can position the type as close to the top left 
corner as you wish using the Move Tool. 

Looking at the image at this point, the text isn’t particularly visible 
against the background. 

 

We could change the Color, Font Family, or Font Size, or we could 
use a Layer Style. 

Layer Styles: Layer Styles are pre-defined special effects applied 
to the image data contained in the Layer. To apply a Layer Style, 
select the Layer you want to apply the effect to and {Click} on the 
Add a Layer Style button at the bottom of the Layers Palette. In 
this instance, apply a Drop Shadow to your Type Layer. From the 
Styles drop-down, select Drop Shadow. 

 Blend Mode: Multiply 
 Opacity: 100% 
 Angle: 140 degrees 
 Use Global Light: Checked 
 Distance: 5 px 
 Spread: 15 px 
 Size: 5 px 
 Layer Knocks Out Drop Shadow: 

Checked 
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Layer Sets (con't): The new Layer Set is named "Set 1" by default. 
Rename the Layer Set by {Double-Clicking} on it and inputting an 
appropriate name. You can also give the Layer Set a color if you 
wish. It is important to remember that the color settings for your 
Layer Set override any individual color settings you have given 
individual Layers. To place a Layer in a Layer Set you {Click} and 
drag it onto the Set's Folder Icon. You need to place it directly on 
the Icon or the move won't take place. A successfully relocated 
Layer will appear below the Layer Set and its Thumbnail will be 
slightly indented. A Layer Set can be expanded or collapsed by 
{Clicking} on the small gray rectangle beside the Layer Set name. 

 

Both the "priests" and the "Garbage Can" Layers 
are in the "Priest Set" Layer Set. 

Layer Sets (con't): Note the default Blend Mode of the Layer Set. It 
is set to Pass Through. What Pass Through indicates is that the 
Layer Set itself does not have any Blend Mode properties; it merely 
passes through the Blend Mode settings of the Layers it contains. 
You can select another Blend Mode for the Layer Set and it will take 
all the properties of the Layers it contains and composite them. 
Once the composite is built, that composite of Layers is treated as 
single Layer and the Blend Mode for the Layer Set is applied to the 
composite of Layers and then composisted with any other Layers 
and/or Layer Sets that the image contains. You have successfully 
completed assembling your first composite image using Selections, 
Layers, a Layer Mask, and a Layer Set. Save your image if you 
wish. You can compare your image to the one referenced in this 
manual which is called gate.psd, in the completed folder for this 
chapter. 

 

gate.psd 

 

Managing Layers: As you produce images in Photoshop, some of 
them can be quite complex, consisting of many Layers. Knowing 
how to manage Layers can help you and anyone you may 
collaborate with work efficiently. 

Changing the Stacking Order: To change the stacking order of 
Layers simply {Click} and drag the Layer above or below other 
Layers. A solid black line indicates the Layer is ready to be 
dropped. {Release} the mouse button. 

Duplicating Layers: Use the Layer Options Menu and select 
Duplicate Layer to make a copy of the Layer. You can title the 
Layer and choose to copy it to the same image, another image you 
have opened, or create a new image with the contents of the 
Layer. 

Merge Options: Selecting Merge Down merges the contents of 
the currently active Layer with the Layer below it. Selecting Merge 
Visible merges the all the currently visible Layers. The bottom 
Layer must be visible and the currently active Layer. Select 
Layer/Merge Linked to merge Layers you have linked together. 
Select Flatten Image to merge all Layers. This removes all the 
flexibility you have with Layers. 

Color-coding Layers: Photoshop has made managing Layers 
much easier by allowing the user to color-code them in the Layers 
Palette. Select Layer Properties from the Layer Options Menu, 
select a color from the drop down menu and {Click} OK. 

Layer Sets: Photoshop also allows the user to group similar 
content into a Layer Set. A Layer Set is like a folder into which you 
place a collection of individual Layers. Create a Layer Set by 
clicking on the New Layer Set button at the bottom of the Layer's 
Palette. The Layer Set is created above the currently selected 
Layer by default. 

 

By default the new Layer Set is created 
above the currently selected Layer. 
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EDITING IMAGES 
 

Using Photoshop’s Tools 
Photoshop's Tools are very powerful. For each Tool, there are sets of options (in the Options Bar) you use to define how the Tool operates. To 
use Photoshop effectively you should be familiar with all the fundamentals and use them in combination to 
create images. 

As we progress through the Drawing Tools we're going to need an image we can use to experiment with. 
Open blank.psd (we’ll be using other images as well.) 

This image is 600 x 300/72ppi, with two (2) Layers, transparent and white. As you read this section, try the tools and options out on your 
image. You might want to make a separate Layer for some of the Tools 
you experiment with. 

The Brush Tool  
When you use any of the Brush Tools, it's a good idea to select a 
Brush Diameter, Brush Shape and Color immediately. Select the Brush 
Tool and examine Options Bar. 

Tool Presets: A Tool Preset is effectively a library of custom settings for a particular 
Tool. Each Tool in Photoshop has a set of Options that can be set in the Options Bar. If 
you find yourself using the same set of Options repeatedly you may wish to make a Tool 
Preset so that you do not have to input the Options in the future. If you examine the 
Options for the Marquee Tools for example, among other Options we have Feather and 
Anti-aliased. We’ll cover each of these Options below, however, if you were to commonly 
use a the Eliptical Marquee Tool with Anti-aliased checked and a Feather value of 20, 
you could create a Tool Preset that saves those Options. 

To create a Tool Preset, select the Tool, in this case the Eliptical Marquee Tool. Input a 
value of 20 into the Feather field, and check Anti-aliased. Next, {Click} the Tool Preset 
drop-down menu to view the Tool Preset window. 

 

Brush Preset Picker: {Click} the Brush Preset Picker to set Brush 
Diameter and Brush Shape. Use the Master Diameter Slider or input 
box to set the diameter you desire. Select a Brush Shape by 
{Clicking} on it. You can use the scroll bar to view more shapes or 
resize the Brush Preset Picker box. The diameter is displayed 
(which you can change) and a sample stroke is displayed. 

Brush Preset Picker (con't): In addition to the default Brushes, you 
can add more Brushes by selecting Options and choosing from a 
variety of Brush categories. For example, if we select the Special 
Effect Brushes Category, we are asked if we wish to replace the 
current Brushes or append them to the current set of Brushes. The 
additional Brushes will appear 
below the current set.  

Its usually good to append so 
that you do not remove the 
default set, however, if you do, 
select Reset Brushes from 
Options. The defaults will be 
restored. 

Painting Mode: Painting Mode affects the way the color of the Brush mixes with existing image data in the same manner as the Blend Mode 
for Layers  

 

blank.psd 
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To get a good idea of how the Color Field works in tandem with the 
Color Slider select the R in the RGB Color Mode. The Color Slider 
presents the full range of Red Colors from the darkest to the 
lightest. With Red selected, the Color Field will consist of a mix the 
remaining primary colors, Green and Blue. You can select a Red by 
using the Color Slider or select from the Color Field. Just as with the 
HSB Color Field, when you adjust the Color Slider, the Color in the 
Color Field adjusts as well. You can also input numerical values into 
the Color Mode Fields or the Hex Value Field. To view only Web-
Safe Colors (a range of 216 fixed Colors that the major browsers 
use), check the Web-Safe Colors checkbox. Your chosen Color 
appears in the Color Swatch. Once you have chosen a Color, {Click} 
OK. You can begin to paint with your selected Brush. 

Try a variety of Brushes, Colors, and Brush Shapes. Append other 
Brush Sets to the Brush Preset Picker and try them. Adjust both 
Opacity and Flow Rate and note how these settings affect the Brush 
Stroke. Use the History Palette to remove your changes or make 
different Layers to experiment with. 

The Color Palette: To create a Color using the Color Palette, select 
the Foreground Color Swatch or Background Color Swatch and use 
the Color Sliders, the Color Fields (input values between 0 - 255), or 
the Color Ramp to select your desired Color. 

 

The Color Palette (con't): Select both RGB Sliders and RGB 
Spectrum (for the Color Ramp) when working with images for the 
web. If you are limiting yourself to the Web-Safe Color palette, 
select Web Color Sliders and Make Ramp Web Safe. Web-Safe 
Color is covered in a later chapter. 

 

Stroke Opacity: Stroke Opacity affects the level of transparency 
of the Stroke (0% being fully transparent, 100% being fully 
opaque.) 

Stroke Flow Rate: The Stroke Flow Rate determines the rate at 
which paint is applied. For example, even though you might have 
Stroke Opacity set to 100%, if you’ve set Stroke Flow Rate to 20% 
and you’ve selected Black as your Color, a grey opaque Color 
results. By continuing to brush over the same area, the Color will 
get darker. 

Enable Airbrush: {Click} Enable Airbrush to switch the Brush Tool 
to an Airbrush Tool. When an Airbrush, the Brush Tool effectively 
sprays color onto an image, similar to painting with a can of Spray 
Paint. Imagine the mouse button is the nozzle you press down and 
hold as you spray. The longer you spray a particular area the more 
opaque or dense the color or paint becomes. In other words, as 
you apply increased or consistent pressure the density of the color 
increases. 

Selecting a Color: Before we proceed, we should select a Color. 
In Photoshop, there are a variety of ways to select a Color, 
including the Color Picker, the Color Palette, and the Swatches 
Palette. 

The Color Picker: One method of selecting a Color in Photoshop 
is to {Double-Click} the Foreground Color Swatch (because the 
current Foreground Color Swatch holds your paint Color) to launch 
the Color Picker. 

 

The Color Picker (con't): There are three Color Modes with which 
you can select a Color from by using the Color Slider and the 
Color Field. By default, the HSB Color Field is selected. HSB 
stands for Hue, Saturation, and Brightness, and is a Color Mode 
from which you can select a valid RGB Color. To select a Color, 
simply {Click} anywhere within the Color Field. Note that the 
numerical values in each Color Mode are displayed. Use the Color 
Slider to adjust the range of Colors within the Color Field. 
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To restore the Swatches Palette back to its default Colors, select 
Reset Swatches from the Options Menu. 

The Brushes Palette: To customize and modify Brushes to a great 
degree, you can use the Brushes Palette which, by default, is 
docked in the Palette Well beside the File Browser. 

 

Selecting a Brush Preset: To select a Brush Preset, {Click} on the 
Brush Presets Name in the Brush Modifiers column. The Modifier 
Options column displays the default Brush Presets that we looked at 
in the Brush Preset Picker. Use the Master Diameter Slider to set 
the size of the Brush. 
 
Creating a Custom 
Brush: To create a 
custom Brush, first 
select a Brush 
Preset as a starting 
point and {Click} the 
Create New Brush 
button. Give the 
Brush an 
appropriate name. 
Next, you can 
select from any of 
the remaining 
options in the Brush 
Modifiers column. 
You usually start by 
modifying the Brush 
Tip Shape and then 
move on to select 
one of more options 
to create your 
custom Brush. 
Selecting the 
checkbox beside 
each Modifier 
makes it active. To view and modify the options for each Modifier, 
{Click} on the Modifier Name itself. Modifier Options will vary. 
Experiment with the options presented to you until you are happy 
with your custom Brush. Note that not all of the Brush Modifiers 
have options. 

The Swatches Palette: The Swatches Palette defaults to a broad 
spectrum of available Colors. To choose a Color {Click} on a Color 
Swatch. The Color you select replaces the current Foreground 
Color. 

 

Creating a Custom Swatch: To create your own swatch(es), 
modify the Foreground Color in the Color Picker or Color Palette 
and then select the Swatches Palette and {Click} the Create New 
Swatch of Foreground Color button. Name your custom swatch 
accordingly. 

Viewing Colors by Name: To view Colors by name, select Small 
List from the Options Menu. You can change the scale of the 
Swatches Palette to view a list of two (2) columns. 

 

Saving, Adding, and Restoring Swatches: To save swatches 
you’ve created select Save Swatches from the Options Menu. You 
can also add swatches by selecting from a variety of included 
swatch sets listed at the bottom of the Options Menu as well as 
selecting Load Swatches to load in a custom swatch set. You will 
have the option to append or replace the existing swatch set. 
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The Clone Stamp Tool (con't): Using the Clone Stamp Tool, we 
selected reference points close to the people in the image and 
painted over the people by duplicating the surface of the pillars 
nearby. The result: 

 

The people have been removed. 

Clone Stamp Tool Options: Most of Options for the Clone Stamp 
Tool are identical to the Brush Tool; however, the Aligned and Use 
All Layers Options differ. 

 

Aligned: Check Aligned to force the cross-hair established at the 
reference point to follow the Clone Stamp Tool regardless of how 
many times you {Click} and {Re-Click}. When Aligned is unchecked 
the cross-hair returns to original reference point after you have 
released the mouse button and {Click} again to resume. 

Use All Layers: Check Use All Layers to duplicate visible image 
data in all Layers. Uncheck to duplicate the image data from 
currently active Layer exclusively. The Clone Stamp Tool is not 
limited to duplicating image data into the same image or a single 
Layer. You can establish reference points in one Image Window and 
duplicate the contents into another Image Window or another Layer. 
Open the landscape.psd image and practice using the Clone 
Stamp Tool. 

 

landscape.psd 

Try to add and remove trees and rocks. Duplicate elements from 
landscape.psd into a new 
Layer of blank.psd. 

Pattern Stamp Tool:   
The Pattern Stamp Tool 
paints or repeats a pattern. 
You use the Rectangular Marquee Tool to define patterns in 
Photoshop. 

Defining a Pattern: Using the landscape.psd image, create a 
rectangular Selection around one of the trees. Select Edit/Define 
Pattern. Name the Pattern accordingly. There are no limits on the 
size or content of the pattern, but it must be rectangular. Photoshop 
stores the pattern you've just defined for use by any of the Tools 
that use patterns, such as the Pattern Stamp Tool in Pattern drop-
down menu in the Options Bar. {Click} on the Pattern drop-down to 
access your defined pattern in addition to a range of preset patterns.  

Try to create your own custom Brush and experiment with it. 
Remember to select different Colors, try different Brush Diameters, 
and change Opacity and Flow Rate. 

Pencil Tool Options: Select from Brush Preset Picker, Painting 
Mode, Opacity, and Auto Erase. 

 

Brush Preset Picker: {Click} the Brush Preset Picker to set Brush 
Diameter and Brush Shape. Use the Master Diameter Slider or 
input box to set the diameter you desire. 

Painting Mode: Painting Mode affects the way the color of the 
Brush mixes with existing image data in the same manner as the 
Blend Mode for Layers. 

Opacity: Opacity affects the level of transparency of the Stroke 
(0% being fully transparent, 100% being fully opaque.) 

Auto Erase: Check Auto Erase to make the Pencil Tool paint the 
currently designated Background Color over the currently 
designated Foreground Color. Experiment with Pencil Tool with 
blank.psd. 

The Clone Stamp Tool: The Clone Stamp Tool operates like the 
Brush Tool except that rather than selecting a color to paint with, 
you select an area of the image to duplicate or clone by 
{Alt/Option-Clicking} the area you wish to duplicate. As you paint 
with the Clone Stamp Tool a cross-hair passes over the area 
you've selected for your reference. The diameter of the brush you 
select in the Brushes Palette determines the size or radius of the 
cloning area. Usually, you’ll have to reestablish a reference point 
or area repeatedly and paint over other areas of the image in small 
parts. Use the Clone Stamp Tool to modify photographs. For 
example, we wanted to remove the people from the following 
image: 
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The print has been cracked and stained. By using the Healing Brush 
Tool, we can restore this image or correct the imperfections. 

The Healing Brush Tool (con't): Open restoration.psd. 

 

restoration.psd 

Select the Healing Brush Tool and examine the Options in the 
Options Bar. 

Brush Picker: You can build the Brush you’ll use to paint with using 
the Brush Picker. You can modify Diameter, Hardness, Spacing, 
Angle, Roundness, and Size (for work pressure sensitive tablets.) 
Experiment with each option to learn how they affect your Brush. 
Similar options are available when creating a custom Brush using 
the Brushes Palette (see “Creating a Custom Brush” on page 112.) 

Effect Mode: Select from a variety of Effect Modes. These function 
like the Blend Mode setting for Layers or the Painting Mode setting 
for the Brush Tool (see “Blend Modes” on page 86.) 

Source: To specify what the source of the Healing Brush Tool to will 
be select from either Sampled or Pattern. If you select Sampled, the 
source is the area at which you [ALT-{Click}] upon, just as with the 
Clone Stamp Tool. If you select Pattern, choose a Pattern from the 
drop-down menu. 

Aligned: Check Aligned to force the cross-hair established at the 
reference point to follow the Clone Stamp Tool regardless of how 
many times you {Click} and {Re-Click}. When Aligned is unchecked 
the cross-hair returns to original reference point after you have 
released the mouse button and {Click} again to resume. 

The Healing Brush Tool (con't): Thus far the options and use of 
the Healing Brush Tool do not differ much from the Clone Stamp 
Tool. However, recall that the Clone Stamp Tool merely duplicates 
the area you designate as the reference point so that if you 
reference a red area of an image and paint with the Clone Stamp 
Tool somewhere else in the image the painting will also be red. With 
the Healing Brush Tool this is not the case. The lighting, texture, 
and shading of the referenced area automatically matches (as best 
it can) the lighting, texture, and shading of the healed area. For 

example, 
rather than 

selecting 
Sampled for 

our 
reference 

point, lets 
select 

Pattern. 
Select the 

Bubbles 
preset 

Pattern. 

The Options menu for the Pattern drop-down will allow you to add 
to, delete, rename, and reset the Patterns available. 

Pattern Stamp Tool (con't): Many of the settings in the Options 
Bar for the Pattern Stamp Tool are similar to the Options for the 
Brush Tool and the Clone Stamp Tool. You’ll find many of the 
Tools share many of the same Options. 

 

The Pattern of the tree we created is added and 
made available in the Pattern drop-down menu. 

Painting with the Pattern Stamp Tool: Paint with the Pattern 
Stamp Tool as you do with the Brush Tool. You'll notice that the 
Pattern you just defined is painted and repeated (also called tiled.) 
Check the Impressionist checkbox to give the Pattern a painterly 
impressionist affect. 

 

A pattern is painted in a new Layer in blank.psd. 

The Healing Brush Tool  :The Healing Brush Tool is very 
similar to the Clone Stamp Tool. Just as with the Clone Stamp 
Tool, you select a reference point that you wish to duplicate within 
another area of the image and build a Brush Shape to replicate the 
reference point. The Healing Brush Tool differs from the Clone 
Stamp Tool in its purpose. You use the Healing Brush Tool to 
correct imperfections within an image. You may have to scan 
flawed source material, such as an old photograph, or modify the 
complexion of a person in a photograph. For example, examine 
this image: 
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The Healing Brush Tool (con't): As you paint, you may notice that 
the area appears to be darker or lighter. Once you {Release} the 
mouse button, Photoshop will adjust the replicated area to match 
the painted areas lighting, texture, and shading as best it can. 
Usually, it does a spectacular job. For the spots on the dress, you 
may have to reduce the Brush Diameter. 

 

Using the Healing Brush Tool, the stains/spots 
are removed from this area. 

The Healing Brush Tool (con't): Continue to use the Healing 
Brush Tool to remove the stains, spots, scratches, and so forth from 
the image. Often you have to use a combination of the Healing 
Brush Tool and the Clone Stamp Tool. Why the Clone Stamp Tool? 
Sometimes you may not want to preserve the lighting, texture, and 
shading of a particular area. Try making some corrections along the 
edge of the image (where the brown background reaches the white 
frame of the image) to see why you may need to use the Clone 
Stamp Tool as well. Don’t worry about correcting the white frame 
area of image, we’ll not be using that area of the image for the web 
site. When you’ve done, your image should look something like this: 

 

Using a combination of the Healing Brush Tool and the 
Clone Stamp Tool the stains, spots, and scratches are removed. The image is 

almost restored. 

The Bubbles Pattern is blue in color. With the Healing Brush Tool, 
paint on the restoration.psd image along the right side. As you 
paint, the Pattern appears to be painting, in its original Color over 
the brown Color of the image. However, when you {Release} the 
mouse button, Photoshop matches the lighting, texture, and 
shading of the painted area with the Pattern. 

The Healing Brush Tool (con't): Switch to the Pattern Stamp 
Tool and select the same Pattern. Paint beside the painting you 
just completed. Note the difference. With the Pattern Stamp Tool 
(and the Clone Stamp Tool) the referenced area is replicated 
(though the options you choose (Opacity, Flow Rate, Airbrush, 
Brush Shape, etc.) can change how it’s replicated and applied.) 
With the Healing Brush Tool, the referenced area is replicated but 
the lighting, texture, and shading of the painted area is preserved. 

The Healing Brush Tool (con't): Next let’s try to use the Healing 
Brush Tool with Sampled selected from the Source Option. First, 
restore restoration.psd back to its original state using the History 
Palette. Create a Brush with the following settings: 

 Diameter: 10 px 
 Hardness: 70 % 
 Spacing: 1% 
 Angle: O degrees 
 Roundness: 100 % 

Like the Clone Stamp Tool, you may have to select a reference 
point repeatedly and modify the size and shape of your Brush for 
the best results. Begin to reference clean areas of the background 
and paint over damaged areas. It will take some time, and you 
may need to zoom into the image. For example, we can start by 
removing the stains to the left of the woman’s shoulder. 

 

Sample (establish a reference point) the areas close to the 
stains and then paint over the stains. 
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4. The selection returns to the original area. Deselect. 

The Patch Tool (con't): Alternately, you could have selected 
Destination from the Options Bar. In this case, you select the area 
you wish to replicate first and then drag the replicated Selection 
over the area you wish to patch. 

Note 
You can use the standard Selection 
Tools first, to make a Selection for 
your patch and then use the Patch 
Tool. The Patch Tool will inherit the 
Selection you’ve already made and 
use it as the basis with which to make 
the patch. 

 

Using a Pattern with the Patch Tool: To use a Pattern with the 
Patch Tool, make a Selection first. The Pattern Option is now 
available. Select your Pattern and press the Pattern button to 
apply it. For example, we’ve used the Magnetic Lasso Tool to 
create a Selection around the woman. Then we inversed the 
Selection (Select/Inverse from the Menu), selected the Patch 
Tool. selected the Bubbles Pattern and applied it to our selected 
patch area by pressing the Pattern button. The result: 

 

Open restoration.psd again (or use the History Palette to restore 
it to its original state.) Experiment with the Patch Tool. 

To view the image above, open bubbles.psd. 

 

restoration.psd 
bubbles.psd 

 
 

The Healing Brush Tool (con't): Save your image if you like. Do not 
save over restoration.psd as you will need this image for the next 
Tool we cover, the Patch Tool. If you like, open 
restorationStepA.psd to view the changes we’ve made thus far. 
Compare it to your own to see if you missed some spots or if we’ve 
missed some spots. 

 

restorationStepA.psd 

The Patch Tool 

 
The Patch Tool is similar to the Healing Brush Tool but the method 
one uses to patch or correct particular areas of an image differs. To 
use the Patch Tool: 

1. Select either Source or Destination from the Options Bar. 
 

 
2. If you’ve selected Source, use the Patch Tool to draw a 

Selection around the area you wish to correct, such as one 
of the stains in the restoration.psd image. 
 

 

The Patch Tool (con't) 

3. Next, with the Patch Tool still selected, place it within the 
Selection you’ve just made and drag the Selection to the 
area you wish to duplicate. {Release} the mouse button. 
The area you dragged the Selection to is replicated over 
the area your originally selected, with lighting, texture, and 
shading preserved. 
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History Brush Tool (con't)   
Select Filter/Brush Strokes/Crosshatch. 

 

Use the following settings - Stroke Length: 25 / Sharpness: 20 / 
Strength: 1. {Click} OK. The filter is applied, changing the image to a 
distorted sketch. 

History Brush Tool (con't)  : Examine the History Palette. 
You'll notice that both the Watercolor and Crosshatch filters are 
listed as History States. To remove the Crosshatch effect on the one 
of the toys select the History Brush Tool, select a Brush Diameter, 
and select 100% Opacity. {Click} the Toggle Box in the Watercolor 
State. A History Brush icon appears. This indicates that you will 
painting with the contents of this particular History State. As you 
paint over the toy of your choice that toy will appear as it did in the 
Watercolor State, before you applied the Crosshatch Filter. 

 

The History Brush Icon beside the Watercolor History State indicates that as 
you paint, you’ll be restoring the appearance of the image from that particular 

State. 

The Art History Brush Tool 

 
The Art History Brush Tool operates like the History Brush Tool with 

History Brush Tool  : The History Brush Tool operates like 
the Brush Tool except that rather than selecting a Color to paint 
with, you select a History State to restore as you paint. To illustrate 
how the History Brush Tool works we're going to apply two filters 
to an image (filters are covered later) and then use the History 
Brush Tool to restore particular areas of the image to previous 
States. 

Open toys.psd. 

 

toys.psd 

 

toys.psd: A collection of wooden dolls 

History Brush Tool (con't)   
From the Menu, select Filter/Artistic/Watercolor. 

 

Use the following settings - Brush Detail: 14 / Shadow Intensity: 0 / 
Texture: 3. {Click} OK. 
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additional brush or paint effects. Like the History Brush, the Art History Brush samples data from a History State of your choice. 

Art History Brush Options: You can produce 
various natural media effects by changing the 
Painting Mode, Opacity, Painting Style, Painting 
Area, and Painting Tolerance settings in the Options 
Bar. The Art History Brush Tool takes some getting 
used to and practice. Experiment with different 
settings to learn how they affect your image. 

Art History Brush Options (con't) 

Painting Style: 
Select from a number of different options to define the shape of your brush strokes. 

Area: 
Area determines how much of the image is covered by your paint strokes and how frequently the stroke effects are applied. Larger numbers 
increase both the area and the frequency. 

Tolerance; 
Tolerance determines the limitations of your strokes based on color variations. Increasing the value limits your strokes to area of similar color. 
Decreasing the value broadens the range of color your strokes affect. 

The Eraser Tool   
The Eraser Tool works similarly to Photoshop's other painting Tools except rather than add color you remove image data. Like the other 
painting Tools, you select the Brush Diameter and other settings from the Options Bar. In addition, you can select Erase to History to make the 
Eraser Tool operate like the History Brush Tool. 

Eraser Tool Options/: Options for the Eraser Tool are 
similar to the Options for the Brush Tool. Additional 
Options include Erasing Mode and Erase to History. 

Eraser Tool Options (con't) 

Erasing Mode: Select from Brush, Pencil, or Block to determine how the Eraser Tool behaves. Block produces a square block. 

Erase to History: Toggle a History State or Snapshot in the History Palette and check the Erase to History checkbox if you want to erase to 
an earlier incarnation of your current image. This functions in the same manner as the History Brush Tool. 
This is very similar to the image we worked on previously. Recall that we removed the Priest in the green 
robe by using a Layer Mask. Using a Layer Mask is a non-destructive approach, using the Eraser Tool to 
accomplish the same goal is a destructive method. The Layer Mask hid or masked the Priest from view 
whereas erasing the Priest with the Eraser Tool will actually remove the image data. Expand the Priest Set 
Layer Set and select the priests Layer. Use the Eraser Tool (in combination with the Zoom Tool and any 
other Tools you’ve learned to use, such as the Selection Tools) to remove the Priest in the green robe 
from the Layer. Once image data is erased, and you have saved the edited image, you will not be able to 
recover it. This is a perfectly valid method and one you will employ frequently in a number of different 
situations. Sometimes you will want to use a Layer Mask for maximum flexibility. Keep the differences in mind. 

The Background Eraser Tool 
 
The Background Eraser Tool intelligently erases areas of an image to transparency, most particularly 
areas of continuous or similar Color. By {Clicking} and dragging close to an edge the Background Eraser 
Tool will erase the background but not the edge. You can use the Background Eraser Tool to remove the 
background from around an object, such as a person, rather than making a Selection around the person. 

Background Eraser Tool Options 
Options include Brush Preset Picker, 
Limits (Discontiguous, Contiguous, Find 
Edges), Tolerance, Protect Foreground 

 

The Art History Brush Tool has some unique options. 

Open gate.psd. 

 

gate.psd 
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Color, and Sampling (Continuous, Once, Background Swatch). 

Background Eraser Tool Options (con't) 

Brush Preset Picker: You can build the Brush you’ll use to paint with using the Brush Picker. You can modify Diameter, Hardness, Spacing, 
Angle, Roundness, and Size (for work pressure sensitive tablets.) Experiment with each option to learn how they affect your Brush. Similar 
options are available when creating a custom Brush using the Brushes Palette. 

Limits: Select Discontiguous to erase the sampled Color wherever it occurs beneath the Brush. The strictness of this setting is affected by the 
Tolerance value you set. Select Contiguous to erase the sampled Color and surrounding Color in a similar range. The strictness of this setting 
is affected by the Tolerance value you set. Contiguous is the default value. Select Find Edges to erase areas of the same Color as well as 
maintaining a sharper definition for the edge. These settings are similar to some of the Selection settings we examined earlier. To set a base 
sample Color, [ALT-{Click}] over the Color you wish to sample with the Background Eraser Tool. If you do not set a sampled Color yourself, 
the first Color you {Click} on while using the Background Eraser Tool becomes the sampled Color. The way the sampled Color behaves is 
affected by what you select for the Sampling Option. 

Background Eraser Tool Options (con't) 

Tolerance: Tolerance affects the range of Colors erased based on the sampled Color. A low value restricts erasure to Colors similar to the 
sampled Color. Higher values increase the range of Colors that can be erased. 

Protect Foreground Color: Check Protect Foreground Color to prevent the eraser from erasing colors that match the current Foreground 
Color. This option is unchecked by default. 

Sampling: Select Continuous to sample as you drag. Contiguous is the default value. 
Select Once to sample and erase areas containing the initial sample color. 
Select Background Swatch to erase areas containing the current Background Color. 
The strictness of this setting is affected by the Tolerance value you set. Use the applicable settings in the Options Bar as required. Usually the 
default values are fine, though you’ll need to set Tolerance as needed. 

The Background Eraser Tool: Open eraseBackground.psd. 

We’ve cropped our restoration.psd image to isolate the face of the woman. We need to 
remove the background. Let’s do so by using the Background Eraser Tool. Select the 
following Options: 

1. For the Brush: Diameter = 20px; Hardness = 80%; Spacing = 1%; Angle = 0 degree; 
Roundness = 100% 

2. Limits: Contiguous 
3. Tolerance: 20% 
4. Protect Foreground Color: Unchecked 
5. Sampling: Continuous 

The Background Eraser Tool: Start by brushing just outside the hair. Don’t worry if your Brush 
Shape overlaps the hair a little because the Background Eraser Tool should leave it alone. You may 
want to increase magnification for accuracy. You may also want to brush or paint small bits of the 
background at a time. You should see the hair remain in place and the background color turn to 
transparency. 

The Background Eraser Tool: Continue to remove the background immediately around the woman 
using the Background Eraser Tool. You will have to reduce the Brush Diameter to something like 5px 
for the neck area (and even smaller for the earnings.) Around the neck area you may also need to 
reduce the Tolerance (if you don’t have a steady hand). Note how the background and the flesh color 
at the neck are very similar, which could confuse the Background Eraser Tool. 

Don’t bother using the Background Eraser Tool to remove the remainder of the background as you can remove it quickly by using the Magic 
Wand Tool to select the remaining image data and pressing the [DELETE] key to remove it. Don’t worry if you see a little bit of the background 
here and there in patches throughout the image, we’ll look at a method of finding and removing them later in the chapter. Save your image for 
use later (or you can use the image we’ve saved called backgroundErased.psd. Your image should look this: 

 

eraseBackground.psd 

 

 

The Background Eraser Tool removes the 
background 

image data around the hair with ease. 
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The Magic Eraser Tool:  The Magic Eraser Tool erases entire areas of color with a single {Click} 
rather than {Clicking}, holding, and dragging, which we have to do if we’re using the Eraser Tool or 
the Background Eraser Tool. It operates in a similar manner to the Magic Wand Tool, except that 
rather than making Selections, it erases pixels. 

Magic Eraser Tool 
Options: You can set 
Tolerance, Anti-
aliased, Contiguous, Use All Layers, and Opacity as required. 

Magic Eraser Tool Options (con't) 

Tolerance: Tolerance affects the range of Colors removed based upon the Color you {Click} on in 
the image. A low value restricts erasure to a small range of similar Colors. Higher values increase 
the range of Colors. 

Anti-Aliased: Check Anti-aliased to ensure that the edges of the areas that remain after erasure are smooth. 

Contiguous: Check Contiguous to erase colors that are uninterrupted by colors outside the range established by the Tolerance level. 
Uncheck Tolerance to erase all the colors within the entire image established by the Tolerance level. 

Use All Layers: When checked, Use All Layers permits the Magic Eraser Tool to erase a range of colors within all the Layers of the image. 

Opacity: If Opacity is set to anything below 100%, the Magic Eraser Tool will not erase the color but merely change the Opacity of the color. 

Magic Eraser Tool: Open eraseBackground.psd. 

 

eraseBackground.psd 

Remove the background from the image again. Experiment with the Magic Eraser Tool. Note how some of the woman’s face may be erased 
when you {Click} in the area close to her left shoulder. Change the Tolerance level or, as is common when working with Photoshop, use a 
combination of Tools to achiever your goal. 

The Gradient Tool   
The Gradient Tool is used to create gradient colors and patterns. Gradients are gradual shifts from at least one color to another or one color to 
transparency. The effect is similar to the way the sky shifts from dark blue to a lighter blue as you look toward the horizon. Gradients can also 
consist of multiple colors, much like a rainbow. 

Gradient Tool Options: Options include Gradient 
Picker/Editor, Gradient Type, Blend Mode, Opacity, 
Reverse, Dither, and Transparency. A preview of the 
gradient appears in the Gradient Picker bar. 

Gradient Picker/Editor: To select a preset Gradient, 
{Click} on the drop down arrow. All available Gradients are displayed. Select the Gradient you desire by {Clicking} on the Gradient Swatch. A 
description of the Gradient appears when you hover your mouse pointer over a Gradient 
Swatch. 

Note that the first two (2) Gradient Swatches (top row) are Foreground to Background and 
Foreground to Transparent. The Color of each will change according to your currently 
selected Foreground and Background Colors. 

Open blank.psd. 
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blank.psd 

Select various Gradients and try them out to see how they appear. Try to vary the length and angle of each Gradient. 

Creating Custom Gradients 
To create your own Gradient, {Click} on the Gradient Picker/Editor itself. The Gradient Editor appears. 

 

To create a new Gradient, select an existing Gradient Preset and modify it. 

Creating Custom Gradients (con't) 
To change a color select one of the Color Stops 
situated at the bottom of the Gradient Bar and 
{Double-Click} on it. Select a color from the 
Color Picker. 

To add additional Color Stops to the Gradient {Click} on an empty spot beneath the Gradient Bar. To modify the location of Gradient colors 
drag the Color Stops and Midpoint Markers back and forth as you desire or input specific values into the fields in the Stop Settings Area. To 
delete a color simply select it's Color Stop and hit the [DEL] key or drag up or down on it and it will disappear. 

To add Transparency {Click} and adjust the Stops at the top of the Gradient Bar (which displays Alpha information rather than colors) and 
adjust the Opacity Slider at the bottom of the dialog box. {Clicking} and dragging the Stops and Midpoint Markers effects the placement of 
Transparency. 

 

Note 
To make a Color Stop dynamic, meaning it will pick up whatever your 
current Foreground or Background Color is, select the Color Stop and then 
select either Foreground or Background from the Color field in the Stop 
Settings Area. 
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Opacity: Set the overall Opacity of the Gradient. 

Reverse: Check Reverse to reverse the Gradient. 

Dither: Check Dither to make the transition from one color to the 
next as smooth as possible. 

Transparency: Check Transparency to enable any transparency 
settings in the Gradient patterns. Uncheck to disable 
Transparency. Experiment with the Gradient Tool. Load other 
Gradient Presets and see how they function. Try using a black 
and white Gradient in a Layer Mask. 

The Paint Bucket Tool 

 
The Paint Bucket Tool replaces a color or range of colors with 
either the current Foreground Color or a Pattern. It also fills 
transparent areas and Selections. Simply select a Color and 
{Click} in the area you wish to fill or replace. You may have to set 
some options to get the desired effect. 

Paint Bucket Tool Options: Options for the Paint Bucket Tool 
include Fill Source, Pattern, Fill Mode, Opacity, Tolerance, Anti-
aliased, Contiguous, and All Layers. 

 

Paint Bucket Tool Options (con't) 

Fill Source: Select either Foreground to fill with the current 
Foreground Color or Pattern to fill with a Pattern. 

Pattern: If you have selected Pattern from Fill Source you can 
select your fill Pattern here. 

Fill Mode: This is identical to Blend Mode when using Layers. 

Opacity: Set the Opacity of the fill. 

Paint Bucket Tool Options (con't) 

Tolerance: When you{Click} on a pixel that is any particular color 
(such as red for example) and you are replacing that color with 
the current Foreground Color that might be yellow for example, 
any pixels in the surrounding area that are also red or a similar 
shade of the red pixel you have {Clicked} on will be filled (or not) 
depending on the Tolerance level you set. Higher numbers will fill 
a greater range of colors while lower numbers will limit the range. 
This is similar to the Tolerance setting for the Magic Wand Tool. 

Anti-aliased: Check Anti-aliased to make the edge of the fill 
smooth. 

Creating Custom Gradients (con't) 
Adjust the Smoothness Slider to increase or decrease the 
smoothness of your Gradient. You can also choose a Gradient Type 
from the Gradient Type drop-down Menu. Solid is the default while 
Noise creates a Gradient that randomly mixes the color across a 
selected range. Adjust the various Sliders in the dialog box to find a 
noisy Gradient that suits your needs. 

If you wish you can use percentage figures to precisely position the 
Stops and the Midpoint Markers by adjusting the location fields in the 
Stop Settings Area. When you have finished creating your custom 
Gradient, give in an appropriate name and {Click} the New button. 
Your custom Gradient is added to the Gradient Presets. 

 

Note 
If you wish to use it again you 
should save the new set of 
Gradient Presets. {Click} Save. 
You will save a.grd file. Give it 
an appropriate name. By 
default, it is saved in the 
location you installed 
Photoshop in under 
Presets/Gradients. To load a 
Gradient set, {Click} Load in 
the Gradient Editor dialog box. 

{Click} OK to finish. Try out your custom Gradient. 

Gradient Type: Select from Linear, Radial, Angle, Reflected, and 
Diamond. 

Linear Gradient 
Linear (straight line) transition from one point to 
another. Can contain multiple colors and 
transparency levels. Can be placed at various 
angles. 

 

Radial Gradient 
A circular transition from one point to another from 
one point to another. Can contain multiple colors 
and transparency levels.  
Angle Gradient 
A counter-clockwise transition from one point to 
another. Can contain multiple colors and 
transparency levels. Can be placed at various 
angles. 

 

Reflected Gradient 
Linear gradients are created from the starting 
point. Each gradient moves away from the starting 
point.  
Diamond Gradient 
A diamond shaped transition from one point to 
another. Can contain multiple colors and 
transparency levels. Can be placed at various 
angles. 

 

Blend Mode: Set the Blend Mode for the Gradient. This is similar to 
the same setting for Layers or the Painting Mode setting for the 
Brush Tool. 
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Brush Preset Picker: Select a Brush with which to blur with.  

Effect Mode: Select from a number of different options which will 
affect the color over which you apply the blur strokes. This is similar 
to the Blend Mode used for Layers. 

Strength: Set the Strength of your stroke. A higher value will 
increase the degree of blurriness. 

Use All Layers: Check Use All Layers to blur the image data you 
paint over throughout all Layers. Try using the Blur Tool on an 
element of the toys image to see the effects. 

The Sharpen Tool 

 
Use the Sharpen Tool to sharpen soft edges in an image. The 
Sharpen Tool functions similarly to the Blur Tool except of course it 
sharpens rather than blurs. The Sharpen Tool increases the 
contrast in colors over the area you stroke. If you’re not careful, 
color banding or a halo can occur. You’ll have to experiment with it 
and try out different Effect Modes. The Options for the Sharpen Tool 
are identical to those of the Blur Tool. The Blur Tool and the 
Sharpen Tool are referred to as the Focus Tools. 

Try using the Sharpen Tool on any of the images in this chapter to 
see how it works. 

The Smudge Tool :  
Use the Smudge Tool to create a finger painting effect within your 
image. The Smudge Tool functions like many of the Brush related 
Tools in that you select a Brush, some options, and paint over areas 
of an image. Smudge Tool Options: The Smudge Tool Options are 
identical to the Blur Tool Options with one addition. In addition, the 
Smudge Tool has a Finger Painting Option. 

 

Finger Painting: Check Finger Painting to mix the current 
Foreground Color into the smudge as you paint. 

The Dodge Tool  
Use the Dodge Tool to lighten areas of the image by painting over 
them. The Dodge Tool works similarly to the other Brush Tools. 
Grouped together with the Burn Tool, these Tools are referred to as 
the Toning Tools. Dodge Tool Options: Select a Brush Shape from 
the Brush Preset Picker Select the Range, Exposure, and if you like, 
you can 
enable 
the 
Airbrush 
capabilities. 

Contiguous: Check to fill pixels in the immediate color range 
(affected by your Tolerance level) of the pixel you have {Clicked} 
on. Uncheck to fill all the colors in the image within the color range 
you’ve selected All Layers: Check All Layers to fill colors across 
all Layers. 

Paint Bucket Tool 
Open backgroundErased.psd. 

 

backgroundErased.psd 

Recall earlier in the chapter we used the Background Eraser Tool 
in combination with the Eraser Tool to remove the background 
around the woman. When we remove a background from an 
image with only one (1) Layer, the background is erased to 
Transparency. Sometimes its difficult to see if you’ve removed all 
of the background. We’re going to use the Paint Bucket Tool to 
add a new background color and make sure we’ve removed all of 
the original background at the same time. Execute the following 
steps: 

1. Create a new Layer. Recall that by default, when you 
create a new Layer, its created above the currently 
selected Layer. Drag the new Layer beneath the current 
Layer (the one with the woman on it) and rename it 
background. 

2. Name the Layer with the woman on it customer. 
3. Choose the following Foreground Color with the Color 

Picker: Red - 222; Green - 0; Blue - 0. 
4. Select the Paint Bucket Tool. 

Paint Bucket Tool 

5. Select the background Layer. 
6. Fill the background Layer with the Foreground Color. 
7. Take a look at the image. You should notice some 

artifacts or left over elements of the original background 
we removed earlier. Furthermore, there are areas 
around the hair that need to be erased as well. 

8. Use the Eraser Tool and the Background Eraser Tool to 
remove the last bits of the original background. You’ll 
probably have to switch between one and the other Tool 
frequently, as well as zooming in and out of the image, 
and using very soft-edged brushes as you erase, 
particularly around the hair. It will take some time. 

9. Save the image if you like. 

The Blur Tool   
Use the Blur Tool to blur areas of the image by painting over them. 
The Blur Tool behaves very much like the Brush Tool, except 
rather than paint color you paint blurriness  

Blur Tool Options: Blur Tool Options include Brush Preset 
Picker, Effect Mode, Strength, and Use All Layers. 
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The Horizontal Type Tool  
Use the Horizontal Type Tool (or the other Type related Tools) to 
create text in Photoshop. For the Internet you'll be using type to 
label buttons and as elements of typographic design. Select the 
Horizontal Text Tool and {Click} in the Image Window. Begin to 
input your text. To make a paragraph, {Click}, hold, and drag a 
Paragraph Box in the Image Window then input your text into the 
Paragraph Box. Photoshop creates a new Text Layer (indicated in 
the Layers Palette by a capital "T" in the Layer Thumbnail. The text 
you input into a Type Layer appears as the Layer Name. 

 

Typographic Terminology 
Before you begin to create and manipulate type in Photoshop, you 
should know some of the basic typographic terminology that some 
of the options in Photoshop use. Examine the following example: 

 

Typeface: A typeface is a full set of characters (uppercase, 
lowercase, numerals, special characters, etc.) designed in a specific 
Style. For example, the same word, presented using different 
typefaces, can look quite different: 

 
Typefaces are also often referred to as Fonts. The look of your text 
is very much a key in the design of your images. 
 
Kerning: Kerning is the space between a particular pair of 
characters. Each typeface may have particular Kerning values so 
that some characters are closer to each other than others, 
depending on their shape. For example, the capital letters A and V, 
when placed together, have complimentary shapes and are often 
placed closer together than A and N.  
 
Tracking: Tracking is the space between characters in a line of text. 
The space between characters, regardless of the particular 
characters, is uniform when using Tracking. It can easily be 
confused with Kerning. Remember that Kerning is a very specific 
measurement of spacing between particular pairs of characters, 
whereas Tracking is the measurement of spacing between all 
characters. 
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Baseline: The Baseline in text is an imaginary line that the characters effectively sit upon. Lower case text, such as the "p", has a descender, 
which descends below the Baseline. 

Horizontal Type Tool Options 
In Photoshop you set and adjust Font Family, Font Style, Font Size, Justification, and so forth by selecting options from either the Options Bar 
or the Character Palette. Let’s examine the Horizontal Type Tool Options. 

Font Family: Select the Font Family (also referred to as Typeface or Font) 
you wish to use for your text. Photoshop will list all the currently active fonts 
on your system. 

Font Style: Select the Font Style you wish to use. Common Font Styles 
include Bold, Italic, Underline, and Regular. Available Font Styles differ 
depending on the Font Family you've selected. However, the Character 
Palette has options for apply Font Styles that are normally unavailable to a 
particular Font Family. 

Font Size: Select or input Font Size to set the size of your text. The Font 
Size is measured in points, which is the traditional measurement for print and within common computer applications such as word processors. 
When we get to ImageReady, we can use Font Sizes in pixels, which may be more useful, depending on how you like to work, for web 
development. If you highlight your text by {Clicking} and dragging over it, any changes you make to the Font Size changes the size of the font. 
Alternately you can select the Type Layer itself in the Layers Palette, select the Horizontal Text Tool and then make changes to the text 
without highlighting but modifying the options. 

Anti-Alias: You can select various levels of Anti-aliased text. Choices consist of None, Sharp, 
Crisp, Strong, and Smooth. You'll find that Sharp and Crisp are particularly useful for small 
text. 

Alignment: Select from Left Align, Center, and Right Align to set the Alignment of your text. 
The Alignment of your text, even if it is a single word or line of text, can affect how multiple 
Type Layers are aligned. You should experiment with Alignment to see how it operates in 
Photoshop. 

Font Color: Select a Font Color by {Clicking} on the Font Color Swatch. The Color Picker 
appears. 

Warp Text: Warp Text allows the user to customize the appearance of text and still maintain 
the ability to edit it at all times. With a Type Layer selected or text itself selected, {Click} on the 
Warp Text button. The Warp Text dialog box appears. Select a Warp Style from the Style drop-down menu. 

Warp Text (con't): The Warp Style effectively places an shape or envelope around your type. For example, 
in this image, the text "warped text" appears without a Warp Style and is repeated with the Fish Warp Style 
applied to it. Once you’ve applied a Warp Style, you can modify it by changing the options in the Text Warp 
dialog box. Modify orientation along the Horizontal or Vertical axis and change Bend, Horizontal Distortion, and Vertical Distortion values. 
You’ll have to experiment with each Warp Style to learn how each 
affects your type. 

Toggle Character Palette: {Clicking} the Toggle Character Palette 
button launches the Character Palette, which is grouped with the 
Paragraph Palette. Each of these Palettes gives you identical 
settings to those found in the Options Bar as well as some additional 
options. 

Kerning: To modify the Kerning between two specific characters 
(letters), place your cursor between the two characters, do not 
highlight any characters. The Kerning field will become active. 
Select Metrics to set automatic Kerning. You can input your own 
value or select one of the presets. Negative values move characters 
closer together. Positive values move characters further apart. 
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Leading: Leading is the amount of space between lines of text. If you’ve written papers or produced any sort of documents you may set the 
spacing to double-spaced then you’ll understand Leading. If you have input text with multiple lines you can set the Leading as you wish. 

Tracking: To modify the Tracking, highlight the text you wish to modify. Select Auto to set automatic Tracking. You can input your own value 
or select one of the presets. Negative values move 
characters closer together. Positive values move characters 
further apart. 

The Paragraph Palette 

The Paragraph Palette features enhanced options to control 
text you’ve input that is more than one line (such as a 
paragraph or caption.) 

Alignment: 
Select from Left Align, Center, and Right Align to set the 
Alignment of your text. 

Justification: Select from Justify Last Left, Justify Last 
Center, Justify Last Right, and Justify All. 

Indent Left Margin: You can set where the Left Margin is within the Paragraph Box by inputting a value in this field. 

Indent Right Margin: You can set where the Right Margin is within the Paragraph Box by inputting a value in this field. 

Indent First Line: If you want the first line of your paragraph to be indented, set the value here. 

Add Space Before Paragraph: If you have multiple paragraphs, you may want to add some space just above the area where the paragraph 
begins. To do so, input a value in this field. 

Add Space After Paragraph: If you have multiple paragraphs, you may want to add some space just below the area where the paragraph 
begins. To do so, input a value in this field. 

Hyphenate: Check Hyphenate to enable hyphenation. 

The Vertical Type Tool 

 
Use the Vertical Type Tool to input text in a vertical orientation. 

The Notes Tool  
As you produce images, you may be working in a collaborative environment or you may be working 
alone. In either case, it can be very helpful to leave notes attached directly to an image so that 
whenever you edit that image, you can familiarize yourself with any tasks or issues you may have. To 
create a note, select the Notes Tool and {Click} anywhere within the Image Window. A pop-up Notes 
Box appears. Input your note. 

The Notes Tool (con't) 
Close the Note by {Clicking} the Close Box at the top right of the Note. A small Note icon remains in 
the Image Window. To open it, {Double-Click} it. To remove it, {Right-Click} and select Delete Note. 
You may find that keeping Notes in this manner is more efficient than keeping paper notes that can 
be easily misplaced. 
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Audio Annotation Tool 
 
If you have a microphone, you can attach a sound clip rather than a typed Note using the 
Audio Annotation Tool. 

The Eyedropper Tool   
As you edit and produce images, you may want or need to match colors precisely. Of course photographic images can often consist of millions 
of colors. Picking one color from millions is simple with the Eyedropper Tool. Simply select the Eyedropper Tool and {Click} on the color you 
wish to sample in the Image Window. The Foreground Color changes to the color you’ve sampled. Hold or press [ALT] to change the 
Background Color rather than the Foreground Color. 

Eyedropper Tool Options 
By default, the Sample Point is set to Point Sample to sample the color of a single 
pixel. You can also select a wider range. The average value within the range is 
sampled. Select from 3 by 3 Average or 5 by 5 Average. 

Using Guides and the Grid for Alignment 
Often you will want elements within your image positioned relative to each other. To align elements, such as a series of buttons or type you 
have two options, using Guides or using the Grid. 

Using Guides 
To create Guides you must make the Rulers visible. Select View/Rulers. The units of the Rulers depend on the setting you selected in 
File/Preferences/Units & Rulers. Because you're developing for the Internet, it's a good idea to select Pixels as the basic unit. Make a Guide 
by passing the pointer over either the horizontal or vertical Ruler and {Click}, hold, and drag the Guide over the image. {Release} to drop the 
Guide at the desired point. By default, the Guide is blue in color. Change the color by selecting Edit/Preferences/Guides, Grid and Slices or 
{Double-Click} the Guide itself. Make sure Snap to Guides is enabled by selecting View/Snap To/Guides. 

Using Guides (con't) 
Open toys.psd. 

Create a Vertical Guide at approximately 50 pixels from the left of the 
image. Create two (2) Type Layers, one with the text "Japanese 
Souvenirs" and one with the text "Children's Toys." Select the "Japanese 
Souvenirs" Type Layer and drag it toward the Guide. Notice how the 
edge the letter "J" snaps against the Guide. Guides ignore the 
transparent areas of a Layer and use image data to snap too. Select the 
"Children's Toys" Type Layer and drag it toward the Guide, just below 
"Japanese Souvenirs". Now both Type Layers are perfectly aligned. 

Using Guides (con't) 
To discard a Guide {Click} and drag the Guide off the image into the Ruler. To move a Guide hold the [CTRL] key over the Guide and drag 
whenever you are using a tool other than the Move Tool. Holding [CTRL] and [ALT] simultaneously switches the orientation of the Guide. You 
can use multiple Guides. To discard all Guides select View/Clear Guides. 

Using the Grid: The Grid works in a similar fashion to Guides in that the content of your Layers will snap to the lines of the Grid. Select 
View/Show/Grid to display the Grid. Make sure that Snap to Grid is also enabled under View/Snap To/Grid. A light gray Grid covers the image. 
To adjust the Grid setting select Edit/Preferences/Guides, Grid and Slices. By now it should be evident to you that Photoshop is a very 
powerful and complex program that is easy to use. Because there are numerous image editing options and many different ways to achieve 
imaging goals first time users might find the program overwhelming. We've reviewed many of the fundamental elements you'll need to put into 
practice when creating images for the Internet. We're going to use many of these techniques in the chapters ahead to create actual images for 
the web, including static images, buttons, navigation bars, banners, and animated GIFs. 

Filters: Filters are a set of pre-built effects that you apply to entire images, individual Layers, or Selections. Images must be in RGB mode to 
access Photoshop’s full range of Filters. 

Applying Filters: To apply a Filter, isolate the area of the image you wish to apply it too. For instance, if you want to apply a Filter, such as 
Blur, to an entire Layer you would select the Layer in the Layers Palette. If you wanted to apply the Blur Filter to a part of the image data on a 
Layer, you would make a Selection on that Layer and apply the Filter. 

 

 

Tip 
To place a Guide at a precise point, select 
View/New Guide. The New Guide dialog-box 
appears. Select Orientation (Horizontal or 
Vertical) and input the Position you wish the 
Guide to be placed at in the Position field. 
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A photograph is transformed into a painting. 

Fine-Tuning Filters with Fade 
Once you've applied a Filter you can fine-tune it by selecting 
Edit/Fade Filter Name, where 
Filter Name is the name of the 
last Filter you applied. In this 
case we select Edit/Fade 
Poster Edges. 

Fade controls include 
Opacity, Mode (Blend Mode), and Preview. Input an Opacity value 
or use the slider to reduce the strength of the Filter’s effect on your 
image. Experiment with different Blend Modes to affect the manner 
in which the Filter is applied to the image. Check Preview to display 
your changes in real-time. {Click} OK to make the changes. 

Adjustment Filters: Filters are not limited to apply effects. There 
are a wide range of Filters available to you. As you learn and use 
Photoshop, you’ll become familiar with many of them. Learning and 
using Filters (also referred to as plug-ins) is largely a process of 
experimentation to view how particular Filters affect an image and 
what type of Options you can use for each of them. Let’s take a look 
at one of the Adjustment Filters. 

Open statue.psd. 

 

statue.psd 

Examine the image. It’s definitely blurry. Select 
Filter/Sharpen/Unsharp Mask. You can set the following Options: 
Amount, Radius, and Threshold. We’ve used the following settings: 

 Amount: 50% 
 Radius: 1.0 pixels 
 Threshold: 0 levels 

Use these settings are your own. Once you’ve applied the Filter the 
image should appear sharper. 

As we progress through the manual, we’ll be creating buttons, 
navigation bars, and GIF animations, and we’ll put some Filters to 
use. Recall that Layers have Layer Styles, which are essentially 
specialized Filters linked to Layers, though of course Layer Styles 
can be disabled whereas applying Filters is a destructive operation 
We'll be using these effects as well. Some of the Layer Styles can 

Open boy.psd. 

 

boy.psd 

Filters (con't) 
Select Filter/Artistic/Poster Edges. The Filter dialog box appears 
with the title of the currently selected Filter. A set of Options 
accompanies most Filters (not all Filters have Options). Options 
change depending on the nature of the Filter. 

 

In this case, the Options we have are Edge Thickness, Edge 
Intensity, and Posterization. Filters usually have a Preview 
Window in the dialog box so you can see the effects of the Filter 
on your image and the effects that changing the Options cause in 
real-time. Note that you can change the Magnification of the 
Preview Window but {Clicking} the positive (+) and negative (-) 
buttons accordingly. You can also move the image around with the 
Preview Window. In this case, make sure you have the following 
settings: 

 Edge Thickness: 2 
 Edge Intensity: 1 
 Posterization: 1 

{Click} OK. 

Filters (con't) 
Photoshop applies the Filter to your image and the History Palette 
creates a History State. You've effectively changed a photograph 
into a painting. 
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be applied to Type Layers, but to apply Filters to Type Layers you'll have to {Right-Click} the "T" icon in the Type Layer and select Rasterize 
Layer. Effectively you’ll be converting the type to a bitmap so that you won't be able to edit your type after rendering it. However, you’ll be to 
apply Filters to it. 

ADJUSTING IMAGES 
 
In addition to modifying or adjusting images with Selections, Filters, Layers, using Blend Modes, and using the various Tools, Photoshop also 
allows you to adjust a wide variety of color properties, such as tone, saturation, balance, and contrast. Controls for adjusting these image 
qualities are located under Image/Adjustments. Adjustment controls include Levels, Auto-Levels, Auto-Contrast, Auto-Color, Curves, Color 
Balance, Brightness/Contrast, Hue/Saturation, Desaturate, Replace Color, Selective Color, Channel Mixer, Gradient Map, Invert, Equalize, 
Threshold, Posterize, and Variations. Before using these controls however, you should examine the image's Histogram. 

Histogram 
The Histogram represents the pixels of an image in graph form. It charts how many pixels an image 
contains and their distribution in terms of dark tones to bright tones. Dark tones are charted to the left 
and bright to the right. Dark tone areas are referred to as Shadows. The area in between dark and 
bright tones is referred to as Midtones. Bright tone areas are referred to as Highlights. 

The image is clear, but the colors are dull. This image could use some adjustment. Start by 
examining the Histogram by selecting Image/Histogram. 

Histogram (con't) 

By examining the Histogram of an image, you can instantly see the Tonal balance of the 
image and use that information as a basis for your adjustments. For this image, most of 
the pixel information is concentrated left of the middle of the graph (the Midtones area.) 
As a result, we can see that the image is primarily dark in tone. The images Tonal range 
is unbalanced. We’ll make adjustments to create a better balance. 

Histogram (con't) 

Channel: Select from Luminosity, Red, Green, or Blue when working with RGB images. 
Luminosity is a composite of the Red, Green, and Blue Channels. 

Mean, Std Dev, Median, Pixels: The values listed in the left hand column of the 
Histogram display the average brightness value of the image (Mean), the range of 

variance from the mean (Std Dev), the middle brightness value (Median), and the number of pixels used to calculate these numbers. If you're 
viewing a Histogram for the entire image, all the pixels are used. If you're viewing a Histogram for a Selection, the numbers of pixels within the 
Selection are used. 

Level, Count, Percentile, Cache Level: {Click} and drag to highlight particular areas of the Histogram to get values for Level (the selected 
area's brightness level), Count (the number of pixels in the selected area), and Percentile (the percentage of pixels within the selected tonal 
range.) Cache Level is set in File/Preferences/Memory & Image Cache. If Use cache for histograms is checked, the Histogram is based on the 
Cache version of the image. For absolute accuracy uncheck Use cache for histograms to force Photoshop to use the real image data. This is 
less of a concern for web development because you're working on a low resolution (in terms of density as in 72 ppi) image, which matches the 
resolution of the Cache version. However, if you are working on higher density images the accuracy of the Histogram is affected. 

Histogram (con't) 

Channel: Select from Luminosity, Red, Green, or Blue when working with RGB images. Luminosity is a composite of the Red, Green, and 
Blue Channels. 

Mean, Std Dev, Median, Pixels: The values listed in the left hand column of the Histogram display the average brightness value of the image 
(Mean), the range of variance from the mean (Std Dev), the middle brightness value (Median), and the number of pixels used to calculate 
these numbers. If you're viewing a Histogram for the entire image, all the pixels are used. If you're viewing a Histogram for a Selection, the 
numbers of pixels within the Selection are used. 

Level, Count, Percentile, Cache Level: {Click} and drag to highlight particular areas of the Histogram to get values for Level (the selected 
area's brightness level), Count (the number of pixels in the selected area), and Percentile (the percentage of pixels within the selected tonal 

Open flower.psd. 

 

flower.psd 
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range.) Cache Level is set in File/Preferences/Memory & Image Cache. If Use cache for histograms is checked, the Histogram is based on the 
Cache version of the image. For absolute accuracy uncheck Use cache for histograms to force Photoshop to use the real image data. This is 
less of a concern for web development because you're working on a low resolution (in terms of density as in 72 ppi) image, which matches the 
resolution of the Cache version. However, if you are working on higher density images the accuracy of the Histogram is affected. 

Channel: Select from the composite RGB to modify all channels 
simultaneously or select Red, Green, or Blue and modify channels on an 
individual basis. Input Levels/Input Levels Sliders. Input Levels display the 
range from the Black Point (Shadows) to the White Point, and the Mid Point 
in between. By default, the range is 256 possible values, from 0 to 255 with 
the Mid Point being precisely in between. By adjusting these Levels, you 
can increase or decrease each of the three primary tonal properties, 
Shadows, Midtones, and Highlights. The Histogram for this image reveals 
that very few pixels are actually in the Midtones and fewer still in Highlights. 
Use the Sliders or input the following values into Input Levels: 

 Shadows: 7 
 Midtones: 1.00 
 Highlights: 108 

Channel (con't): Make sure that Preview is checked. {Click} OK. The image 
should look much brighter. Keep in mind that you can make adjustments by Channel. You could adjust each individual Channel or start by 
adjusting all of them at once (RGB) and then isolate each channel to make finer adjustments. It takes some time to get used to adjusting 
images in this manner. 

Output Levels/Output Levels Sliders: Reduce the tonal range (at default 0 to 255) by adjusting the Output Levels either by input or using the 
sliders. 

Levels Eyedropper Tools 
Use the Shadows (Black Point), Midtones (Gray Point), and Highlights (White Point) Eyedroppers to designate pure black, pure medium, and 
pure white manually by selecting the appropriate Eyedropper and {Clicking} on a point within the image. Select Image/Adjustments/Levels 
again. Note how the Levels Histogram has changed to reflect the changes we’ve already made. If you select the Midtones Eyedropper and 
{Click} on the red part of the flower the Histogram changes to reflect your selection and the color of the image changes drastically as well. In 
this case, the image is dominated by blue and green tones. The Eyedroppers are generally more useful when changing the tone of grayscale 
images. 

Channel (con't) 

Auto: {Click} this button to let Photoshop adjust the Levels for you automatically. 

Options: {Click} Options to fine tune the manner in which Photoshop automatically balances Levels if you choose to have Photoshop do the 
adjustment for you. 

Preview: Check Preview to see the affect of your modifications in real-time. 

Auto Levels: Selecting Image/Adjustments/Auto Levels causes Photoshop to automatically balance the tonal range of the image. Depending 
on the image, this feature can work well or not work particularly well. Restore flower.psd back to its original state and try it out. 

Auto Contrast: Select Image/Adjustments/Auto Contrast to automatically increase the contrast of colors in an image. Colors increase in 
saturation and edges sharpen. 

Auto Color: Select Image/Adjustments/Auto Color to automatically balance the colors within an image. 

Curves: Use Curves for greater control when adjusting image tone. Curves are very similar to Levels in that you adjust the Shadows (Black 
Point), Midtones (Medium Point), and Highlights (White Point), except you do so with a curve to which you can add points too for increased 
accuracy. You manipulate the Curve by {Clicking} and dragging on a point. You add points to the Curve by {Clicking} and dragging on the 
Curve where there isn't a point or by {Clicking} on the Curve where there isn't a point. Controls for Curves include Channel, Input and Output 
Fields (visible when you have a Point selected, Edit Curve Button, Custom Curve Button, Black Point, Mid Point, and White Point 
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Eyedroppers, Auto, Smooth, options to Save and Load Curve settings, the Curve Window and the Curve itself. The controls common to the 
Levels adjustment work precisely the same in Curves. 

Curves (con't) 
The Curve is in a straight line, at 45 degrees, indicating it has not yet been manipulated. The Point at the bottom left of the Curve represents 
the current Black Point while the point at the top right represents the White Point. There is no point in the middle of the Curve by default 
because you can add points all along the Curve and {Click} and drag them for 
very accurate and precise control. However, by {Clicking} the center of the Curve 
you can add a Midtone Point. 

{Click} the center of the Curve to add a Midtone Point. Next {Click}, hold, and 
drag the Midtone Point up and down the Curve, trying to keep the Curve as 
straight as possible. By doing this you are mirroring Levels controls where you 
{Click} and drag the Point sliders back and forth. The distance between the 
sliders or Points changes the tone of the image. With Curves, you have 
increased control because you can add multiple points between the Black, Mid, 
and White Points. {Click} twice at different locations on the Curve between the 
Midtone Point and the Black Point to add two more points. Now {Click} and drag 
these points back and forth and watch what happens to the image. By {Clicking} 
and dragging the points to add variance to the Curve more drastic tonal changes 
occur. It takes practice to get used to using Curves to adjust tone but as you can 
see it is a much more powerful option than using Levels. At any time, with a Point 
selected, you can input values into the Input or Output fields. 

Curves (con't) 

Note 
To change the Grid in the Curves 
dialog box, press [ALT] and 
{Click} simultaneously. 

Curves (con't) 
In our case, we’ve applied the following Curve to flower.psd. To view our version, load 
flowerCurves.psd. 

flowerCurves.psd 

Keep flowerCurves.psd open and feel free to try the following procedures on your own version as well. 

Custom Curve Button: In addition to using the default Curve, Photoshop permits you to draw your own Curve. Simply {Click} the Custom 
Curve Button and {Click} and drag inside the Curve Window to create your Curve. Adjust the Curve as you would normally by {Clicking} the 
Edit Curve Button. 

Curves (con't) 

Scale: Vertical/Horizontal: The Vertical Scale represents values from 0 - 255 (in RGB 
Mode) with Shadows at the bottom and Highlights at the top. The Horizontal Scale 
represents values from 0 - 255 with Shadows at the left and Highlights at the right. You 
can reverse the orientation by {Clicking} the Arrows in the center of the Horizontal Scale. 
Eyedroppers: Use the Eyedroppers to establish the range of tones. For example, use 
the Black Point Eyedropper by {Clicking} on the darkest point in your image (or whatever 
you wish to designate as the darkest point). The rest of the image adjusts automatically. 
Use the other Eyedroppers (Gray Point, White Point) appropriately. Like Levels, using 
Curves can be a little confusing. Experimentation and practice is the best way to get a 
solid understanding of how you can use Curves to achieve your goals. Color Balance 
Adjust the Color Balance of an image, Layer, or Selection with the Color Balance 
controls. Controls include Color Balance fields and sliders for Cyan to Red, Magenta to Green, and Yellow to Blue, Tone Balance (Shadows, 
Midtones, and Highlights), Preserve Luminosity, and Preview. 
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You can adjust the Core Range and Fall Off range by sliding the 
Indicators as needed. Note that you can use the Eyedroppers to 
adjust the range by {Clicking} on colors within the image to add or 
remove them from the range. The Fall Off range is used to make 
your adjustments as smooth and realistic as possible. You can 
experiment with changing the range if you like. 

Hue/Saturation (con't) 
For now, keep the range at default and make adjustments to the 
Reds in the image. We’ve changed Saturation to +60 and 
Lightness to -15. 

Next move to Yellows. We’ve changed Hue to -25. 

Next move to Greens. We’ve changed Saturation to +40. 

Next move to Cyans. We’ve changed Hue to -75. 

We’ve left Blues and Magenta unadjusted as most of these colors 
are in the background. The background of this image is out of 
focus (blurry) and color adjustments tend to become blocky or 
band when adjusting blurry areas. In fact, you should notice some 
pinish patches in the background that appear unseemly. This is 
bound to happen when making global adjustments (adjustments 
to the entire image and therefore all the colors within the image 
that fall within a particular range.) Remember, you can also 
isolate areas of the image by creating Selections or by selecting 
content on a single Layer and then make adjustments to the 
content accordingly. 

Hue/Saturation (con't) 
If you examine the image now, the Reds and Greens should 
appear much better than they originally did (compare it side-by-
side to flower.psd if you like.) 

You could go back to Hue/Saturation, isolate the Reds and 
change the color of the flower to a pink (by increasing Brightness) 
or yellow (by increasing Hue and Saturation and decreasing 
Brightness.) 

Open flowerComplete.psd to view the changes as we’ve made 
them to the image. 

 

flowerComplete.psd 

Colorize 
Colorize causes the image, Layer, or Selection to take on a 
duotone effect, where the image is tinted by one dominant color. 

Color Balance Fields and Sliders: Use the Cyan to Red, Magenta 
to Green, and Yellow to Blue fields (Color Levels) and sliders to 
adjust color values. As you experiment with them, notice how the 
color changes in the image. To isolate particular tones within the 
image use the Tone Balance controls. 

Tone Balance: Check Shadows, Midtones, or Highlights to isolate 
Color Balance changes you wish to make to those particular tonal 
ranges in the image. 

Preserve Luminosity: Check Preserve Luminosity so that Color 
Balance changes affect only the color of the pixels and not the 
brightness. 
Using flowerCurves.psd, input the following values into the Color 
Levels fields (in order, left to right): -46, -20, +1. 
Note how combining the previous adjustments we made with Curves 
with the Color Balance adjustments has greatly improved the tone of 
this image (compare it to flower.psd side-by-side.) 

Brightness/Contrast: Use the Brightness and Contrast Sliders or 
Fields to increase or decrease the brightness and contrast of an 
image, Layer, or Selection. 

 

Using flowerCurves.psd, increase Brightness by 10 and Contrast by 
10. 

Hue/Saturation: Use the Hue/Saturation Controls to increase and 
decrease the Hue, Saturation, and Lightness of an image, Layer, or 
Selection. From Edit select Master to adjust all the colors or select 
from a list of color ranges that include Reds, Yellows, Greens, 
Cyans, Blues, and Magentas. 

 

Hue/Saturation (con't) 
When you select a color range, you can adjust the magnitude of that 
range using the sliders in between the Color Bars at the bottom of 
the Hue/Saturation dialog box and by using the Eyedropper Tools. 
For example, select Red from Edit. Note how the Color Bars at the 
bottom display the range of Reds that will be affected. 
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Gradient Map: Use the Gradient Map dialog box to map either a 
custom or preset Gradient to the grayscale values of an image. The 
effect is somewhat like that of a Duotone used in print but without the 
need of converting the image over to a Duotone. The default Gradient 
consists of the current Foreground and Background Color, with the 
foreground mapped to black and the background mapped to white (in 
the Grayscale range.) Choose a Gradient or {Double-Click} on the 
Gradient Preview itself to edit and create custom Gradients. Check the 
Dither checkbox to create a smooth Gradient. Check the Reverse 
checkbox to flip the colors from right to left. In our case we had Red as 
the Foreground Color and Black as the Background Color, which 
results in a Gradient from Red to Black. 

 

Gradient Map (con't) 
We’ve selected the Orange, Yellow, Orange Gradient and applied it to 
the flower image with the following results: 

 

Invert: Use Invert to reverse the colors of the current image, Layer, or 
Selection. In effect, you make a photographic negative of your image. 

Equalize: Use Equalize to make Photoshop designate the lightest 
pixel and the darkest value as absolute black and white and then 
adjust the pixels between evenly or equally. 

Desaturate: Selecting Desaturate removes the color from an 
image. The image will appear to be in Grayscale Mode but 
actually remains in RGB Mode so that you can still add color to 
it and use all the Filters. 

Replace Color: Use Replace Color to change the Hue, 
Saturation, and Lightness of a particular color or particular 
range of colors. Use the Eyedroppers to select the color(s) you 
wish to replace. Replace Color is similar to selecting by Color 
Range, including Fuzziness, Eyedroppers to select one color, 
select additional colors, or deselect colors, a Preview checkbox, 
and the ability to choose either Selection or Image in the Image 
Box (see “Creating a Selection with Color Range” on page 68.) 
In addition, Replace Color includes Hue, Saturation, and 
Brightness Sliders and Fields, and the Sample Box that 
indicates the currently selected color or base color for the 
currently selected range. 

 

Try using Replace Color on the flower or on different colors 
within the image. 

Selective Color: Use Selective Color to adjust CMYK values for 
images destined for print. Because you don't use CMYK mode 
for the Internet you won't have much use for this control. 
However, feel free to experiment with it. Like other controls, you 
can isolate a color range and use sliders to modify them. 

Channel Mixer: Use the Channel Mixer to adjust the balance of 
each individual Color Channel in the image. Select the desired 
Color Channel with the Output Channel drop-down list. You'll 
notice that sliders for the Source Channels default to a value of 
zero, except for the currently selected Color Channel, which 
defaults to a value of 100%. Use the sliders to increase and 
decrease the percentage values of each Channel to change the 
tone of the image. Use the Constant slider to add or subtract 
black or white to the mix. Check Monochrome to convert the 
Image to a Gray range of colors (the image itself still remains in 
RGB Mode.) 
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Adjustment and Fill Layers 
(con't): The Adjustments you 
choose work just like the do 
through selecting 
Image/Adjustments/selected 

Adjustment (where selected 
Adjustment is the Adjustment 
of your choice, such as 
Curves.) 

Adjustment and Fill Layers (con't): This is our original, muddy, 
dark image of the flower that we have been modifying throughout 
the chapter. Let’s do the modifications again, but this time using a 
series of Adjustment Layers. Execute the following procedure: 

1. Create a new Adjustment Layer and select Curves for the 
Adjustment Type. The Curves dialog box appears. 

2. Create 3 Points along the Curve as we did before (see 
“Curves” on page 162.). Once you’ve made the Curve (an 
approximation to the screenshot), you can select each, 
from the top down, and input the following coordinates: 

 Input: 136 / Ouput: 182 
 Input: 66 / Ouput: 147 
 Input: 48 / Ouput: 90 

3. {Click} OK. An Adjustment Layer should be added to the 
Layers Palette just above the Background Layer. 

4. Next, add another Adjustment Layer. Select Color 
Balance. 

5. Input the following values into the Color Levels fields (in 
order, left to right): -46, -20, +1. 

6. {Click} OK. 
7. Next, add another Adjustment Layer. Select 

Brightness/Contrast. 
8. Increase Brightness by 10 and Contrast by 10. 
9. {Click} OK. 
10. Next, add another Adjustment Layer. Select 

Hue/Saturation. 
11. Input the following values for the following colors: 

 Reds: Saturation: +60 / Lightness: -15 
 Yellows: Hue: -25 
 Greens: Saturation: +40 
 Cyans: Hue: -75 

12. {Click} OK. 

Threshold: Use Threshold on the current image, Layer, or 
Selection to convert all pixels to either black or white. Adjust the 
Threshold Level by input a new value or using the slider. 
Increasing the value adds more black and decreasing the value 
adds more white. The range is from 0 to 255. 

Posterize: Use Posterize on the current image, Layer, or 
Selection to reduce the amount of colors, and therefore tone. For 
instance, if you enter a value of 5, the image is reduced to five of 
the most dominant colors. 

Variations: Use Variations to view multiple results of tonal 
changes for the current image, Layer, or Selection. The Variations 
dialog box consists of twelve (12) Thumbnails divided into three (3) 
areas. At the top is the image in its Original form beside which is 
the image as it appears with modifications. To isolate tones and 
saturation check Shadows, Midtones, Highlights, or Saturation. 
Check Show Clipping when adjusting Saturation to ensure you do 
not over saturate a particular color. Use the Fine and Coarse slider 
to adjust the amount of each change. 

 

Variations (con't): Execute changes by {Clicking} on the 
Thumbnails in the Color or Brightness areas. The Color Area 
consists of Thumbnails to add more Green, Yellow, Cyan, Red, 
Blue, and Magenta. Continue {Clicking} on the Thumbnails to add 
color. Lighten or darken the image by {Clicking} on the Lighter or 
Darker Thumbnails in the Brightness area. {Click} OK to make the 
changes. 

Adjustment and Fill Layers: Photoshop features a powerful 
Adjustment Layer you can use within the Layers Palette to affect 
tonal changes to Layers that lie beneath the Adjustment Layer. 
Thus far, we have been using a destructive method, where the 
adjustments we make are permanent and are actually applied to 
the image data on a particular Layer. If we use an Adjustment 
Layer, we use a non-destructive method of adjusting tone, color, 
brightness, and so forth. To create an Adjustment Layer select the 
Layer that you want to affect and {Click}on the New Fill or 
Adjustment Layer button at the bottom of the Layers Palette. A 
drop-down menu appears that allows you to choose an Adjustment 
Type. For Fills select either Solid, Pattern, or Gradient. For 
Adjustments select either Levels, Curves, Brightness/Contrast, 
Color Balance, Hue/Saturation, Selective Color, Channel Mixer, 
Gradient Map, Invert, Threshold, or Posterize. 

Open flowers.psd. 

 

flowers.psd 
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Adjustment and Fill Layers (con't) 
We’ve made all the changes we made earlier, but this time in a non-destructive manner. We should have four (4) Adjustment Layers stacked 
on top of the Background Layer. The original image has not been modified. We are seeing the modifications through the Adjustment Layers. 
You can use the Visibility Toggle at any time to disable an Adjustment Layer or {Double-Click} the Adjustment Layer Thumbnail to change the 
settings you’ve applied. Futhermore, you can use the Opacity or Fill values for the Adjustment Layer to reduce the effect on the Layers below. 

 

 
 

OPTIMIZING IMAGES FOR THE INTERNET 
 

Creating a Logo in Photoshop 
Most logos are actually created in vector-based programs such as Adobe Illustrator because vector-based artwork is scalable and suitable for 
print. In most cases, you are given a copy of a company's logo in either Encapsulated Postscript (.eps) or Illustrator format (.ai.) However, 
since we are working exclusively in Photoshop we will create a logo within Photoshop, using external media as well as Type and a Vector 
Shape. 

Importing Vector Image Files: If you are creating a logo, its highly recommended that you do so in a 
program like Adobe Illustrator or Macromedia Freehand (among others) because it is much easier to 
repurpose, for print, for video, and in our case, for the Internet. With the exception of Macromedia Flash 
and the emerging (at the time of publication) SVG format, the browsers still only support bitmap images 
natively. If you need to publish a logo to the Internet, you’ll most likely be taking a vector file and importing 
it into Photoshop. To do so, simply select File/Open and select the appropriate file type. In our case, we’re 
going to import an Adobe Illustrator (.ai) file. 

Creating a Logo in Photoshop (con't): When you import an Illustrator image, the Rasterize Generic EPS Format dialog box appears. To 
rasterize means to translate the vector information of a file into a grid of columns and rows filled with pixels, in other words, to take vector 
information and convert it into bitmap information. Options include Width and Height (in various units), Resolution, Color Mode, Anti-aliased, 
and Constrain Proportions. 

Recall that vector images are resolution independent. You are given the 
opportunity to set your dimensions, resolution, and so forth before the vector 
data is converted to a bitmap. As a result, you could import it again and again 
for different projects that require larger versions. In our case, input a width of 
120 pixels. If Constrain Proportions is checked, the Height field adjusts 
automatically. It is very important that proportions, particularly for logos, be 
maintained. Set Resolution to 72 ppi and Mode to RGB because we will be 
publishing the image to the Internet. Make sure Anti-aliased is checked to 
create smooth edges. {Click} OK. The image is converted to a bitmap and 
appears with a transparent background. You should recognize it from previous 
exercises. 

Creating a Logo in Photoshop (con't) 
Examine the image. You'll notice that it is composed of solid colors and sharp edges. This type of image is typical of vector-based artwork. 
Notice also that unlike opening a bitmap image, which defaults to a “Background” Layer, vector images default to “Layer 1" with the image 
data surrounded by transparency. Rename the Layer “kimonoGirl”. 

Note 
By default, Adjustment Layers affect all the Layers 
below them. If you are working with on a file with 
multiple Layers you may wish to link particular 
Adjustment Layers with particular image Layers. To do 
so, select the image Layer you wish the Adjustment 
Layer to be linked to. Next, place the mouse pointer 
between the image Layer and the Adjustment Layer 
and press the [ALT] key. A link icon will appear. Press 
the mouse button to link the Adjustment Layer to the 
image Layer. 

 

Open kimono.ai. 

 

kimono.ai 
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Creating a Logo in Photoshop 

Select the “risingSun” Layer. Make sure the Foreground Color is still 
red and the Background Color is pure white (R: 255, G: 255, B: 
255.) Add a Gradient Overlay to the Ellipse (Gradient Overlay is a 
Layer Style) using the following settings: 

 Blend Mode: Normal 
 Opacity: 100 
 Gradient: Foreground to Background 
 Reverse: Checked 
 Style: Linear 
 Align with Layer: Checked 
 Angle: 90 
 Scale: 100 
 {Click} OK. The image should appear as follows: 

Next select the Horizontal Text Tool. Set the font to Verdana, Bold, 
90 pt, Smooth, and White for the color. Input a capital “T”. 

Apply a Stroke (another Layer Style) to the text. Use the following 
settings: 

 Size: 3 
 Position: Outside 
 Blend Mode: Normal 
 Opacity: 100 
 Fill Type: Color 
 Color: Black (R: 0, G: 0, B: 0) 

Place the Type Layer in between the 
“kimonoGirl” and “risingSun” Layers. 
Position it like this (approximately): 

Creating a Logo in Photoshop 
Next, select the Horizontal Text Tool and 
change the color to black and the size to 
60, but keep the same font (if you still have 
the Type Layer you just created selected, 
you will change the settings of that Type 
Layer, make sure to select a standard 
Layer first.) Input “ravel” and position it 
accordingly: 

Adding a Vector Shape 
Our next step involves adding the components that will make up 
the completed logo. In this case, we’re going to start by making the 
canvas of the Image Window larger. To so, select Image/Canvas 
Size. The Canvas Size dialog box appears. 

 

Input a Width of 350 and a Height of 300 pixels. Note the Anchor 
section. By {Clicking} on the various Arrows you can change the 
orientation that the canvas expands to. We want it to expand 
evenly on all sides so we accept the default centered orientation. 
This is a quick way of changing the size of the canvas or Image 
Window without modifying the size of pixel content. We could have 
just as easily created a new image and dragged the image of the 
kimono girl into it. 

Adding a Vector Shape (con't) 
You should have an Image Window that looks like this: 

 

Next we are going to change the scale of the kimono girl and add 
a Shape to mimic the rising Sun. 

If you wish, you can open travelLogo.psd and work with that file. 

 

travelLogo.psd 
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The Save for Web dialog box consists of Tabs (Original, Optimized, 
2-Up, 4-Up) to control how many Optimization Previews of the 
image you can see (from 1 to 3 at a time.) A set of Hand, Slice, 
Magnification, and Eyedropper Tools, and Image Compression 
Options (Image Type, Color Reduction, Dither Type, Compression, 
Colors, Dither Percentage, Transparency, Matte, Interlaced, and 
Web Snap) are included. Output Settings, a Color Table, Color 
Table Options, Image Size, Magnification Level, Info Bar, and Info 
Bars at the bottom of each Preview Window are also included. We 
will cover the Slice Tool and Output Settings later in the manual so 
focus your attention on the other features of this dialog box for the 
time being. 

Preview Windows 
Select from Original, Optimized, 2-Up, and 4-Up to see various 
versions or your image in the Preview Windows. 

 

You'll be applying various compression and file-type settings to your 
image. Photoshop gives you a real-time preview of what the image 
looks like with a particular set of compression options in contrast to 
the Original version of the image (the Photoshop native, 
uncompressed version.) {Click} on the 2-Up Tab. Two (2) Preview 
Windows result, one titled “Original” in the Info Bar at the bottom, 
which includes the File Size, and one titled with the currently 
selected Image Compression options, including File Type, File Size, 
Projected Download Time, Dither percentage, Palette, and Number 
of Colors.  

Depending on your current Image Compression options the new 
version of the image should be dramatically smaller than the native 
Photoshop version. 

Next, set the Tracking to – 80. 
Create two new Type Layers, one with the letter “J” with the same 
settings as the letter “T” except the color will be (R: 204, G: 51, B: 
51), and one black, with “apan” (same settings as the “ravel” Type 
Layer, including the Tracking.) Position them accordingly: 

 

Creating a Logo in Photoshop 
Next, you should Crop the image as tightly as possible. In addition, 
let’s add a Drop Shadow to the kimono girl with the following 
settings: 

 Blend Mode: Multiply 
 Opacity: 75 
 Angle: 120 
 Use Global Light: Checked 
 Distance: 5 
 Spread: 0 
 Size: 5 
 Contour: Linear 
 Anti-Aliased: Checked 
 Noise: 0 
 Layer Knocks Out Drop Shadow: Checked 

Go ahead and do so and save your image if you like. For the next 
section, we’ll all use the same image. 

Load travelLogoFinished.psd. 

 

travelLogoFinished.psd 

Once you have created your image as desired, it’s time to save it 
for the Internet. To do so within Photoshop, select File/Save for 
Web. The Save for Web dialog-box appears. 



 
 
 

SARVA EDUCATION (SITED) (Running- An I.T & Skill Advancement Training Programme)                                                                                                                                                                   - 135 -                                                                                                                                                         

                                                                       

 

Visit us at:  www.sarvaindia.com                                                                 Licensed by Govt. of India                                                                       ISO 9001:2015 Certified 

Building Compression Options for GIF and PNG-8 
If none of the pre-set Compression Options is useful to you, you can 
customize options by using the drop-down settings. The following 
options are available for GIG and PNG- 8: Optimize Menu, Image 
Type, Color Reduction, Dithering, Dithering Level, Lossy, Colors, 
Matte Color, Transparency, Transparency Dithering, Transparency 
Dithering Amount, Interlaced, and Web Snap. 

 

Building Compression Options 
for GIF and PNG-8 (con't) 

Image Type: Select from GIF, JPEG, PNG-8, and PNG-24 for the 
Internet. In this case, we would select GIF because of the nature of 
the image. If you select JPG or PNG-24 the Compression Options 
will change. 

Lossy (for GIFs only): Lossy compression discards data from the 
image to reduce file size. The higher the Lossy value the more data 
lost. Usually the higher the value the more the image itself 
degrades. Try it out and examine the results. Note that this option 
will not be available if you select particular Dithering options or if 
Interlaced is checked. 

Color Reduction and Colors: Select from the following Color 
Reduction algorithms: Perceptual, Selective, Adaptive, Web, 
Custom, Black & White, Grayscale, Mac OS, and Windows. For the 
Internet, Perceptual, Selective, Adaptive, Web are the most 
common. The Colors option works in tandem with Color Reduction. 
You can select or input the number of colors you wish to use 
depending on the selected algorithm. The Auto option appears in 
Colors when the Web algorithm is selected. Both Photoshop and 
ImageReady will attempt to use the least amount of colors possible 
to maintain the highest quality. You are free to change the amount 
of colors yourself. Select each option and examine the results for 
our image. Note the colors in the Color Table. 

Building Compression Options 
for GIF and PNG-8 (con't) 

Dithering and Dither Level: Dithering encompasses a variety of 
techniques to simulate color that cannot be generated or is not 
available (GIF can only support a maximum of 256 colors.) You can 
select from the following Dithering methods: No Dither, Diffusion, 
Pattern, and Noise. Dithering creates patterns to trick your eye into 
seeing colors that are not there. The Diffusion method is the least 
noticeable. You can also modify the level of the Diffusion method by 
increasing or decreasing the value of the Dither Level. Select each 
method and examine the effect they have on our image. 

 

This Preview Window displays the image as a GIF. 
Note the information in the Info Bar. 

Compression Options: Photoshop has numerous Compression 
Options you can apply to an image to prepare it for the Internet. 
Select from a list of pre-set Compression Options by selecting 
Settings which include GIF, JPEG, and PNG variations. At this 
point PNG is not fully supported by the browsers. Most of the 
newer browsers will support displaying PNG files, but may not 
support the Transparency features. Its highly recommended that 
you test any use of PNG files before you commit to using the 
format. There are a few things to consider when selecting an 
appropriate compression option: 
 
 Nature of the Image: Solid Colors, Sharp Edges, Photograph 
 Target Audience Bit-Depth: 8-bit display or higher? 
 Target Audience Bandwidth: Low, Medium, or High? 
 
If the image is made up of predominantly solid colors and sharp 
edges, such as the image we are working with, then GIF is the 
best format because file size will be significantly smaller than using 
JPEG. JPEGs are 24bit images with over 16 millions colors and 
are much more suited to photographic images which tend to be 
made up of a wide variety of colors, tones, and little, if any, 
patterns. 

Compression Options (con't): Select each of the pre-set GIF 
Compression Options and examine the image and the image size. 
When you can, it's advisable to use the Web-Safe Color Palette to 
ensure that people using 8-bit displays see the image as you do. 
More and more users have 24-bit color displays so the Web-Safe 
Color Palette is becoming less of an issue than they were in the 
past. We will, however, employ them in this example to see how 
they work. Select GIF Web Palette from Settings. You'll notice that 
certain colors shift slightly from the original (the face, the obi 
(sash), and fan.) In addition if you examine the Gradient, you can 
see banding (a series of different color stripes) rather than a 
gradual shift from one color to another. In many cases, when you 
are creating images of this type that are not logos these color 
shifts are acceptable. However, your client may not agree to 
slightly different colors for a logo. At present, if you examine the 
Color Table you'll notice that there are only 37 (this number may 
vary slightly) colors in the compressed version of the image. To 
adjust these settings, such as adding more Web-Safe Colors you'll 
have to build Compression Options yourself. 
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For our image use the following settings: 

 Image Type: Gif 
 Color Reduction: Perceptual 
 Dithering: No Dither 
 Transparency: Unchecked 
 Lossy: 0 
 Colors: 256 
 Matte: White 
 Web Snap: 0 

Building Compression Options 
for GIF and PNG-8 (con't) 
If these are settings you’ll use frequently, {Click} the Optimize Menu 
and select Save Settings. Name your settings appropriately. 

Otherwise, {Click} Save. Save your image as studentTravelLogo.gif. 
Now its ready to be used in a web site. 
If you like, you can load our version, travelLogo.gif to view it. 

Note 
Usually, you save your Internet-ready image to the 
appropriate folder within your web site. When you 
are done saving the optimized version of the file, 
you are returned to Photoshop where you can 
continue to work on the image. At this point you 
should save the image because the optimization 
settings you selected are saved with it as well. Keep 
a copy of your original Photoshop file, also referred 
to as the Production file. Make changes to this file 
and re-optimize the image for the Internet after 
you’ve made your changes. 

Building Compression Options using JPEG 
JPEG or PNG-24 images are usually photographic images, due to 
the complexity of a 
photograph and the 
number of potential colors. 
You can use GIF or PNG-8 
compression methods with 
photographic images and 
still get good visual results, 
but the file size tends to be 
quite large. Let’s examine 
compression options 
for photographic 
images. 

Select File/Save for 
Web. 

Building 
Compression 
Options using JPEG 
(con't) 
Select GIF for Image Type and try out the various settings you tried 
with logo image we created. Note the file size of the compressed 
version of the image and the color banding that can occur. Next, 
select JPEG from Image Type. The optimization options change 
from those we had with GIF. Options include Compression Quality, 
Quality, Progressive, ICC Profile, Optimized, Blur, and Matte. 

 

Our image with No Dithering selected using 
the Web-Safe Color Palette. 

 

Our image with Pattern Dithering selected 
using the Web-Safe Color Palette. 

Building Compression Options 
for GIF and PNG-8 (con't) 

Transparency and Matte: Check Transparency if you wish to 
generate a Transparent GIF. By default, any transparent area in 
the Photoshop file will be transparent. The Transparency in GIF 
images can produce images with rough edges. You can use the 
Matte options to select a color to which the edges can be Anti-
aliased to (with Transparency enabled or not.) Select from None, 
Eyedropper Color, White, Black, or Other. You can use the 
Eyedropper Tool in the Save for Web dialog box to sample a color 
from the image. Selecting Other launches the Color Picker. 

Transparency Dithering and Amount: Use Transparency 
Dithering to set the Dithering for partially transparent pixels in 
PNG-8 images. Use Amount to control the level of Dithering. 

Interlace: If you check Interlace the GIF image will appear to 
download faster as a broken-up or low resolution version of the 
image is displayed until the full image has been uploaded. Be 
aware that it does increase file size. 

Building Compression Options 
for GIF and PNG-8 (con't) 

Web Snap: Increasing the value of Web Snap will cause colors to 
shift closer to the Web-Safe Color equivalents. Using Web Snap is 
not necessary if you’ve selected Web for Image Type. 

     Open miyajima.psd. 

 

miyajima.psd 
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Building Compression Options using JPEG (con't) 

Matte (con't) 
Examine the file size: 56.85k in our case. Still rather large. This is 
due to the fact that dimensions of the image itself are rather large. 
Reduce the dimensions, reduce the file size. Recall that you want to 
keep the original in its original form. Rather than reducing the scale 
of the original image, simply select the Image Size tab beside the 
Color Table tab. 

 

Our original image is 500 x 668 pixels. Let’s reduce the dimensions 
by inputting a different Width or Height into the appropriate field in 
the New Size area. Alternately, you can input a percentage value 
into the Percent field. 

By default, the proportions are constrained to maintain the aspect 
ratio of the image. To disable, uncheck Constrain Proportions. 

Building Compression Options using JPEG (con't) 

Matte (con't) 
You can also select a Quality setting for Image. Input 200 in the 
Width field or 40 into the Percent field and {Click} Apply. The file 
size has been reduced from 56.85k to 11.27k. 

{Click} Save. Save the file as studentMiyajima.jpg. 

If you like, you can view our version by loading miyajima.jpg. 

 

miyajima.jpg 

There you go! You’ve just created two (2) Internet-ready images. 
But that is only the beginning. You’ll need to experiment with a 
number of images to get to know how the compression options 
operate with different images (differences in colors, content, and so 
forth.) Try out the images included in the exercises. 

 
 
 

 
___________________________________________ 

 
 

Building Compression Options using JPEG (con't) 

Compression Quality and Quality: Compression Quality and 
Quality are really the same thing. With Compression Quality you 
can select from Low, Medium, High, and Maximum. Each setting 
will change the value of Quality. The value of Quality affects both 
the file size and visual quality of the image. Lower values reduce 
both and higher values increase both. You have to test various 
Quality levels until you strike a balance between file size and 
appearance. 

Progressive: Check Progressive to force the image to be 
displayed in steps or progressively in a browser. This will give 
users the ability to see a low-resolution version of the image as it 
loads. This feature is not supported by all browsers. 

Building Compression Options using JPEG (con't) 

ICC Profile: Check ICC Profile to embed the ICC Profile with the 
file. Some browsers may support color correction and in future 
perhaps all browsers may support this option. This option will 
increase the file size slightly. Consult Photoshop Help or your 
Photoshop manual for more information on setting up color 
management. 

Optimized: Check Optimized for maximum compression. Older 
browsers may not support this option. 

Blur: At times, adding a very slight blur to the compressed image 
helps to reduce the file size and mask compression irregularities or 
artifacts (the lower the Quality value the more artifacts you may 
see, such as banding and corrupted areas within the image.)  
 
This is identical to apply a Gaussian Blur Filter to the image. Set 
Quality to 10 and examine the sky around the edge of the 
structure. You should see compression artifacts. 

Building Compression Options using JPEG (con't) 

Matte: Because JPEG does not support Transparency, you’ll need 
to specify a color to fill any transparent or partially transparent 
areas with. Use Matte to do so. Go ahead and try various settings 
and examine the results. Use the Hand Tool in the Save for Web 
dialog box to move the image around within the Preview Window.  

When you’re done, select the following settings (but do not press 
OK yet): 

 Optimized: Checked 
 Quality: 30 
 Blur: 0 
 Matte: None 
 Progressive: Unchecked 
 ICC Profile: Checked 
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